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Willow Scorebook Introduction

W E L C O M E
" There is seldom more than one proficient scorer in a cricket club. This is partly because 

the task is undervalued and more often due to the complexities of scoring. Many clubs 
survive without a good scorer at all thus depriving themselves of accurate match results 
and analysis. This can lead to all manner of problems not least of which being match 
disputes. Although the final decision rests with the umpires and team captains, it is more 
often the match scorer(s) whom bear the brunt of accusation when the Scoreboard, 
Scorebook and Players relate different opinions upon the current or final match position.

How often too, do the most diligent of scorers, find fault in their own manual scoring? In 
providing an accurate analysis mistakes can often be made leaving the result in question 
when batting totals do not equal bowling totals. Finding such mistakes can be impossible.

Smaller clubs fare worst in these respects even with competent scorers. The nature of 
the amateur game complicates the task of scoring. How often are both teams player lists 
produced before the game? How often are batting orders changed and juggled? Is the 
scoreboard kept up to date fully ball by ball? "

The Willow Scorebook has been designed to address these concerns and to extend the
ability of even the most professional scorer by providing one touch scoring, full match 
analysis and extended features previously available only to the highly financed television 
and radio networks. The Willow Scorebook is also an asset for any cricket coach.

The Willow Scorebook offers facilities such as :-

One key entry for common scoring operations.
Comprehensive event selection.
Support for Innings suspension for Rain, Light, Lunch, Tea or Drinks.
Match Save & Load.
From 5 to 11 players per team plus substitute.
Recording of Captains & Wicket Keepers.
Radial Charts for batsmen and bowlers.
Automatic calculation of match result.
View previous match positions while the match is in progress.
Byes & Leg Byes are indicated in bowlers analysis.
Recording of a batsman's time in & out, balls received & time at crease.
Full control over printing.
Scoreboard & Score sheet display.
Match Summary display.
Run Rate Graph depiction.
Manhattan Graphs.
Automatic or manual batsman/bowler selection.



Automatic or manual timing of events.
Automatic or manual end of over
Recording of Weather & Pitch condition.
Local Customs.
Match or Innings notes.
One or two innings matches.
Support for no-balls of one or two run value.
Customisable windows display.
Separate Windows for All Scorebook Analyses.
Online Help
The Laws Of Cricket
Support for Cricket Statistics for Windows

EddSON hope that The Willow Scorebook is all you expected it to be and more. Please
read the Product Support section of this Help guide for further product and support 
information.



Product Support
Willow Scorebook includes everything required to run and be used effectively by a 

competent Windows user with cricket knowledge. The package includes software supplied 
on 3.5" disk or CD, registration, contact and licence information. The software is supplied 
with installation and set-up routines, the program itself and this on-line help.

If you experience problems using this package, or the instruction manual and on-line 
help do not satisfactorily answer your questions then DO NOT despair, further assistance it 
at hand.

Undocumented changes to the program, intructions or on-line help are recorded in a 
README file found on the installation disk or CD. Read this file before proceeding further 
(Use the Windows Notepad to open the README file to view its contents).

EddSON provide support for Willow Scorebook either through the supplier channel or 
directly. We strongly advise that you contact your supplier with initial queries.

EddSON will provide product support to all their customer's subject to terms & conditions
in place at the time service is provided. Special consideration should be made by 
customers outside the United Kingdom. Contact EddSON over the telephone, by email or in 
writing using the contact information supplied with the package. When requesting product 
support you will be asked for your serial number. Please be ready if you telephone or mark 
the serial number clearly on correspondence.

Product training, consultancy and data collection are all services offered by EddSON. 
Further details can be given on enquiry.

Willow Scorebook is under constant review and change. Your installation disks are 
marked with the supplied version, release and revision levels ( e.g.    v1.01 r001indicates 
version 1 release 01 revision 001, the first issue of the package). Revisions are invariably 
minor bug fixes and slight improvements, which would not be included in a formal software 
release. These revisions can be supplied to you free of charge or at cost price if this 
involves materials. Contact EddSON for revision details. New versions or releases of the 
software are chargeable although EddSON attempt to keep such charges to a minimum. 
EddSON do not believe in forcing their customers to pay for a product twice. EddSON's 
upgrade charges and the upgrades themselves are available through either the supplier 
channel or directly from EddSON.



The Laws of Cricket
The Laws Of Cricket, 1980 Code, Second Edition - 1992, 1993 May, have been 

reproduced by kind permission of Marylebone Cricket Club.

Printed copies of the Laws of Cricket (currently 3 pounds sterling for hardback and 1 
pound 50 pence for softback) with full notes and interpretations may be obtained from:

Marylebone Cricket Club
(MCC Book Shop)

Lord's Cricket Ground
London. NW8 8QN

England
(44) 0171-289 5686

Law 1 - The Players
Law 2 - Substitues & Runners
Law 3 - The Umpires
Law 4 - The Scorers
Law 5 - The Ball
Law 6 - The Bat
Law 7 - The Pitch
Law 8 - The Wickets
Law 9 - The Bowling, Popping & Return Creases
Law 10 - Rolling, Sweeping, Mowing, Watering & Remarking
Law 11 - Covering The Pitch
Law 12 - Innings
Law 13 - The Follow On
Law 14 - Declarations
Law 15 - Start Of Play
Law 16 - Intervals
Law 17 - Cessation Of Play
Law 18 - Scoring
Law 19 - Boundaries
Law 20 - Lost Ball
Law 21 - The Result
Law 22 - The Over
Law 23 - Dead Ball
Law 24 - No Ball
Law 25 - Wide Ball
Law 26 - Bye & Leg-Bye
Law 27 - Appeals



Law 28 - The Wicket Is Down
Law 29 - Batsman Out Of His Ground
Law 30 - Bowled
Law 31 - Timed Out
Law 32 - Caught
Law 33 - Handled The Ball
Law 34 - Hit The Ball Twice
Law 35 - Hit Wicket
Law 36 - Leg Before Wicket
Law 37 - Obstructing The Field
Law 38 - Run Out
Law 39 - Stumped
Law 40 - The Wicket Keeper
Law 41 - The Fieldsman
Law 42 - Unfair Play



Law 1 - The Players
1.NUMBER OF PLAYERS & CAPTAIN

A match is played between two sides each of eleven Players, one of whom shall be 
Captain. In the event of the Captain not being available at any time a Deputy shall act for 
him.

2.NOMINATION OF PLAYERS
Before the toss for innings, the Captain shall nominate his Players who may not 

thereafter be changed without the consent of the opposing Captain.

Notes
(a) More Or Less Than Eleven Players A Side
A Match may be played by agreement between sides of more or less than eleven players 
but not more than eleven players may field.



Law 2 - Substitutes & Runners: Batsman or Fieldsman 
Leaving The Field: Batsman Retiring: Batsman 
Commencing Innings
1.SUBSTITUTES

In normal circumstances, a substitute shall be allowed to field only for a player who 
satisfies the Umpires that he has become injured or become ill during the match. However, 
in very exceptional circumstances, the Umpires may use their discretion to allow a 
Substitute for a player who has to leave the field for wholly acceptable reasons, subject to 
consent being given by the opposing Captain. If a player wishes to change his shirt, boots, 
etc., he may leave the field to do so (no changing on the field) but no substitute will be 
allowed..

2.OBJECTION TO SUBSTITUTES
The opposing Captain shall have no right of objection to any player acting as substitute 

in the field, nor as to where he shall field; however, no substitute shall act as wicket-keeper.

3.SUBSTITUTE NOT TO BAT OR BOWL
A Substitute shall not be allowed to bat or bowl.

4.A PLAYER FOR WHOM A SUBSTITUTE HAS ACTED
A Player may bat, bowl or field even though a substitute has acted for him.

5.RUNNER
A runner shall be allowed for a batsman who, during the match is incapacitated by illness

or injury. The player acting as runner shall be a member of the batting side and shall, if 
possible, have already batted in that innings.

6.RUNNER'S EQUIPMENT
The player acting as runner for an injured batsman shall wear the same external 

protective equipment as the injured batsman.

7.TRANSGRESSION OF THE LAWS BY AN INJURED BATSMAN OR RUNNER
An injured batsman may be out should his runner break any one of Law 33: (Handled the 

Ball), Law 37: (Obstructing the Field) or Law 38: (Run Out). As striker he remains himself 
subject to the Laws. Furthermore, should he be out of his ground for any purpose and the 
wicket at the wicket-keeper's end be put down he shall be out under Law 38: (Run Out) or 
Law 39: (Stumped) irrespective of the position of the other batsman or the runner and no 
runs shall be scored.
When not the striker, the injured batsman is out of the game and shall stand where he does
not interfere with the play. Should he bring himself into the game in any way then he shall 
suffer the penalties that any transgression of the Laws demands.

8.FIELDSMAN LEAVING THE FIELD
No Fieldsman shall leave the field or return during a session of play without the consent 



of the Umpire at the Bowler's end. The Umpire's consent is also necessary if a Substitute is 
required for a Fieldsman, when his side returns to the field after an interval. If a member of 
the fielding side leaves the field or fails to return after an interval and is absent from the 
field for longer than 15 minutes, he shall not be permitted to bowl after his return until he 
has been on the field for at least that length of playing time for which he was absent. This 
restriction shall not apply at the start of a new day's play.

9.BATSMAN LEAVING THE FIELD OR RETIRING
A Batsman may leave the field or retire at any time owing to illness, injury or other 

unavoidable cause, having previously notified the Umpire at the Bowler's end. He may 
resume his innings at the fall of a wicket, which for the purposes of this Law shall include 
the retirement of another Batsman.
If he leaves the field or retires for any other reason he may only resume his innings with the
consent of the opposing Captain.
When a Batsman has left the field or retired and is unable to return owing to illness, injury 
or other unavoidable cause his innings is to be recorded as 'retired, not out'. Otherwise it is 
to be recorded as 'retired, out'.

10. COMMENCEMENT OF A BATSMAN'S INNINGS
A Batsman shall be considered to have commenced his innings once he has stepped on 

to the field of play.

Notes
(a) Substitutes & Runners
For the purpose of these Laws allowable illnesses or injuries are those which occur at any 
time after the nomination by the Captains of their teams.



Law 3 - The Umpires
1.APPOINTMENT

Before the toss for innings two Umpires shall be appointed, one for each end, to control 
the game with absolute impartiality as required by the Laws.

2.CHANGE OF UMPIRE
No Umpire shall be changed during a match without the consent of both Captains.

3.SPECIAL CONDITIONS
Before the toss for innings, the Umpires shall agree with both Captains on any special 

conditions affecting the conduct of the match.

4.THE WICKETS
The Umpires shall satisfy themselves before the start of the match that the wickets are 

properly pitched.

5.CLOCK OR WATCH
The Umpires shall agree between themselves and inform both Captains before the start 

of the match on the watch or clock to be followed during the match.

6.CONDUCT & IMPLEMENTS
Before and during a match the Umpires shall ensure that the conduct of the game and 

the implements used are strictly in accordance with the Laws.

7.FAIR & UNFAIR PLAY
The Umpires shall be the sole judges of fair and unfair play.

8.FITNESS OF GROUND, WEATHER & LIGHT
(a) The Umpires shall be the sole judges of the fitness of the ground, weather and light 
before play.

(i) However, before deciding to suspend play or not to start play or not to resume play 
after an interval or stoppage, the Umpires shall establish whether both Captains (the 
Batsmen at the wicket may deputy's for their Captain) wish to commence or to continue 
in the prevailing conditions; if so, their wishes shall be met.
(ii) In addition, if during play, the Umpires decide that the light is unfit, only the batting 
side shall have the option of continuing play. After agreeing to continue to play in unfit 
light conditions, the Captain of the batting side (or a Batsman at the wicket) may appeal 
against the light to the Umpires, who shall uphold the appeal only if, in their opinion, the 
light has deteriorated since the agreement to continue was made.

(b) After any suspension of play, the Umpires, unaccompanied by any of the Players or 
Officials shall, on their own initiative, carry out an inspection immediately the conditions 
improve and shall continue to inspect at intervals. Immediately the Umpires decide that 
play is possible they shall call upon the Players to resume the game.
 



9.EXCEPTIONAL CIRCUMSTANCES
In exceptional circumstances, other than those of weather, ground or light, the Umpires 

may decide to suspend or abandon play. Before making such a decision the Umpires shall 
establish, if the circumstances allow, whether both Captains (the Batsmen at the wicket 
may deputise for their Captain) wish to continue in the prevailing conditions: if so their 
wishes shall be met.

10. POSITION OF UMPIRES
The Umpires shall stand where they best see any act upon which their decision may be 

required.
Subject to this over-riding consideration the Umpire at the Bowler's end shall stand where 
he does not interfere with either the Bowler's run up or the Striker's view.
The Umpire at the Striker's end may elect to stand on the off instead of the leg side of the 
pitch, provided he informs the Captain of the fielding side and the Striker of his intention to 
do so.

11. UMPIRES CHANGING ENDS
The Umpires shall change ends after each side has had one innings.

12. DISPUTES
All disputes shall be determined by the Umpires and if they disagree the actual state of 

things shall continue.

13. SIGNALS
The following code of signals shall be used by umpires who will wait until a signal has 

been answered by a Scorer before allowing the game to proceed.

Boundary 4 by waving the arm from side to side.
Boundary 6 by raising both arms above the head.
Bye by raising an open hand above the head
Dead Ball by crossing and re-crossing the wrists below the waist.
Leg Bye by touching a raised knee with the hand.
No Ball by extending one arm horizontally.
Out by raising the index finger above the head. If not

the Umpire shall call 'Not Out'.
Short Run by bending the arm upwards and by touching the

nearer shoulder with the tips of the fingers.
Wide by extending both arms horizontally.

14. CORRECTNESS OF SCORES
The Umpires shall be responsible for satisfying themselves on the correctness of the 

scores throughout and at the conclusion of the match (See Law 21.6 - Correctness of 
Result).



Notes
(a) Attendance of Umpires
The Umpires should be present on the ground and report to the Ground Executive or the 
equivalent at least 30 minutes before the start of a day's play.

(b) Consultation Between Umpires and Scorers
Consultation between Umpires and Scorers over doubtful points is essential.

(c) Fitness Of Ground
The Umpires shall consider the ground as unfit for play when it is so wet or slippery as to 
deprive the Bowlers of a reasonable foothold, The fieldsmen, other than the deep fielders, 
of the power of free 



movement, or the Batsmen the ability to play their strokes or to run between the wickets. 
Play should not be suspended merely because the grass and the ball are wet and slippery.

(d) Fitness Of Weather & Light
The Umpires should only suspend play when they consider that the conditions are so bad 
that it is unreasonable or dangerous to continue.



Law 4 - The Scorers
1.RECORDING RUNS

All runs scored shall be recorded by Scorers appointed for the purpose. Where there are 
two Scorers they shall frequently check to ensure that the score sheets agree.

2.ACKNOWLEDGING SIGNALS.
 The Scorers shall accept and immediately acknowledge all instructions and signals given 
to them by the Umpires.



Law 5 - The Ball
1.WEIGHT & SIZE

The ball, when new, shall weight    not less than 5½ ounces/155.9g., nor more than 5¾ 
ounces/163g.: and shall measure not less than 8.13/16 inches/22.4 cm., nor more than 9 
inches/22.9 cm. in circumference.

2.APPROVAL OF BALLS
All balls used in matches shall be approved by the Umpires and Captains before the start 

of the match.

3.NEW BALL
Subject to agreement to the contrary, having been made before the toss, either Captain 

may demand a new ball at the start of each innings.

4.NEW BALL IN MATCH OF 3 OR MORE DAYS DURATION
In a match of 3 or more days duration, the Captain of the fielding side may demand a 

new ball after the prescribed number of overs has been bowled with the old one. The 
Governing Body for cricket in the country concerned shall decide the number of overs 
applicable in that country which shall be not less than 75 six-ball overs (55 eight-ball 
overs).

5.BALL LOST OR BECOMING UNFIT FOR PLAY
In the event of a ball during play being lost or, in the opinion of the Umpires, becoming 

unfit for play, the Umpires shall allow it to be replaced by one that in their opinion has had 
a similar amount of wear. If a ball is to be replaced, the Umpires shall inform the Batsmen.

Notes
(a) Specifications
The specifications, as described in 1. above shall apply to top-grade balls only. The 
following degrees of tolerance will be acceptable for other grades of ball.

(i) Men's Grades 2-4
Weight: 5.5/16 ounces/150g. to 5.13/16 ounces/165g.
Size: 8.11/16 inches/22.0cm. to 9.1/16 inches/23.0cm.
(ii) Women's
Weight: 4.15/16 ounces/140g. to 5.5/16 ounces/150g.
Size: 8.1/4 inches/21.0cm. to 8.7/8 inches/22.5cm.
(iii) Junior
Weight: 4.5/16 ounces/133g. to 5.1/16 ounces/143g.
Size: 8.1/16 inches/20.5cm. to 8.11/16 inches/22.0cm.



Law 6 - The Bat
1. WIDTH & LENGTH

The bat overall shall not be more than 38 inches/96.5cm. in length; the blade of the bat 
shall be made of wood and shall not exceed 4¼ inches/10.8cm. at the widest part.

Notes
(a) The blade of the bat may be covered with material for protection, strengthening or 
repair. Such material shall not exceed 1/16 inches/1.56mm. in thickness.



Law 7 - The Pitch
1.AREA OF PITCH

The Pitch is the area between the bowling creases. It shall measure 5ft/1.52m. in width 
on either side of a line joining the centre of the middle stumps of the wickets (See Law 8 - 
The Wickets).

2.SELECTION & PREPARATION
Before the toss for innings, the Executive of the Ground shall be responsible for the 

selection and preparation of the pitch; thereafter the Umpires shall control its use and 
maintenance.

3.CHANGING THE PITCH
The pitch shall not be changed during a match unless it becomes unfit for play, and then 

only with the consent of both Captains.

4.NON-TURF PITCHES
In the event of a non-turf pitch being used, the following shall apply:-

(a) Length: That of the playing surface to a
minimum of 58ft. (17.68m.)

(b) Width That of the playing surface to a
minimum of 6ft. (1.83m.)

(See Law 10, - Rolling, Sweeping, mowing, Watering the Pitch & Re-Marking of Creases). 
Note (a)



Law 8 - The Wickets
1.WIDTH & PITCHING

Two sets of wickets, each 9 inches/22.86cm. wide, and consisting of three wooden 
stumps with two wooden bails upon the top, shall be pitched opposite and parallel to each 
other at a distance of 22 yards/20.12m. between the centres of the two middle stumps.

2.SIZE OF STUMPS
The stumps shall be of equal and sufficient size to prevent the ball from passing between

them. Their tops shall be 28 inches/71.1cm, above the ground, and shall be dome-shaped 
except for the bail grooves.

3.SIZE OF BAILS
The bails shall be each 4.1/8 inches/11.1cm. in length and when in position on the top of 

the stumps shall not project more than ½ inch/1.3cm. above them.

Notes
(a) Dispensing with Bails
In a high wind the Umpires may decide to dispense with the use of bails.
(b) Junior Cricket
For Junior Cricket, as defined by the local Governing Body, the following measurements for 
the Wickets shall apply:-
Width8 inches/20.32cm.
Pitched 21 yards/19.20m.
Height 27 inches/68.58cm.
Bails each 3.7/8 inches/9.84cm. in length and should not

project more than ½ inch/1.3cm. above them



Law 9 - The Bowling, Popping & Return Creases
1.THE BOWLING CREASE

The bowling crease shall be marked in line with the stumps at each end and shall be 8ft. 
8 inches/2.64m. in length, with the stumps in the centre.

2.THE POPPING CREASE
The popping crease, which is the back edge of the crease marking, shall be in front of 

and parallel with the bowling crease. It shall have the back edge of the crease marking 
4ft./1.22m. from the centre of the stumps and shall extend to a minimum of 6ft./1.83m. on 
either side of the line of the wicket.

The popping crease shall be considered to be unlimited in length.

3.THE RETURN CREASE
The return crease marking, of which the inside edge is the crease, shall be at each end of

the bowling crease and at right angles to it. The return crease shall be marked to a 
minimum of 4ft./1.22m. behind the wicket and shall be considered to be unlimited in 
length. A forward extension shall be marked to the popping crease.



Law 10 - Rolling, Sweeping, Mowing, Watering the Pitch &
Re-Marking of Creases
1.ROLLING

During the match the pitch may be rolled at the request of the Captain of the batting 
side, for a period of not more than 7 minutes before the start of each innings, other than 
the first innings of the match, and before the start of each day's play. In addition, if after 
the toss and before the first innings of the match, the start is delayed, the Captain of the 
batting side may request to have the pitch rolled for not more than 7 minutes. However, if 
in the opinion of the Umpires, the delay has had no significant effect upon the state of the 
pitch, they shall refuse any request for the rolling of the pitch.

The pitch shall not otherwise be rolled during the match.
The 7 minutes rolling permitted before the start of a day's play shall take place not 

earlier than half an hour before the start of play and the Captain of the batting side may 
delay such rolling until 10 minutes before the start of play should he so desire.

If a Captain declares an innings closed less than 15 minutes before the resumption of 
play, and the other Captain is thereby prevented from exercising his option of 7 minutes 
rolling or if he is so prevented for any other reason the time for rolling shall be taken out of 
the normal playing time.

2.SWEEPING
Such sweeping of the pitch as is necessary during the match shall be done so that the 7 

minutes allowed for rolling the pitch provided for in 1. above is not affected.

3.MOWING
(a) Responsibility of Ground Authority & of Umpires

All mowings which are carried out before the toss for innings shall be the responsibility of
the Ground Authority. Thereafter they shall be carried out under the supervision of the 
Umpires, (See Law 7.2 - Selection & Preparation).
(b) Initial Mowing

The pitch shall be mown before play begins on the day the match is scheduled to start or
in the case of a delayed start on the day the match is expected to start.
(c) Subsequent Mowing in a Match of 2 or More Days' Duration

In a match of two or more days' duration, the pitch shall be mown daily before play 
begins. Should this mowing not take place because of weather conditions, rest days or 
other reasons the pitch shall be mown on the first day on which the match is resumed.
(d) Mowing of the Outfield in a match of 2 or More Days' Duration

In order to ensure that conditions are as similar as possible for both sides, the outfield 
shall normally be mown before the commencement of play on each day of the match, if 
ground and weather conditions allow.

4.WATERING
The pitch shall not be watered during a match.

5.RE-MARKING CREASES
Whenever possible the creases shall be re-marked.



6.MAINTENANCE OF FOOT HOLES
In wet weather, the Umpires shall ensure that the holes made by the Bowlers and 

Batsmen are cleaned out and dried whenever necessary to facilitate play. In matches of 2 
or more days' duration, the Umpires shall allow, if necessary, the re-turfing of foot holes 
made by the Bowler in his delivery stride, or the use of quick-setting fillings for the same 
purpose, before the start of each day's play.

7.SECURING OF FOOTHOLDS & MAINTENANCE OF PITCH
During play, the Umpires shall allow either Batsman to beat the pitch with his bat and 

players to secure their footholds by the use of sawdust, provided that no damage to the 
pitch is so caused, and Law 42 (Unfair Play) is not contravened.

Notes
(a) Non-Turf Pitches
Law 10 applies to turf pitches.
The game is played on non-turf pitches in many countries at various levels. Whilst the 
conduct of the game on these surfaces should always be in accordance with the Laws of 
Cricket, it is recognised that it may be necessary for Governing Bodies to lay down special 
playing conditions to suit the type of non-turf pitch used in their country.
In matches played against Touring Teams, any special playing conditions should be agreed 
in advance by both parties.
(b) Mowing of the Outfield in a Match of 2 or More Days' Duration
If, for reasons other than ground and weather conditions, daily and complete mowing is not
possible, the Ground Authority shall notify the Captains and Umpires, before the toss for 
innings, of the procedure to be adopted for such mowing during the match.
(c) Choice of Roller
If there is more than one roller available the Captain of the batting side shall have a choice.



Law 11 - Covering The Pitch
1.BEFORE THE START OF A MATCH

Before the start of a match complete covering of the pitch shall be allowed.

2.DURING A MATCH
The pitch shall not be completely covered during a match unless prior arrangement or 

regulations so provide.

3.COVERING BOWLERS' RUN-UP
Whenever possible, the Bowlers' run-up shall be covered, but the covers so used shall 

not extend further than 4ft./1.22m. in front of the popping crease.

Notes
(a) Removal of Covers
The covers should be removed as promptly as possible whenever the weather permits.



Law 12 - Innings
1.NUMBER OF INNINGS

A match shall be of one or two innings of each side according to agreement reached 
before the start of play.

2.ALTERNATE INNINGS
In a two innings match each side shall take their innings alternately except in the case 

provide for in Law 13 (The Follow-On).

3.THE TOSS
The Captains shall toss for the choice of innings on the field of play not later than 15 

minutes before the time scheduled for the match to start, or before the time agreed upon 
for play to start.

4.CHOICE OF INNINGS
The winner of the toss shall notify his decision to bat or to field to the opposing Captain 

not later than 10 minutes before the time scheduled for the match to start, or before the 
time agreed upon for play to start. The decision shall not thereafter be altered.

5.CONTINUATION AFTER ONE INNINGS OF EACH SIDE
Despite the terms of 1. above, in a one innings match, when a result has been reached 

on the first innings the Captains may agree to the continuation of play if, in their opinion, 
there is a prospect of carrying the game to a further issue in the time left (See Law 21 - 
Result).

Notes
(a) Limited Innings - One Innings Match
In a one innings match, each innings may, by agreement, be limited by a number of overs 
or by a period of time.
(b) Limited Innings - Two Innings Match
In a two innings match, the first innings of each side may, by agreement, be limited to a 
number of overs or by a period of time.



Law 13 - The Follow-On
1.LEAD ON FIRST INNINGS

In a two innings match the side which bats first and leads by 200 runs in a match of five 
days or more, by 150 runs in a three-day or four-day match, by 100 runs in a two-day 
match, or by 75 runs in a one-day match, shall have the option of requiring the other side 
to follow their innings.

2.DAY'S PLAY LOST
If no play takes place on the first day of a match of 2 or more days' duration, 1. above 

shall apply in accordance with the number of days' play remaining from the actual start of 
the match.



Law 14 - Declarations
1.TIME OF DECLARATION

The Captain of the batting side may declare an innings closed at any time during a 
match irrespective of its duration.

2.FORFEITURE OF SECOND INNINGS
A Captain may forfeit his second innings, provided his decision to do so it notified to the 

opposing Captain and Umpires in sufficient time to allow 7 minutes rolling of the pitch (See 
Law 10 - Rolling, Sweeping, Mowing, Watering the Pitch & Re-Marking of Creases). The 
normal 10 minute interval between innings shall be applied.



Law 15 - Start of Play
1.CALL OF PLAY

At the start of each innings and of each day's play and on the resumption of play after 
any interval or interruption the Umpire at the Bowler's end shall call "play".

2.PRACTICE ON THE FIELD
At no time on any day of the match shall there be any bowling or batting practice on the 

pitch. No practice may take place on the field if, in the opinion of the Umpires, it could 
result in a waste of time.

3.TRIAL RUN-UP
No Bowler shall have a trial run-up after "play" has been called in any session of play, 

except at the fall of a wicket when an Umpire may allow such a trial run-up if he is satisfied 
that it will not cause any waste of time.



Law 16 - Intervals
1.LENGTH

The Umpire shall allow such intervals as have been agreed upon for meals, and 10 
minutes between each innings.

2.LUNCHEON INTERVAL - INNINGS ENDING OR STOPPAGE WITHIN 10 MINUTES OF INTERVAL
If an innings ends or there is a stoppage caused by weather or bad light within 10 

minutes of the agreed time for the luncheon interval, the interval shall be taken 
immediately.

The time remaining in the session of play shall be added to the agreed length of the 
interval but no extra allowance shall be made for the 10 minutes interval between innings.

3.TEA INTERVAL - INNINGS ENDING OR STOPPAGE WITHIN 30 MINUTES OF INTERVAL
If an innings ends or there is a stoppage caused by weather or bad light within 30 

minutes of the agreed time for the tea interval, the interval shall be taken immediately.
The interval shall be of the agreed length and, if applicable, shall include the 10 minute 

interval between innings.

4.TEA INTERVAL -CONTINUATION OF PLAY
If at the agreed time for the tea interval, nine wickets are down, play shall continue for a 

period not exceeding 30 minutes or until the innings is concluded.

5.TEA INTERVAL - AGREEMENT TO FOREGO
At any time during the match, the Captains may agree to forego a tea interval.

6. INTERVALS FOR DRINKS
If both Captains agree before the start of a match that intervals for drinks may be taken, 

the option to take such intervals shall be available to either side. These intervals shall be 
restricted to one per session, shall be kept as short as possible, shall not be taken in the 
last hour of the match and in any case shall not exceed 5 minutes.

The agreed times for these intervals shall be strictly adhered to except that if a wicket 
falls within 5 minutes of the agreed time then drinks shall be taken out immediately.

If an innings ends or there is a stoppage caused by weather or bad light within 30 
minutes of the agreed time for a drinks interval, there will be no interval for drinks in that 
session.

At any time during the match the Captains may agree to forego any such drinks interval.

Notes
(a) Tea Interval - One- Day Match
In a one-day match, a specific time for the tea interval need not necessarily be arranged, 
and it may be agreed to take this interval between the innings of a one-innings match.
(b) Changing the Agreed Time of Intervals
In the event of the ground, weather or light conditions causing a suspension of play, the 
Umpires, after consultation with the Captains, may decide in the interests of time-saving, to



bring forward the time of the luncheon or tea interval.



Law 17 - Cessation of Play
1.CALL OF TIME

The Umpire at the Bowler's end shall call "time" on the cessation of play before any 
interval or interruption of play, at the end of each day's play, and at the conclusion of the 
match (See Law 27 - Appeals).

2.REMOVAL OF BAILS
After the call of "time", the Umpires shall remove the bails from both wickets.

3.STARTING A LAST OVER
The last over before an interval or the close of play shall be started provided the Umpire, 

after walking at his normal pace, has arrived at his position behind the stumps at the 
Bowler's end before time has been reached.

4.COMPLETION OF THE LAST OVER OF A SESSION
The last over before an interval or the close of play shall be completed unless a Batsman 

is out or retires during that over within 2 minutes of the interval or the close of play or 
unless the Players have occasion to leave the field.

5.COMPLETION OF THE LAST OVER OF A MATCH
An over in progress at the close of play on the final day of a match shall be completed at 

the request of either Captain even if a wicket falls after time has been reached.
If during the last over the Players have occasion to leave the field the Umpires shall call 

"time" and there shall be no resumption of play and the match shall be at an end.

6.LAST HOUR OF MATCH - NUMBER OF OVERS
The Umpires shall indicate when one hour of playing time of the match remains 

according to the agreed hours of play. The next over after that moment shall be the first of 
a minimum of 20 6-ball overs, (15 8-ball overs), provided a result is not reached earlier or 
there is no interval or interruption of play.

7.LAST HOUR OF MATCH - INTERVALS BETWEEN INNINGS & INTERRUPTIONS OF PLAY
If, at the commencement of the last hour of the match, an interval or interruption of play 

is in progress or if, during the last hour there is an interval between innings or an 
interruption of play, the minimum number of overs to be bowled on the resumption of play 
shall be reduced in proportion to the duration, within the last hour of the match, of any 
such interval or interruption.

The minimum number of overs to be bowled after a resumption of play shall be 
calculated as follows :-
(a) In the case of an interval or interruption of play being in progress at the commencement
of the last hour of the match, or in the case of a first interval or interruption a deduction 
shall be made from the minimum of 20 6-ball overs (or 15 8-ball overs).
(b) If there is a later interval or interruption a further deduction shall be made from the 
minimum number of overs which should have been bowled following the last resumption of 
play.



(c) These deductions shall be based on the following factors :-
(i) The Number of overs already bowled in the last hour of the match or, in the case of a 
later interval or interruption in the last session of play.
(ii) The number of overs lost as a result of the interval or interruption allowing one 6-ball 
over for every full three minutes (or one 8-ball over for every full four minutes) of interval
or interruption.
(iii) Any over left uncompleted at the end of an innings to be excluded from these 
calculations.
(iv) Any over of the minimum number to be played which is left uncompleted at the start 
of an interruption of play shall be completed when play is resumed and to count as one 
over bowled.
(v) An interval to start with the end of an innings and to end 10 minutes later, an 
interruption to start on the call of "time" and to end on the call of "play".

(d) In the event of an innings being completed and a new innings commencing during the 
last hour of the match, the number of overs to be bowled in the new innings shall be 
calculated on the basis of one 6-ball over for every three minutes or part thereof remaining 
for play (or one 8-ball over for every four minutes or part thereof remaining for play); or 
alternatively on the basis that sufficient overs be bowled to enable the full minimum quota 
of overs to be completed under circumstances governed by (a), (b) and (c) above. In all 
such cases the alternative which allows the greater number of overs shall be employed.

8.BOWLER UNABLE TO COMPLETE AN OVER DURING LAST HOUR OF THE MATCH
If, for any reason, a Bowler is unable to complete an over during the period of play 

referred to in 6. above, Law 22.7. (Bowler Incapacitated or Suspended during an Over) shall
apply.



Law 18 - Scoring
1.A RUN

The score shall be reckoned by runs. A run is scored :-
(a) So often as the Batsman, after a hit or at any time while the ball is in play, shall have 
crossed and made good their ground from end to end.
(b) When a boundary is scored (See Law 19 - Boundaries).
(c) When penalty runs are awarded. See 6. below.

2.SHORT RUNS
(a) If either Batsman runs a short run, the Umpire shall call and signal "one short" as soon 
as the ball becomes dead and that run shall not be scored. A run is short if a Batsman fails 
to make good his ground on turning for a further run.
(b) Although a short run shortens the succeeding one, the latter, if completed shall count.
(c) If either or both Batsman deliberately run short the Umpire shall, as soon as he sees 
that the fielding side have no chance of dismissing either Batsman, call and signal "dead 
ball" and disallow any runs attempted or previously scored. The Batsman shall return to 
their original ends.
(d) If both Batsman run short in one and the same run, only one run shall be deducted.
(e) Only if three or more runs are attempted can more than one be short and then, subject 
to (c) and (d) above, all runs so called shall be disallowed. If there has been more than one 
short run the Umpires shall instruct the Scorers as to the number of runs disallowed.

3.STRIKER CAUGHT
If the Striker is Caught, no run shall be scored.

4.BATSMAN RUN OUT
If a Batsman is Run Out, only that run which was being attempted shall not be scored. If, 

however, an injured Striker himself is run out no runs shall be scored (See Law 2.7 - 
Transgression of the Laws by an Injured Batsman or Runner).

5.BATSMAN OBSTRUCTING THE FIELD
If a Batsman is out Obstructing the Field, any runs completed before the obstruction 

occurs shall be scored unless such obstruction prevents a catch being made in which case 
no runs shall be scored.

6.RUNS SCORED FOR PENALTIES
Runs shall be scored for penalties under Laws 20 (Lost Ball), Law 24 (No Ball), Law 25. 

(Wide Ball), Law 41.1. (Fielding the Ball) and for boundary allowances under Law 19. 
(Boundaries).

7.BATSMAN RETURNING TO WICKET HE HAS LEFT
If while the ball is in play, the Batsman have crossed in running, neither shall return to 

the wicket he has left even though a short run has been called or no run has been scored 
as in the case of a catch. Batsmen, however, shall return to the wickets they originally left 



in the cases of a boundary and of any disallowance of runs and of an injured Batsman 
being, himself, run out (See Law 2.7 - Transgression of the Laws by an Injured Batsman or 
Runner).

Notes
(a) Short Run
A Striker taking stance in front of his popping crease may run from that point without 
penalty.



Law 19 - Boundaries
1.THE BOUNDARY OF THE PLAYING AREA

Before the toss for innings, the Umpires shall agree with both Captains on the boundary 
of the playing area. The boundary shall, if possible, be marked by a white line, a rope laid 
on the ground, or a fence. If flags or posts only are used to mark a boundary, the imaginary
line joining such points shall be regarded as the boundary. An obstacle, or person, within 
the playing area shall not be regarded as a boundary unless so decided by the Umpires 
before the toss for innings. Sight-screens within, or partially within, the playing area shall 
be regarded as the boundary and when the ball strikes or passes within or under or directly 
over any part of the screen, a boundary shall be scored.

2.RUNS SCORED FOR BOUNDARIES
Before the toss for innings, the Umpires shall agree with both Captains the runs to be 

allowed for boundaries, and in deciding the allowance for them, the Umpires and Captains 
shall be guided by the prevailing custom of the ground. the allowance for a boundary shall 
normally be 4 runs, and 6 runs for all hits pitching over and clear of the boundary line or 
fence, even though the ball has been previously touched by a Fieldsman, 6 runs shall also 
be scored if a Fieldsman, after catching a ball, carries it over the boundary (See Law 32 - 
Caught, Note (a)). 6 runs shall not be scored when a ball struck by the Striker hits a sight 
screen full pitch if the screen is within, or partially within, the playing area, but if the ball is 
struck directly over a sight screen so situated, 6 runs shall be scored.

3.A BOUNDARY
A boundary shall be scored and signalled by the Umpire at the Bowler's end whenever, in

his opinion :-
(a) A ball in play touches or crosses the boundary, however marked.
(b) A Fieldsman with ball in hand touches or grounds any part of his person on or over a 
boundary line.
(c) A Fieldsman with ball in hand grounds any part of his person over a boundary fence or 
board. This allows the Fieldsman to touch or lean on or over a boundary fence or board ion 
preventing a boundary.

4.RUNS EXCEEDING BOUNDARY ALLOWANCE
The runs completed at the instant the ball reaches the boundary shall count if they 

exceed the boundary allowance.

5.OVERTHROWS OR WILFUL ACT OF A FIELDSMAN
If the boundary results from an overthrow or from the wilful act of a Fieldsman, any runs 

already completed and the allowance shall be added to the score. The run in progress shall 
count provided that the Batsmen have crossed at the instant of the throw or act.

Notes
(a) Position of Sight-Screens
Sight screens should, if possible, be positioned wholly outside the playing area, as near as 
possible to the boundary line.





Law 20 - Lost Ball
1.RUNS SCORED

If a ball in play cannot be found or recovered any fieldsman may call "lost ball" when 6 
runs shall be added to the score; but if more than 6 have been run before "lost ball" is 
called, as many runs as have been completed shall be scored. The run in progress shall 
count provided that the Batsmen have crossed at the instant of the call of "lost ball".

2.HOW SCORED
The runs shall be added to the score of the Striker if the ball has been struck, but 

otherwise to the score of byes, leg-byes, no-balls or wides as the case may be.



Law 21 - The Result
1.A WIN - TWO INNINGS MATCHES

The side which has scored a total of runs in excess of that scored by the opposing side in 
its two completed innings shall be the winners.

2.A WIN - ONE INNINGS MATCHES
(a) One innings matches, unless played out as in 1. above, shall be decided on the first 
innings (but see Law 12.5 - Continuation After One Innings of Each Side).
(b) If the Captains agree to continue play after the completion of one innings of each side in
accordance with Law 12.5 (Continuation After One Innings of Each Side) and a result is not 
achieved on the second innings, the first innings result shall stand.

3.UMPIRES AWARDING A MATCH
(a) A match shall be lost by a side which, during the match,

(i) refuses to play, or
(ii) Concedes defeat,

and the Umpires shall award the match to the other side.
(b) Should both Batsman at the wickets or the fielding side leave the field at any time 
without the agreement of the Umpires, this shall constitute a refusal to play and, on appeal,
the Umpires shall award the match to the other side in accordance with (a) above.

4.A TIE
The result of a match shall be a tie when the scores are equal at the conclusion of play, 

but only if the side batting last has completed its innings.
If the scores of the completed innings of a one-day match are equal, it shall be a tie but 

only if the match has not been played out to a further conclusion.

5.A DRAW
A match not determined in any of the ways as in 1, 2, 3 and 4. above shall count as a 

draw.

6.CORRECTNESS OF RESULT
Any decision as to the correctness of the scores shall be the responsibility of the Umpires

(See Law 3.14 - Correctness of Scores).
If, after the Umpires and Players have left the field, in the belief that the match has been 

concluded, the Umpires decide that a mistake in scoring has occurred, which affects the 
result, and provided time has not been reached, they shall order play to resume and to 
continue until the agreed finishing time unless a result is reached earlier.

If the Umpires decide that a mistake has occurred and time has been reached, the 
Umpires shall immediately inform both Captains of the necessary corrections to the scores 
and, if applicable, to the result.

7.ACCEPTANCE OF RESULT
In accepting the scores as notified by the scorers and agreed by the Umpires, the 



Captains of both sides thereby accept the result.

Notes
(a) Statement of Results
The result of a finished match is stated as a win by runs, except in the case of a win by the 
side batting last when it is by the number of wickets still then to fall.
(b) Winning Hit or Extra
As soon as the side has won, see 1 and 2. above, the Umpire shall call "time", the match is 
finished, and nothing that happens thereafter other than as a result of a mistake in scoring,
see 6. above, shall be regarded as part of the match.
However, if a boundary constitutes the winning hit - or extras - and the boundary allowance
exceeds the number of runs required to win the match, such runs scored shall be credited 
to the side's total and, in the case of a hit to the Striker's score.



Law 22 - The Over
1.NUMBER OF BALLS

The ball shall be bowled from each wicket alternatively in overs of either 6 or 8 balls 
according to agreement before the match.

2.CALL OF "OVER"
When the agreed number of balls has been bowled, and as the ball becomes dead or 

when it becomes clear to the Umpire at the Bowler's end that both the fielding side and the
Batsmen at the wicket have ceased to regard the ball as in play, the Umpire shall call 
"over" before leaving the wicket.

3.NO BALL OR WIDE BALL
Neither a no ball nor a wide ball shall be reckoned as one of the over.

4.UMPIRE MISCOUNTING
If an Umpire miscounts the number of balls, the over as counted by the Umpire shall 

stand.

5.BOWLER CHANGING ENDS
A Bowler shall be allowed to change ends as often as desired provided only that he does 

not bowl two overs consecutively in an innings.

6.THE BOWLER FINISHING AN OVER
A Bowler shall finish an over in progress unless he be incapacitated or be suspended 

under Law42.8 (The Bowling of Fast Short Pitched Balls), Law 42.9 (The Bowling of Fast High
Full Pitches), Law 42.10 (Time Wasting) and Law 42.11 (Players Damaging the Pitch). If an 
over is left incomplete for any reason at the start of an interval or interruption of play, it 
shall be finished on the resumption of play.

7.BOWLER INCAPACITATED OR SUSPENDED DURING AND OVER
If, for any reason, a Bowler is incapacitated while running up to bowl the first ball of an 

over, or is incapacitated or suspended during an over, the Umpire shall call and signal 
"dead ball" and another Bowler shall be allowed to bowl or complete the over from the 
same end, provided only that he shall not bowl two overs, or part thereof, consecutively in 
one innings.

8.POSITION OF NON-STRIKER
The Batsman at the Bowler's end shall normally stand on the opposite side of the wicket 

to that which the ball is being delivered, unless a request to do otherwise is granted by the 
Umpire.



Law 23 - Dead Ball
1.THE BALL BECOMES DEAD, WHEN :-
(a) It is finally settled in the hands of the Wicket Keeper or the Bowler.
(b) It reaches or pitches over the boundary.
(c) A Batsman is out.
(d) Whether played or not, it lodges in the clothing or equipment of a Batsman or the 
clothing of an Umpire.
(e) A ball lodges in a protective helmet worn by a member of the fielding side.
(f) A penalty is awarded under Law 20. (Lost Ball) or Law 41.1. (Fielding the Ball)
(g) The Umpire calls "over" or "time"

2.EITHER UMPIRE SHALL CALL & SIGNAL "DEAD BALL", WHEN :-
(a) He intervenes in a case of unfair play.
(b) A serious injury to a Player or Umpire occurs.
(c) He is satisfied that, for an adequate reason, the Striker is not ready to receive the ball 
and makes no attempt to play it.
(d) The Bowler drops the ball accidentally before delivery, or the ball does not leave his 
hand for any reason, other than in an attempt to run out the Non-Striker, (See Law 24.5 - 
Bowler Attempting to Run Out Non Striker Before Delivery).
(e) One or both bails fall from the Striker's wicket before he receives delivery.
(f) He leaves his normal position for consultation.
(g) He is required to do so under Law 26.3. (Disallowance of Leg-Byes), etc.

3.THE BALL CEASES TO BE DEAD, WHEN :-
(a) The Bowler starts his run up to bowling action.

4.THE BALL IS NO DEAD, WHEN :-
(a) It strikes an Umpire (unless it lodges in his dress).
(b) The wicket is broken or struck down (unless a Batsman is out thereby).
(c) An unsuccessful appeal is made.
(d) The wicket is broken accidentally either by the Bowler during his delivery or by a 
Batsman in running.
(e) The Umpire has called "no ball" or "wide".

Notes
(a) Ball Finally Settled
Whether the ball is finally settled or not - see 1a above - must be a question for the 
Umpires alone to decide.
(b) Action on Call of "Dead Ball"

(i) If "dead ball" is called prior to the Striker receiving a delivery the Bowler shall be 
allowed an additional ball.
(ii) If "dead ball" is called after the Striker receives a delivery the Bowler shall not be 



allowed an additional ball, unless a "no-ball" or "wide" has been called.



Law 24 - No Ball
1. MODE OF DELIVERY

The Umpire shall indicate to the Striker whether the Bowler intends to bowl over or round
the wicket, over arm or underarm, or right or left-handed. Failure on the part of the Bowler 
to indicate in advance a change in his mode of delivery is unfair and the Umpire shall call 
and signal "no ball".

2. FAIR DELIVERY - THE ARM
For a delivery to be fair the ball must be bowled not thrown, see Note (a) below. If either 

Umpire is not entirely satisfied with the absolute fairness of a delivery in this respect he 
shall call and signal "no ball" instantly upon delivery.

3. FAIR DELIVERY - THE FEET
The Umpire at the bowler's wicket shall call and signal "no ball" if he is not satisfied that 

in the delivery stride :-
(a) the Bowler's back foot landed within and not touching the return crease or its forward 
extension
or
(b) some part of the front foot whether grounded or raised was behind the popping crease.

4. BOWLER THROWING AT STRIKER'S WICKET BEFORE DELIVERY
If the Bowler, before delivering the ball, throws it at the Striker's wicket in an attempt to 

run him out, the Umpire shall call and signal "no ball" (See Law 42.12. - Batsman Unfairly 
Stealing a Run & Law38. - Run Out)

5. BOWLER ATTEMPTING TO RUN OUT NON-STRIKER BEFORE DELIVERY
If the Bowler, before delivering the ball, attempts to run out the non-Striker, any runs 

which result shall be allowed and shall be scored as no balls. Such an attempt shall not 
count as a ball in the over. The Umpire shall not call "no ball" (See Law 42.12. - Batsman 
Unfairly Stealing a Run).

6. INFRINGEMENT OF LAWS BY A WICKET-KEEPER OR A FIELDSMAN
The Umpire shall call and signal "no ball" in the event of the Wicket-Keeper infringing 

Law 40.1 (Limitation of On-Side Fieldsman) or Law41.3. (Position of Fieldsmen).

7. REVOKING A CALL
An Umpire shall revoke the call "no ball" if the ball does not leave the Bowler's hand for 

any reason (See Law 23.2. - Either Umpire Shall Call and Signal "Dead Ball").

8. PENALTY
A penalty of one run for a no ball shall be scored if no runs are made otherwise.

9. RUNS FROM A NO BALL



The Striker may hit a no ball and whatever runs result shall be added to his score. Runs 
made otherwise from a no ball shall be scored no balls.

10. OUT FROM A NO BALL
The Striker shall be out from a no ball if he breaks Law 34. (Hit the Ball Twice) and either 

Batsman may be Run Out or shall be given out if either breaks Law 33. (Handled the Ball) or
Law37. (Obstructing the Field)

11. BATSMAN GIVEN OUT OFF A NO BALL
Should a Batsman be given out off a no ball the penalty for bowling it shall stand unless 

runs are otherwise scored.

Notes
(a) Definition of a Throw
A ball shall be deemed to have been thrown if, in the opinion of either Umpire, the process 
of straightening the bowling arm, whether it be partial or complete, takes place during that 
part of the delivery swing which directly precedes the ball leaving the hand. This definition 
shall not debar a Bowler from the use of the wrist in the delivery swing.
(b) No Ball not Counting in Over
A no ball shall not be reckoned as one for the over (See Law 22.3. - No Ball or Wide Ball)



Law 25 - Wide Ball
1. JUDGING A WIDE

If the Bowler bowls the ball so high over or so wide of the wicket that, in the opinion of 
the Umpire it passes out of reach of the Striker, standing in a normal guard position, the 
Umpire shall call and signal "wide ball" as soon as it has passed the line of the Striker's 
wicket.

The Umpire shall not adjudge a ball as being wide if :-
(a) The Striker, by moving from his guard position, causes the ball to pass out of his reach.
(b) The Striker moves and thus brings the ball within his reach.

2. PENALTY
A penalty of one run for a wide ball shall be scored if no runs are made otherwise.

3. BALL COMING TO REST IN FRONT OF THE STRIKER
If a ball which the Umpire considers to have been delivered, comes to rest in front of the 

line of the Striker's wicket, "wide" shall not be called. The Striker has a right, without 
interference from the fielding side, to make one attempt to hit the ball. If the fielding side 
interfere, the Umpire shall replace the ball where it came to rest and shall order the 
Fieldsmen to resume the places they occupied in the field before the ball was delivered.

The Umpire shall call and signal "dead ball" as soon as it is clear that the Striker does not
intend to hit the ball, or after the Striker has made one unsuccessful attempt to hit the ball.

4. REVOKING A CALL
The Umpire shall revoke the call if the Striker hits a ball which has been called "wide".

5. BALL NOT DEAD
The ball does not become dead on the call of "wide ball" (See Law 23.4. - The Ball is Not 

Dead).

6. RUNS RESULTING FROM A WIDE
All runs which are run or result from a wide ball which is not a no ball shall be scored 

wide balls, or if no runs are made one shall be scored.

7. OUT FROM A WIDE
The Striker shall be out from a wide ball if he breaks Law 35. (Hit Wicket) or Law 39. 

(Stumped). Either Batsman may be Run Out and shall be out if he breaks Law 33. (Handled 
the Ball) or Law 37. (Obstructing the Field).

8. BATSMAN GIVEN OUT OFF A WIDE
Should a Batsman be given out off a wide, the penalty for bowling it shall stand unless 

runs are otherwise made.

Notes



(a) Wide Ball not Counting in Over
A wide ball shall not be reckoned as one of the over (See Law 22.3. - No Ball or Wide Ball).



Law 26 - Bye & Leg-Bye
1. BYES

If the ball, not having been called "wide" or "no ball" passes the striker without touching 
his bat or person, and any runs are obtained, the Umpire shall signal "bye" and the run or 
runs shall be credited as such to the batting side.

2. LEG-BYES
If the ball, not having been called "wide" or "no ball" is unintentionally deflected by the 

Striker's dress or person, except a hand holding the bat, and any runs are obtained the 
Umpire shall signal "leg-bye" and the run or runs so scored shall be credited as such to the 
batting side.

Such leg-byes shall only be scored if, in the opinion of the Umpire, the Striker has :-
(a) Attempted to play the ball with his bat, or
(b) Tried to avoid being hit by the ball.

3. DISALLOWANCE OF LEG-BYES
In the case of a deflection by the Striker's person, other than in 2(a) and (b) above, the 

Umpire shall call and signal "dead ball" as soon as one run has been completed or when it 
is clear that a run is not being attempted or the ball has reached the boundary.

On the call and signal of "dead ball" the Batsman shall return to their original ends and 
no runs shall be allowed.



Law 27 - Appeals
1. TIME OF APPEALS

The Umpires shall not give a Batsman out unless appealed to by the other side which 
shall be done prior to the Bowler beginning his run-up or bowling action to deliver the next 
ball. Under Law 23.1.(g) (The Ball Becomes Dead) the ball is dead on "over" being called; 
this does not, however, invalidate an appeal made prior to the first ball of the following over
provided "time" has not been called (See Law 17.1. - Call of Time)

2. AN APPEAL "HOW'S THAT?"
An appeal "How's That?" shall cover all ways of being out.

3. ANSWERING APPEALS
The Umpire at the Bowler's wicket shall answer appeals before the other Umpire in all 

cases except those arising out of Law 35. (Hit Wicket) or Law 39. (Stumped) or Law38. (Run 
Out) when this occurs at the Striker's wicket.

When either Umpire has given a Batsman not out, the other Umpire shall, within his 
jurisdiction, answer the appeal or a further appeal, provided it is made in time in 
accordance with 1. above (Time of Appeals).

4. CONSULTATION BY UMPIRES
An Umpire may consult with the other Umpire on a point of fact which the latter may 

have been in a better position to see and shall then give his decision. If, after consultation, 
there is still doubt remaining the decision shall be in favour of the Batsman.

5. BATSMAN LEAVING HIS WICKET UNDER A MISAPPREHENSION
The Umpires shall intervene if satisfied that a Batsman, not having been given out, has 

left his wicket under a misapprehension that he has been dismissed.

6. UMPIRE'S DECISION
The Umpire's decision if final. He may alter his decision, provided that such alteration is 

made promptly.

7. WITHDRAWAL OF AN APPEAL
In exceptional circumstances the Captain of the fielding side may seek permission of the 

Umpire to withdraw an appeal providing the outgoing Batsman has not left the playing area.
If this is allowed, the Umpire shall cancel his decision.



Law 28 - The Wicket Is Down
1. WICKET DOWN

The wicket is down if :-
(a) Either the ball or the Striker's bat or person completely removes either bail from the top 
of the stumps. A disturbance of a bail, whether temporarily or not, shall not constitute a 
complete removal, but the wicket is down if a bail in falling lodges between two of the 
stumps.
(b) Any player completely removes with his hand or arm a bail from the top of the stumps, 
providing that the bail is held in that hand or in the hand of the arm so used.
(c) When both bails are off, a stump is struck out of the ground by the ball, or a player 
strikes or pulls a stump out of the ground, providing the ball is held in the hand(s) or in the 
hand of the arm so used.

2. ONE BAIL OFF
If one bail is off, it shall be sufficient for the purpose of putting the wicket down to 

remove the remaining bail, or to strike or pull any of the three stumps out of the ground in 
any of the ways stated in 1. above.

3. ALL THE STUMPS OUT OF THE GROUND
If all the stumps are out of the ground, the fielding side shall be allowed to put back one 

or more stumps in order to have an opportunity of putting the wicket down.

4. DISPENSING WITH BAILS
If owing to the strength of wind, it has been agreed to dispense with the bails in 

accordance with Law 8. Note (a) (dispensing with Bails) the decision as to when the wicket 
is down is one for the Umpires to decide on the facts before them. In such circumstances 
and if the Umpires so decide the wicket shall be held to be down even though a stump has 
not been struck out of the ground.

Notes
(a) Remaking the Wicket
If the wicket is broken while the ball is in play, it is not the Umpire's duty to remake the 
wicket until the ball has become dead (See Law 23. - Dead Ball). A member of the fielding 
side, however, may remake the wicket in such circumstances.



Law 29 - Batsman Out Of His Ground
1. WHEN OUT OF HIS GROUND

A Batsman shall be considered to be out of his ground unless some part of his bat in his 
hand or his person is grounded behind the line of the popping crease.



Law 30 - Bowled
1. OUT BOWLED

The Striker shall be out bowled if :-
(a) His wicket is bowled down, even if the ball first touches his bat or person
(b) He breaks his wicket by hitting or kicking the ball on to it before the completion of a 
stroke, or as a result of attempting to guard his wicket (see Law 34.1. - Out - Hit the Ball 
Twice).

Notes
(a) Out Bowled - Not L.B.W.
The Striker is out Bowled if the ball is deflected on to his wicket even though a decision 
against him would be justified under Law 36. (Leg Before Wicket).



Law 31 - Timed Out
1. OUT TIMED OUT

An incoming Batsman shall be out Timed Out if he wilfully takes more than two minutes 
to come in - the two minutes being timed from the moment a wicket falls until the new 
batsman steps on to the field of play.

If this is not complied with and if the Umpire is satisfied that the delay was wilful and if 
an appeal is made, the new Batsman shall be given out by the Umpire at the Bowler's end.

2. TIME TO BE ADDED
The time taken by the Umpires to investigate the cause of the delay shall be added at 

the normal close of play.

Notes
(a) Entry in Score Book
The correct entry in the score book when a Batsman is given out under this Law is "timed 
out", and the Bowler does not get credit for the wicket.
(b) Batsmen Crossing on the Field of Play
It is an essential duty of the Captains to ensure that the in-going Batsman passes the out-
going one before the latter leaves the field of play.



Law 32 - Caught
1. OUT CAUGHT

The Striker shall be out Caught if the ball touches his bat or if it touches below the wrist 
his hand or glove, holding the bat, and is subsequently held by a Fieldsman before it 
touches the ground.

2. A FAIR CATCH
A catch shall be considered to have been fairly made if :-

(a) The Fieldsman is within the field of play throughout the act of making the catch.
(i) The Act of making the catch shall start from the time when the Fieldsman first handles
the ball and shall end when he both retains complete control over the further disposal of 
the ball and remains within the field of play.
(ii) In order to be within the field if play, the Fieldsman may not touch or ground any part 
of his person on or over a boundary line. When the boundary is marked by a fence or 
board the Fieldsman may not ground any part of his person over the boundary fence or 
board, but may touch or lean over the boundary fence or board in completing the catch.

(b) The ball is hugged to the body of the catcher or accidentally lodges in his dress or, in 
the case of the Wicket-Keeper, in his pads. However, a Striker may not be caught if a ball 
lodges in a protective helmet worn by a Fieldsman, in which case the Umpire shall call and 
signal "dead ball" (See Law 23. - Dead Ball)
(c) The ball does not touch the ground even though a hand holding it does so in effecting 
the catch.
(d) A Fieldsman catches the ball, after it has been lawfully played a second time by the 
Striker, but only if the ball has not touched the ground since being first struck.
(e) A Fieldsman catches the ball after it has touched an Umpire, another Fieldsman or the 
other Batsman. However a Striker may not be caught if a ball has touched a protective 
helmet worn by a Fieldsman.
(f) The ball is caught off an obstruction within the boundary provided it has not previously 
been agreed to regard the obstruction as a boundary.

3. SCORING OF RUNS
If a Striker is caught, no runs shall be scored.

Notes
(a) Scoring from an Attempted Catch
When a Fieldsman carrying the ball touches or grounds any part of his person on or over a 
boundary marked by a line, 6 runs shall be scored.
(b) Ball Still in Play
If a Fieldsman releases the ball before he crosses the boundary, the ball will be considered 
to be still in play and it may be caught by another Fieldsman. However, if the original 
Fieldsman returns to the field of play and handles the ball, a catch may not be made.



Law 33 - Handled The Ball
1. OUT HANDLED THE BALL

Either Batsman on appeal shall be out Handled the Ball if he wilfully touches the ball 
while in play with the hand not holding the bat unless he does so with the consent of the 
opposite side.

Notes
(a) Entry in Score Book
The correct entry in the score book when a Batsman is given out under this Law is "handled
the ball", and the Bowler does not get credit for the wicket.



Law 34 - Hit The Ball Twice
1. OUT HIT THE BALL TWICE

The Striker, on appeal, shall be out Hit the Ball Twice if, after the ball is struck or is 
stopped by any part of his person, he wilfully strikes it again with his bat or person except 
for the sole purpose of guarding his wicket: this he may do with his bat or any part of his 
person other than his hands, but see Law 37.2. (Obstructing a Ball From Being Caught).
For the purpose of this Law, a hand holding the bat shall be regarded as part of the bat.

2. RETURNING THE BALL TO A FIELDSMAN
The Striker, on appeal, shall be out under this Law, if, without the consent of the opposite

side, he uses his bat or person to return the ball to any of the fielding side.

3. RUNS FROM BALL LAWFULLY STRUCK TWICE
No runs except those which result from an overthrow or penalty, (See Law 41. - The 

Fieldsman) shall be scored from a ball lawfully struck twice.

Notes
(a) Entry in Score Book
The correct entry in the score book when the Striker is given out under this Law is "hit the 
ball twice", and the Bowler does not get credit for the wicket.
(b) Runs Credited to the Batsman
Any runs awarded under 3. above as a result of an overthrow or penalty shall be credited to
the Striker, provided the ball in the first instance has touched the bat, or, if otherwise as 
extras.



Law 35 - Hit Wicket
1. OUT HIT WICKET

The Striker shall be out Hit Wicket if, while the ball is in play :-
(a) His wicket is broken with any part of his person, dress, or equipment as a result of any 
action taken by him in preparing to receive or in receiving a delivery, or in setting off for his
first run, immediately after playing, or playing at, the ball.
(b) He hits down his wicket whilst lawfully making a second stroke for the purpose of 
guarding his wicket within the provisions of Law34.1. (Out Hit The Ball Twice).

Notes
(a) Not Out Hit Wicket
A Batsman is not out under this Law should his wicket be broken in any of the ways referred
to in 1(a) above if :-

(i) It occurs while he is in the act of running, other than in setting off for his first run 
immediately after playing at the ball, or while he is avoiding being run out or stumped.
(ii) The Bowler after starting his run-up or bowling action does not deliver the ball; in 
which case the Umpire shall immediately call and signal "dead ball".
(iii) It occurs whilst he is avoiding a throw-in at any time.



Law 36 - Leg Before Wicket
1. OUT L.B.W

The Striker shall be out L.B.W. in the circumstances set out below :-
(a) Striker Attempting to Play the Ball
The Striker shall be out L.B.W. if he first intercepts with any part of his person, dress or 
equipment a fair ball which would have hit the wicket and which has not previously touched
his bat or a hand holding the bat, providing that :-

(i) The ball pitch, in a straight line between wicket and wicket or on the off side of the 
Striker's wicket, or was intercepted full pitch.
and
(ii) The point of impact is in a straight line between wicket and wicket, even if above the 
level of the bails.

(b) Striker Making No Attempt to Play the Ball
The Striker shall be out L.B.W. even if the ball is intercepted outside the line of the off-

stump, if, in the opinion of the Umpire, he has made no genuine attempt to play the ball 
with his bat, but has intercepted the ball with some part of his person and if the other 
circumstances set out in (a) above apply.



Law 37 - Obstructing The Field
1. WILFUL OBSTRUCTION

Either Batsman, on appeal, shall be out Obstructing the Field if he wilfully obstructs the 
opposite side by word or action.

2. OBSTRUCTING A BALL FROM BEING CAUGHT
The Striker, on appeal, shall be out should wilful obstruction by either Batsman prevent a

catch being made.
This shall apply even though the Striker causes the obstruction in lawfully guarding his 

wicket under the provisions of Law 34 (see Law 34.1 - Out Hit the Ball Twice).

Notes
(a) Accidental Obstruction
The Umpires must decide whether the obstruction was wilful or not. The accidental 
interception of a throw-in by a Batsman while running does not break this Law.
(b) Entry in Score Book
The correct entry in the score book when a Batsman is given out under this Law is 
"obstructing the field", and the bowler does not get credit for the wicket.



Law 38 - Run Out
1. OUT RUN OUT

Either Batsman shall be out Run Out if in running or at any time while the ball is in play - 
except in the circumstances described in Law 39. (Stumped) - he is out of his ground and 
his wicket is put down by the opposite side. If, however, a Batsman in running makes good 
his ground he shall not be out Run Out, if he subsequently leaves his ground, in order to 
avoid injury, and the wicket is put down.

2. "NO BALL" CALLED
If a no ball has been called, the Striker shall not be given Run Out unless he attempts to 

run.

3. WHICH BATSMAN IS OUT
If the Batsman have crossed in running, he who runs for the wicket which is put down 

shall be out; if they have not crossed, he who has left the wicket which is put down shall be 
out. If a Batsman remains in his ground or returns to his ground and the other Batsman 
joins him there, the latter shall be out if his wicket is put down.

4. SCORING OF RUNS
If a Batsman is run out, only that run which is being attempted shall not be scored. If 

however and injured Striker himself is run out, no runs shall be scored (See Law 2.7. - 
Transgression of the Laws by an Injured Batsman or Runner).

Notes
(a) Ball played on to Opposite Wicket
If the ball is played on to the opposite wicket neither Batsman is liable to be Run Out unless
the ball has been touched by a Fieldsman before the wicket is broken.
(b) Entry in Score Book
The correct entry in the score book when the Striker is given out under this Law is "run 
out", and the Bowler does not get credit for the wicket.
(c) Run Out off a Fieldsman's Helmet
If, having been played by a Batsman, or having come off his person, the ball rebounds 
directly from a Fieldsman's helmet on to the stumps, with either Batsman out of his ground,
the Batsman shall be "Not Out".



Law 39 - Stumped
1. OUT STUMPED

The Striker shall be out Stumped if, in receiving the ball, not being a no-ball, he is out of 
his ground otherwise than in attempting a run and the wicket is put down by the Wicket-
Keeper without the intervention of another Fieldsman.

2. ACTION BY THE WICKET-KEEPER
The Wicket-Keeper may take the ball in front of the wicket in an attempt to Stump the 

Striker only if the ball has touched the bat or person of the Striker.

Notes
(a) Ball Rebounding from Wicket-Keeper's Person
The Striker may be out Stumped if in the circumstances stated in 1. above, the wicket is 
broken by a ball rebounding from the Wicket-Keeper's person or equipment other than a 
protective helmet or is kicked or thrown by the Wicket-Keeper on to the wicket.



Law 40 - The Wicket-Keeper
1. POSITION OF WICKET-KEEPER

The Wicket-Keeper shall remain wholly behind the wicket until a ball delivered by the 
Bowler touches the bat or person of the Striker, or passes the wicket, or until the Striker 
attempts a run. In the event of the Wicket-Keeper contravening this Law, the Umpire at the 
Striker's end shall call and signal "no ball" at the instant of delivery or as soon as possible 
thereafter.

2. RESTRICTION ON ACTIONS OF THE WICKET-KEEPER
If the Wicket-Keeper interferes with the Striker's right to play the ball and to guard his 

wicket, the Striker shall not be out, except under Laws 33. (Handled the Ball), Law 34. (Hit 
the Ball Twice), Law 37. (Obstructing the Field) and Law 38. (Run Out).

3. INTERFERENCE WITH THE WICKET-KEEPER BY THE STRIKER
If in the legitimate defence of his wicket, the Striker interferes with the Wicket-Keeper, he

shall not be out, except as provided for in Law 37.2. (Obstructing a Ball from Being Caught).



Law 41 - The Fieldsman
1. FIELDING THE BALL

The Fieldsman may stop the ball with any part of his person, but if he wilfully stops it 
otherwise, 5 runs shall be added to the run or runs already scored; if no run has been 
scored 5 penalty runs shall be awarded. The run in progress shall count provided that the 
Batsmen have crossed at the instant of the act. If the ball has been struck, the penalty shall
be added to the score of the Striker, but otherwise to the score of byes, leg-byes, no balls or
wides as the case may be.

2. LIMITATION OF ON-SIDE FIELDSMEN
The number of on-side Fieldsmen behind the popping crease at the instant of the 

Bowler's delivery shall not exceed two. In the event of infringement by the fielding side the 
Umpire at the Striker's end shall call and signal "no ball" at the instant of delivery or as 
soon as possible thereafter.

3. POSITION OF FIELDSMEN
Whilst the ball is in play and until the ball has made contact with the bat or the Striker's 

person or has passed his bat, no Fieldsman, other than the Bowler, may stand on or have 
any part of his person extended over the pitch (measuring 22 yards/20.12m. x 
10ft./3.05m.). In the event of a Fieldsman contravening the law, the Umpire at the bowler's 
end shall call and signal "no ball" at the instant of delivery or as soon as possible thereafter 
(See Law 40.1. - Position of Wicket-Keeper).

4. FIELDSMAN'S PROTECTIVE HELMETS
Protective helmets, when not in use by members of the fielding side, shall only be 

placed, if above the surface, on the ground behind the Wicket-Keeper. In the event of the 
ball, when in play, striking a helmet whilst in this position, five penalty runs shall be 
awarded, as laid down in Law41.1 and Note(a).

Notes
(a) Batsmen Changing Ends
The 5 runs referred to in 1. above are a penalty and the Batsmen do not change ends solely
by reason of this penalty.



Law 42 - Unfair Play
1. RESPONSIBILITY OF CAPTAINS

The Captains are responsible at all times for ensuring that play is conducted within the 
spirit of the game as well as within the Laws.

2. RESPONSIBILITY OF UMPIRES
The Umpires are the sole judges of fair and unfair play.

3. INTERVENTION BY THE UMPIRE
The Umpire shall intervene without appeal by calling and signalling "dead ball" in the 

case of unfair play, but should not otherwise interfere with the progress of the game except
as required to do so by the Laws.

4. LIFTING THE SEAM
A Player shall not lift the seam of the ball for any reason. Should this be done, the 

Umpires shall change the ball for one, of similar condition to that in use prior to the 
contravention. See Note (a).

5. CHANGING THE CONDITION OF THE BALL
Any member of the fielding side may polish the ball provided that such polishing wastes 

no time and that no artificial substance is used. No-one shall rub the ball on the ground or 
use any artificial substance or take any other action to alter the condition of the ball.

In the event of a contravention of this Law, the Umpires, after consultation, shall change 
the ball for one of similar condition to that in use prior to the contravention.

This Law does not prevent a member of the fielding side from drying a wet ball, or 
removing mud from the ball. See Note (b).

6. INCOMMODING THE STRIKER
An Umpire is justified in intervening under this Law and shall call and signal "dead ball" 

if, in his opinion, any Player of the fielding side incommodes the Striker by any noise or 
action while he is receiving a ball.

7. OBSTRUCTION OF A BATSMAN IN RUNNING
It shall be considered unfair if any Fieldsman wilfully obstructs a Batsman in running. In 

these circumstances the Umpire shall call and signal "dead ball" and allow any completed 
runs and the run in progress or alternatively any boundary scored.

8. THE BOWLING OF FAST SHORT PITCHED BALLS
The bowling of fast short pitched balls in unfair if, in the opinion of the Umpire at the 

Bowler's end, it constitutes an attempt to intimidate the Striker. See Note (d).
Umpires shall consider intimidation to be the deliberate bowling of fast short pitched 

balls which by their length, height and direction are intended or likely to inflict physical 
injury on the Striker. The relative skill of the Striker shall also be taken into consideration.

In the event of such unfair bowling, the Umpire at the Bowler's end shall adopt the 



following procedure :-
(a) In the first instance the Umpire shall call and signal "no ball", caution the Bowler and 
inform the other Umpire, the Captain of the fielding side and the Batsmen of what has 
occurred.
(b) If this caution is ineffective, he shall repeat the above procedure and indicate to the 
Bowler that this is a final warning.
(c) Both the above caution and final warning shall continue to apply even though the Bowler
may later change ends.
(d) Should the above warnings prove ineffective the Umpire at the Bowler's end shall :-

(i) At the first repetition call and signal "no ball" and when the ball is dead direct the 
Captain to take the Bowler off forthwith and to complete the over with another Bowler, 
provided that the Bowler does not bowl two overs or part thereof consecutively (See 
Law22.7. - Bowler Incapacitated or Suspended during an Over).
(ii) Not allow the Bowler, thus taken off, to bowl again in the same innings.
(iii) Report the occurrence to the Captain of the batting side as soon as the Players leave 
the field for an interval.
(iv) Report the occurrence to the Executive of the fielding side and to any governing body
responsible for the match who shall take any further action which is considered to be 
appropriate against the Bowler concerned.

9. THE BOWLING OF FAST HIGH FULL PITCHES
[Previous Law 42.9 and Note (e) deleted, and replaced with the following amendment, 

approved by the MCC at a Special General Meeting held on 5th May, 1993. This amendment
applies to all grades of cricket with immediate effect.]

The bowling of fast high full pitches is unfair.
A fast high full-pitched ball shall be defined as a ball that passes, or would have passed, 

on the full above waist height of a Batsman standing upright at the crease. Should a Bowler
bowl a fast high full-pitched ball, either Umpire shall call and signal "no-ball" and adopt the 
procedure of caution, final warning, action against the bowler and reporting as set out in 
Law 42.8 above.

10. TIME WASTING
Any form of time wasting is unfair.

(a) In the event of the Captain of the fielding side wasting time or allowing any member of 
his side to waste time, the Umpire at the Bowler's end shall adopt the following procedure :-

(i) In the first instance he shall caution the Captain of the fielding side and inform the 
other Umpire of what has occurred.
(ii) If this caution is ineffective he shall repeat the above procedure and indicate to the 
Captain that this is a final warning.
(iii) The Umpire shall report the occurrence to the Captain of the batting side as soon as 
the Players leave the field for an interval.
(iv) Should the above procedure prove ineffective the Umpire shall report the occurrence 
to the Executive of the fielding side and to any governing body responsible for that 
match who shall take appropriate action against the Captain and the Players concerned.

(b) In the event of a Bowler taking unnecessarily long to bowl an over the Umpire at the 
Bowler's end shall adopt the procedures, other than calling of "no ball", of caution, final 
warning, action against the Bowler and reporting as set out in 8. above.



(c) In the event of a Batsman wasting time (see Note (f) other than in the manner described
in Law 31. (Timed Out), the Umpire at the Bowler's end shall adopt the following 
procedure :-

(i) In the first instance he shall caution the Batsman and inform the other Umpire at 
once, and the Captain of the batting side, as soon as the Players leave the field for an 
interval, of what has occurred.
(ii) If this proves ineffective, he shall repeat the caution, indicate to the Batsman that this
is a final warning and inform the other Umpire.
(iii) The Umpire shall report the occurrence to both Captains as soon as the Players leave
the field for an interval.
(iv) Should the above procedure prove ineffective, the Umpire shall report the occurrence
to the Executive of the batting side and to any governing body responsible for that 
match who shall take appropriate action against the Player concerned.

11. PLAYERS DAMAGING THE PITCH
The Umpires shall intervene and prevent Players from causing damage to the pitch which

may assist the Bowlers of either side. See Note (c).
(a) In the event of any member of the fielding side damaging the pitch the Umpire shall 
follow the procedure of caution, final warning and reporting as set out in 10(a) above.
(b) In the event of a Bowler contravening this Law by running down the pitch after 
delivering the ball, the Umpire at the Bowler's end shall first caution the Bowler. If this 
caution if ineffective the Umpire shall adopt the procedures, other the calling of "no ball", of
final warning, action against the Bowler and reporting as set out in 8. above.
(c) In the event of a Batsman damaging the pitch the Umpire at the Bowler's end shall 
follow the procedures of caution, final warning and reporting as set out in 10(c) above.

12. BATSMAN UNFAIRLY STEALING A RUN
Any attempt by the Batsman to steal a run during the Bowler's run-up is unfair. Unless 

the Bowler attempts to run out either Batsman - See Law 24.4Law24. (Bowler Throwing at 
the Striker's Wicket Before Delivery) and Law 24.5Law24. (Bowler Attempting to Run Out 
Non-Striker Before Delivery) - the Umpire shall call and signal "dead ball" as soon as the 
Batsmen cross in any such attempt to run. The Batsmen shall then return to their original 
wickets.

13. PLAYER'S CONDUCT
In the event of a player failing to comply with the instructions of an Umpire, criticising his

decision by word or action, or showing dissent, or generally behaving in a manner which 
might bring the game into disrepute, the Umpire concerned shall, in the first place report 
the matter to the other Umpire and to the Player's Captain requesting the latter to take 
action. If this proves ineffective, the Umpire shall report the incident as soon as possible to 
the Executive of the Player's team and to any Governing Body responsible for the match, 
who shall take any further action which is considered appropriate against the Player or 
Players concerned.

Notes
(a) The Condition of the Ball
Umpires shall make frequent and irregular inspections of the condition of the ball.
(b) Drying of a Wet Ball



A wet ball may be dried on a towel or with sawdust.
(c) Danger Area
The danger area on the pitch, which must be protected from damage by a Bowler, shall be 
regarded by the Umpires as the area contained by an imaginary line 4ft./1,22m. from the 
popping crease, and parallel to it, and within two imaginary and parallel lines drawn down 
the pitch from the points on that line 1ft./30.48cm. on either side of the middle stump.
(d) Fast Short Pitched Balls
As a guide, a fast short pitched ball is one which pitches short and passes, or would have 
passed, above the shoulder height of the Striker standing in a normal batting stance at the 
crease.
(e) [Eliminated by amendment to Law 42.9.
(f) Time Wasting by Batsmen
Other than in exceptional circumstances, the Batsman should always be ready to take 
strike when the Bowler is ready to start his run-up.



Help With Help
The help feature you are now using can help you to find information with any feature of 

Willow Scorebook. You can either press the F1 key before performing a Scorebook 
function or you can choose help from the Willow Scorebook menu and then use either the 
Search or Index features of this help to find specific information.

The search feature produces a list of topics in alphabetical order on which you can obtain
help or you can use the index feature to hone in on information.

To select the Search feature either click on the search button above or press the 'S' key.
To access the elements from the Index click on highlighted option as you did to display 

this screen.
If you want to return to the previous help screen click the Back button or press the 'B' 

key.
Once you have finished with help select the Exit option from the File menu.

For further information about using the help feature refer to your Windows 
documentation



Help With Menus
This section of the Willow Scorebook Help feature details information about how to use 

the options available from the Willow Scorebook main menu. The main menu should be 
displayed at all times during your use of the Willow Scorebook although some features may 
be reserved from use during the scoring process.

The main menu above provides the main control features of Willow Scorebook but also 
displays information during the scoring of a match.

Section A is used for message display throughout your use of Willow Scorebook and 
should be monitored carefully to ensure your scoring actions are completed satisfactorily.

Section B displays the name of the current match. If the area shows {Untitled} then the 
match has not been saved. The name displayed in this section is the name you give to the 
file as you save the match.

Section C is the menu area and contains all the options and features you will require as 
you use Willow Scorebook. The following topics of this help guide explain each menu option 
in detail.

Section lines D & E are only displayed once a match has commenced. Line D contains the
name of the Home and Away teams, the venue or name of the ground, the date the match 
started and a short description of weather during the current innings. Line E contains the 
current innings number and team, the winner of the toss, the type of match being played 
and the state of the pitch, all taken from the information entered through the Match Setup 
option.

The following sub menu's are available from the Willow Scorebook main menu :-

File Menu - The File menu provides functions for saving and loading matches, printing, 
product defaults and exiting the product.

Ball Menu - The Ball menu allows the entry of all combinations of deliveries and 
subsequent actions during a match. This encompasses Dot balls, Wides, No-Balls, Byes and 
Leg byes, Wickets and Runs and any combination thereof during the play of one delivery.

View Menu - The View menu allows you, the scorer, to view the state of play at the end of
a previous innings.

Events Menu - The Events menu provides functions not catered for by the Ball menu. This
includes all actions which can occur whilst the ball is not in play. The Events menu contains 
options for Bowling changes, Batting changes, Innings and match commencement, 
postponement and cancellation.

Options Menu - The Options menu allows you, the scorer, to change the method in which 
you score. This covers the automatic or manual entry of information, the display and the 
undo ball feature.

Setup Menu - The Setup menu enables you to change match or innings details such as 



the type and make up of match, teams or innings.
Windows Menu - The Windows Menu lists the various information displays possible both 

during and after a match. This includes Scoreboard, Batting and Bowling details, Fall of 
Wickets, Overs, Match and Score sheet analysis

Help Menu - The Help menu gives several options for accessing information about Willow 
Scorebook. You are accessing part of this Help system now.



The File Menu
The File menu provides functions for saving and loading matches, beginning a new 

match, printing match details, saving product defaults and exiting from the product. The 
following options are available from this sub menu. :-

New - The New menu option is used to begin scoring a new cricket match.
Open - The Open menu option is used to continue scoring or view the result of a 

previously saved match.
Save - The Save menu option is used to store scoring details from the current match to 

your computers hard or floppy disk.
Save As - The Save As menu option is used to store scoring details from the current 

match to your computers hard or floppy disk under a new name.
Export Match - The Export Match menu option is used to store scoring details from the 

current match to a either the CSF (Cricket Scorebook Format) or the DIF (Data Interchange 
File).

Save Defaults - The Save Defaults menu option is used to store the default match 
settings you wish to be used for New matches.

Preferences - The Preferences menu option is used to change parameters used by Willow 
Scorebook for start up purposes.

Print - The Print menu option is used when a paper report of the current match is 
required.

Printer Setup - The Printer Setup menu option is used to alter the windows output device 
and associated settings.

Page Setup - The Page Setup menu option is used to format a page with headers, footers 
and margins before printing.

Run CSfW - The Run CSfW menu option can be used to start the compatible statistics 
product Cricket Statistics for Windows (aka Top Score for Windows).

Exit - The Exit menu option is used to close Willow Scorebook and return you to the 
control of Windows.



Creating A New Match
A new match may be created using the New option, available from the File menu. The 

New option should be used at the start of each new match. A blank, untitled Scorebook will 
be created and you may then go about setting up the match options and details available 
from the Match Setup option.

The screen shot above shows the result of the New match option. As the new match has 
not yet been saved the match title currently reads {Untitled}.



Opening A Saved Match
In the course of a match you will have saved the Scorebook during breaks from play such

as the end of a days play or during lunch or tea. If you have subsequently switched off your
computer or simply exited from Willow Scorebook you will need to reload the match in 
order to continue with scoring. The Open option, available from the File menu is used for 
this purpose. After selecting the Open option you will be presented with a typical Windows 
Open window as displayed below.

Section A displays the name of the file currently selected for loading. If no file is currently
selected the display will read *.WSB. If you know the name and location of the file you wish 
to open then type the name in this box.

Section B displays the available files for opening from the current directory. Normally 
only files with the extension .WSB will be shown.

Section C lists the type of files that may be searched for. This may either be .WSB files or
all files.

Section D indicates the directory structure you may search through in order to find the 
match you wish to open. In the example above the d:\eddson directory is currently 
selected.

Section E lists the drives which may be selected in order to find the match you wish to 
load. The example above indicates that the second hard disk drive, d: is currently selected.

Once you have selected the match file name you wish to open or have typed the name 
directly into the box described in section A , you should click on the OK button to open the 
file. The file will be read into Willow Scorebook and the display will change to reflect the 
point at which the match was saved. Scoring can now continue. If the Cancel option is 
clicked then no action will be taken and you will be returned to the Willow Scorebook menu 
without opening a match.



Saving A Match
In the course of a match you will be required to save the current state of your Scorebook 

so that you may return to it during another days play or after lunch or tea for example. To 
save a match two options are available. The Save option, available from the File menu 
should be used for matches you have previously saved. When a match is saved for the first 
time you must designate where you wish to save the match and what name you wish to 
give the file. For further information on saving a file for the first time refer to the next topic 
Saving A Match With A New Name.

The Save option stores all the Scorebook information for the current match in the 
associated file and returns you directly to the Scorebook for further entry. You are 
recommended to save the match at regular intervals throughout play.



Saving A Match With A New Name
In the course of a match you will be required to save the current state of your Scorebook 

so that you may return to it during another days play or after lunch or tea for example. The 
Save As option should be used to save matches which have not been saved before and for 
saving a match under a new name. After selecting the Save As option you will be presented
with a typical Windows Save window as displayed below.

Section A displays the name of the file currently selected for saving. You may either 
select a file from the list provided or type the name of your new file manually.

Section B displays the files previously saved in the current directory. Normally only files 
with the extension .WSB will be shown.

Section C lists the type of files that may be searched for. This may either be .WSB files or
all files.

Section D indicates the directory structure you may search through in order to find the 
area in which to save your match. In the example above the d:\eddson directory is currently
selected.

Section E lists the drives which may be selected. The example above indicates that the 
second hard disk drive, d: is currently selected.

Once you have typed in your new file name in section    A , or have selected a previously 
saved match to overwrite from section B , you should click on the OK button to save the 
match. The file, containing all the Scorebook information will be written to the disk. You will 
then be returned to the Willow Scorebook to continue scoring. If the Cancel option is clicked
then no action will be taken and you will be returned to the Willow Scorebook menu without
saving the match information.



Exporting A Match
Despite Willow Scorebook's versatility, it is not capable of acting as a cricket match 

database allowing for league record keeping or the generation of statistics. You will need 
another package to enable you to generate and keep such records. Contact EddSON to see 
whether a suitable product exists within our range or alternatively use the Export Match 
option to create a file in one of the three supported export formats described below.

1) The Export Match option creates a DIF (Data Interchange File) containing details of the
current match. The DIF format is suitable for creating data to be manipulated by most of 
the regular spreadsheet or database packages available.The DIF is a text file containing 
text and numerical fields seperated by commas. Text is enclosed in double qutation marks 
and numbers are simply delimeted by commas. An example line of a DIF is displayed below
:-

"A Field Of Text",2,10,123,"2nd Field Of Text","Even More Text"

The example contains three pieces of text (The 1st , 5th and 6th fields) and three 
numbers. Notice that all fields are seperated by commas and that all text is enclosed in 
double quotes, even the text which begins with a numeric character.

The DIF format is understood by a number of software packages and can be imported as 
a spreadsheet file or as part of a database. By using common commercial application 
software such as Microsoft Excel, Lotus 1-2-3 or Borland Dbase etc you can build your own 
method of analysing Willow Scorebook data. You should consult the documentation 
provided with your software for information on how to import a DIF.

Willow Scorebook creates a DIF containing general Match information and Batting, 
Bowling and Fall Of Wicket analysis for each innings played.

2) The second Export method creates a file compatible with the CSF (Cricket Scorebook 
Format) standard which is specifically designed to allow cricket match data to be 
manipulated by many different Cricket software packages. The excellent Cricket Statistics 
for Windows is one such example which supports the CSF standard. Click here for further 
information on Cricket Statistics for Windows

3) The third Export method creates a file compatible with the Cricket Statz statistics 
product which uses the MXP (Match Export Format). Click here for further information on 
Cricket Statz



Saving Default Settings
It is likely that you will find you use Willow Scorebook with a regular set of options, the 

options which define the type of match you are scoring and those which affect the way in 
which you score. The Save Defaults option is used to record these settings so that they 
may be called back for each new match. After selecting the Save Defaults option you will 
be asked to confirm your request to overwrite the previous default settings. If you click the 
Yes button then the following settings will be saved :-

1. Whether you will record the batsman's scoring positions before or after the ball. (See 
The Options Menu)

2. Whether you require timing to be performed automatically, manually or not at all. (See
The Options Menu)

3. Whether you require the selection of the next batsman to be performed automatically 
or manually. (See The Options Menu)

4. The match settings. (See Match Setup)
5. The innings setup of weather and pitch conditions. (See Innings Setup)
6. The default page settings. (See Page Setup)

The default settings are stored in a file called OPTDEF.CKT which is stored in the Willow 
Scorebook program directory.



Preferences
The Willow Scorebook relies on several parameters set by Preferences to describe how 

Willow Scorebook should configure itself when started. The Preference settings are stored in
a file called WSB.INI which can be located in your Windows directory. The Preferences 
option allows you to change these Initialisation settings through the Willow Scorebook 
interface. Any changes that you make to the Preferences will only take effect the next time 
Willow Scorebook is loaded as the WSB.INI file is only read once. The following initialisation 
settings may be altered using the Preferences option.

1. The Default Data Directory.
When Willow Scorebook is installed the default Data Directory will be C:\WSB\MATCH. 

If this is not the directory in which you want to store your Match files use the Preferences 
option to change the path. You can either type the required path or select it using the Drive
and Directory lists. When changed the Default Data Directory will be used for file open and 
file save operations when you next load Willow Scorebook.

2. The Memory Allocation Value.
In order to store the Scorebook details Willow Scorebook must allocate enough 

memory to handle the maximum number of overs to be played in each innings of a match. 
The Memory Allocation value specifies the maximum number of overs for an innings which 
can be scored. To preserve Windows memory you should set this value above the number 
of overs you expect in each innings. In a limited over game you will know the maximum 
number of overs per innings. For example in a 50 over match the Memory Allocation value 
should be set at about 60. If you are scoring a Test match you would increase this value to 
perhaps 300. The Memory Allocation value should always be greater than 20 and less than 
1000. The default value is 100. If you have no concerns over the use of Windows memory 
then set this value set to 300.

If you have set a value too low for the actual number of overs being played in a game 
then you will have to save the match, increase the Memory Allocation value, exit from 
Willow Scorebook and then restart Willow and reload the saved match.

3. Use Radial Charts.
Willow Scorebook uses a large number of Windows Resources. This can sometimes 

cause problems when running other applications whilst Willow Scorebook is active. In order 



to reduce the number of resources used by Willow Scorebook you can turn off the Radial 
Charts, Run Rate Graph & Manhattan Graph features thus disabling the Scoring Position 
Entry, Scoring Position View (Batsmen), Scoring Position View (Bowlers), Run Rate Graph 
and Manhattan Graph Windows. This will give a typical 20% resource saving. If you want to 
use Radial Charts, Run Rate Graphs or Manhattan Graphs set the Preferences value to 'Y'. If
you wish to preserve a greater number of free Windows resources set this value to 'N'.

4. Ball Rotation.
When Willow Scorebook loads a spinning Cricket Ball logo appears. This logo slows 

the speed at which Willow Scorebook loads. If you wish to speed the loading of Willow 
Scorebook change the Ball Rotation value to 'N'.



Printing
During or after the completion of a match it will be important for you to obtain a printed 

copy of the Scorebook and other details recorded during play. The Print option provides 
facilities for printing a number of different match and innings reports or even blank reports 
so that you can score manually should you wish?

The Print option displays the following window so that specific print selections can be 
made.

Section B indicates the list of reports available from the Print window. This matches 
the options available from the Windows Menu with the exception of the Fifties option which 
duplicates the Scoresheet List 50's option. Each report has a number of selection boxes 
adjacent to the report heading. Reports may either be printed once for each innings or once 
for the entire match. Only the Scoreboard, Run Rate Graph and Match Summary reports fall 
into the latter category. The All options at the base of the window may be used to tag all the 
reports above for printing.

Section A indicates the innings or blank selection availability of each report type. Up to 
four innings can be selected for printing. Only those innings currently played or being 
played may be selected. This is indicated by the innings number colour. If the colour is 
black then the options below may be selected. If the colour is white then the options below 
may not be selected. The Blank and All options will always be available. The All option can 
be used as a quick way to select all the available innings for a particular report type. The 
Blank option may be selection to generate an empty report.

Also note the Single Page option in the top left. If your printer is set to portrait then you 
can toggle this option and select the Willow Scorebook options to produce a print of both 
Batting and Bowling scorebook details on a single page.

To begin the print process click on the Print button once you have marked the reports 
you wish to print.



Once the Print button has been selected and printing has begun the Printing In Progress 
box will appear indicating the current page, the total number of pages to print and the 
percentage of the current page printed. The Cancel option may be used at any time to 
cancel all current printing. The cancellation may take a few seconds.

The Printer Setup and Page Setup options duplicate the options found on the File 
menu for convenience.

The Cancel option may be used to abort the printing selection screen.

The time taken to print reports varies depending upon the type of report selected 
(Scorebook reports take the longest time as they are the most complex), the orientation of 
the page required for the report, the type of printer selected for printing and the speed of 
your machine. As a guideline printing a one page report should begin printing within five 
minutes although many reports are generated within a few seconds.



Printer Setup
Windows provides a number of configuration options for printing not least of which is the 

selection of the type of printer you wish to use, the orientation of the page, the type of 
paper being used and the source for that paper. The Printer Setup option allows you to 
change these settings as seen below.

Section A provides a list of printers defined to windows which may be used for printing. If
the printer you intend to use is not available from this list then refer to your windows 
manual.

Section B indicates whether you wish reports to be generated vertically or horizontally on
the page. Selections are for portrait printing and landscape printing. Click on the button 
you wish to use. Most Willow Scorebook reports should be produced in landscape mode for 
the best results although an exception is the Scoreboard.

Section C indicates the size of paper to be used for printing. Selection here will usually 
result in a choice between A4 and Letter although other options are often available. Ensure 
that the selection here is matched by the size of your paper.

Section D indicates the source of the paper used for printing. Laser printers are often 
provided with multiple 'bins'. Often the default choice is the most suitable selection here. 
You should consult your printer documentation for further assistance should problems arise 
with source selection.

Many other options are available for different printers. Click on the options button to find 
out what other alterations can be made to your printer setup. Settings for quality of output,
graphic selection, memory usage and colour differentiation are often available from this 
option. You should consult your printer and windows manual for further information.



Page Setup
It may be important for your pages to be clearly marked by a header or footer or you 

may wish to set a distinct margin for your reports. The Page Setup option allows these 
options to be set and will be used as settings for each page of your reports.

Section A indicates the current Header text which will be displayed at the top of each 
printed report page. The header may contain plain text or can incorporate a number of 
defined values set by Willow Scorebook at the time of printing. These values are described 
below.

Section B indicates the current Footer text which will be displayed at the bottom of each 
printed report page. The footer may contain plain text or can incorporate a number of 
defined values set by Willow Scorebook at the time of printing. These values are described 
below.

(page) - The current page number of the report is substituted for the brackets and text.
(type) - A short description of the report is substituted for the brackets and text.
(inns) - The innings number of the report is substituted for the brackets and text.
(date)  - The current date in dd/mm/yy format is substituted for the brackets and text.
(time) - The current time in hh:mm format is substituted for the brackets and text.

Values may be typed in either upper or lower case but must be defined within 
parenthesis.

Both standard text and values can be mixed on both Header and Footer lines as seen in 
the example above.

Section C offers the ability to change the size of margins, top and bottom, left and right 
of the page. All margin values are defined in centimetres and no checks are made upon the
validity of margin selection. You should ensure that the size of margins are suitable for the 
type of report and the size and orientation of the paper selected within the Printer Setup 
option. Most reports will be generated satisfactorily with no margin settings at all.

[Note - We have found that some Epson dot matrix printers, LQ and LX range which use 
the Microsoft Universal Printer Driver do not scale correctly and hence printed information 
can be lost on the right and bottom margins. We suggest that you set the Margin values as 
follows to overcome these problems. Left = 0.5, Right=0.5, Top=0, Bottom=6]



Section D provides a toggle option for selecting how textual information is printed. The 
left hand option 'Fit Text Within Box Area' is the default selection and ensures that text is 
shrunk to fit within the confines of the print templates. The    'Reduce Text To Fit Box Area' 
selection ensures that text is printed at the same height but not necessarily in full. 
Experimentation with this option may be necessary to produce the print output you desire.

Once you are satisfied with the page settings options you can click the Done option to 
return to the main menu.



Run Cricket Statistics for Windows
The Run CSfW option (Sometimes displayed as Run TSfW - Top Score For Windows) will 

only be enabled if you have successfully installed the Cricket Statistics for Windows product
on your PC and Willow can locate the product. CSfW is compatible with the Willow Cricket 
Scorebook and provides club statistics facilities not present within the Willow Cricket 
Scorebook. If this product is installed on your system then you can use this option to 
automatically start the product. By selecting this option you switch control from Willow to 
CSfW. When you close CSfW control will be returned to Willow.



Exiting Willow Scorebook
When a match has been completed or a break in play has been reached you may wish to 

close down Willow Scorebook and turn off your machine. Select the Exit option to unload 
Willow Scorebook and return control to the Windows environment.

If you have not saved a Scorebook you will be asked to confirm your request to exit form 
Willow Scorebook.



The Ball Menu
The Ball menu provides functions for recording each delivery as it is bowled and the 

resulting entries which should be placed in the Scorebook. The Ball menu duplicates a 
number of functions also found on the Options Icon Palette but also provides more 
extensive features.

You are recommended to use the Options Icon Palette for most scoring activities but 
reference should be made to the Ball menu when uncommon scoring activities are required.
A complete description of scoring functions are listed in the following sections.

Dot - The Dot option is used to enter a dot ball into the Scorebook analysis.
Runs - The Runs option is used to enter one or more runs scored by the current batsman 

into the Scorebook analysis.
Wides - The Wides option is used to enter one or more wides bowled by the current 

bowler into the Scorebook analysis.
No Balls - The No Ball option is used to enter one or more no balls bowled by the current 

bowler into the Scorebook analysis.
Byes - The Byes option is used to enter one or more byes run by the batsman into the 

Scorebook analysis.
Leg Byes - The Leg Byes option is used to enter one or more leg byes run by the batsman

into the Scorebook analysis.
Wicket - The Wicket option is used to enter the fall of a batsman's wicket into the 

Scorebook analysis.



Entry Of A Dot Ball
The entry or recording of a dot ball, (a delivery in which no runs are scored either by the 

batting team or by the fault of the bowler), may be made in two ways. A dot ball may be 
scored by using the dot icon from the Options Icon Palette or by selecting the Dot ball 
option from the Ball menu. Both methods perform the same functions :-

1. The delivery is recorded.
2. The current batsman is recorded as facing a dot ball.
3. The over and bowler analysis are updated by one delivery.
4. No addition is made to the score.

If you are recording the stroke play of batsmen, it is not necessary to record a dot ball 
using the Set Scoring Positions entry window.



Entry Of Runs
The entry of runs, (a delivery in which the current batsmen makes contact with bat on 

ball and then makes good, runs between wickets) may be recorded in two ways. A run or 
runs may be scored by using one of the icons from the Options Icon Palette or by selecting 
the Runs option from the Ball menu. Both methods perform similar functions.

The Options Icon Palette provides icon options for the recording of either 1, 2, 3, 4, 5 or 6
runs without any complication such as the fall of a wicket during the run scoring process. 
The Options Icon Palette is the most convenient method for recording the scoring of runs 
under normal conditions but will not cater for every eventuality. The Runs option from the 
Ball menu offers a number of choices as displayed below.

Section A indicates the number of runs scored by the batsman from the delivery. This 
may be from 0 to 9 runs. If 0 is entered as the number of runs scored then any subsequent 
changes to the form will not be recognised and the entry of runs will be aborted. If you are 
registering a fall of wicket when no runs are scored then you should refer to the wicket 
option specific to the batsman's demise. Willow Scorebook will not provide facilities for 
more than 9 runs to be scored from one delivery.

Section B indicates whether a wicket falls during the course of a batsman making runs. If 
no wicket has fallen during the delivery then the default selection, 'No Wicket' will be 
appropriate. If a wicket does fall during the course of a batsman scoring runs then one of 
the following types of dismissal may be recorded :-

1. Run Out
2. Handed The Ball
3. Obstructing Field
4. Hit Ball Twice
If a wicket does fall while the batsman is scoring runs the name of the batsman out 

should be selected in section C. The current batsman is selected by default although the 
non striker may also be chosen from the list.

Once all selections have been made the Done option, identified in section D may be used
to confirm the delivery information. If you wish to cancel the delivery you may choose close
from the Runs window pull down options, top left.

The example shown above indicates that the current batsman scored two runs and then 
his partner J.Clark was run out attempting a third run. Run Outs are one example of a 
situation when batsman can change ends through unusual play. You should pay special 
attention to such situations as they may require the scorer to alter the ends at which the 
batsmen stand using the Batsman Change Ends option, after recording the wicket.



Entry Of Wides
The entry of wides, (a delivery which is deemed unplayable by the umpires) may be 

recorded in two ways. A single wide may be scored by using the wide icon from the Options
Icon Palette or by selecting the Wides option from the Ball menu. Both methods perform 
similar functions.

The Options Icon Palette provides an icon option for recording the delivery of one wide 
without any complication such as the fall of a wicket during the scoring process. The 
Options Icon Palette is the most convenient method for recording the scoring of one wide 
under normal conditions but will not cater for every eventuality. The Wides option from the 
Ball menu offers a number of choices as displayed below.

Section A indicates the number of runs scored from the wide delivery. This may be from 0
to 9 wides. If 0 is entered as the number of wides scored then any subsequent changes to 
the form will not be recognised and the entry of wides will be aborted. If you are registering
a fall of wicket when no runs are scored then you should refer to the wicket option specific 
to the batsman's demise. Willow Scorebook will not provide facilities for more than 9 runs 
to be scored from one delivery. Only one wide may be scored if a batsman is out Hit Wicket 
or Stumped.

Section B indicates whether the Batsmen ran on the wide or not. In most cases this 
selection will be made for you but if only one wide is scored then you will need to tell the 
scorebook whether the batsman ran or not. Depending upon your selection the batsmen 
may have changed ends.

Section C indicates whether a wicket falls during the course of wides. If no wicket has 
fallen during the delivery then the default selection, 'No Wicket' will be appropriate. If a 
wicket does fall during the course of wides then one of the following types of dismissal may
be recorded :-

1. Run Out
2. Handed The Ball
3. Obstructing Field
4. Hit Wicket
5. Stumped
If a wicket does fall after wides are scored the name of the batsman out should be 

selected in section D. The current batsman is selected by default although the non striker 
may also be chosen from the list if a wicket falls due to Run Out. Handled The Ball, or 
Obstructing Field.

Once all selections have been made the Done option, identified in section E may be used
to confirm the delivery information. If you wish to cancel the delivery you may choose close
from the Wides window pull down options, top left.



The example shown above indicates that the current batsman was stumped off a wide.
Run Outs are one example of a situation when batsman can change ends through 

unusual play. You should pay special attention to such situations as they may require the 
scorer to alter the ends at which the batsmen stand using the Batsman Change Ends 
option, after recording the wicket.



Entry Of No Balls
The entry of no balls, (a delivery which is deemed unfair by the umpire at the bowlers 

end) may be recorded in two ways. A single no ball may be scored by using the no ball icon 
from the Options Icon Palette or by selecting the No Ball option from the Ball menu. Both 
methods perform similar functions.

The Options Icon Palette provides an icon option for recording the delivery of one no ball 
without any complication such as the fall of a wicket during the scoring process or other 
runs accruing from the No Ball. The Options Icon Palette is the most convenient method for 
recording the scoring of one No Ball under normal conditions but will not cater for every 
eventuality. The No Ball option from the Ball menu offers a number of choices as displayed 
below.

First however here is a brief explanation of how Willow deals with the complexity of 
scoring No Balls. There are a growing number of Cricket formats in use throughout the 
World from the one day game through to full Tests. Due to the requirements of each format 
new rules concerning No Balls have been introduced. There are currently four known 
varieties of No Ball format. Before you even start scoring a match you should consider the 
No Ball format you will need to use. The four formats are configurable from the Match 
Setup panel and are thus :-

a) The current MCC No Ball rule and the rule still used for Test Matches states that 'A 
penalty of one run for a no ball shall be scored if no runs are made otherwise'. Thus if a 
bowler bowls a No Ball and the batsman hits the ball to the boundary then the batsman 
would be attributed with four additional runs, the score would advance by four and the 
bowlers analysis would increase by four and the bowler would be obliged to repeat the 
delivery. However if the bowler bowled a No Ball and no other runs were made then the 
Score would advance by one run and the bowlers analysis would do likewise with the 
penalty now directly attributable to the No-Ball. On the Match Setup panel you can 
configure this basic format by entering (1).

b) In some Formats the penalty for a No Ball is not one run but two runs. The rules for 
scoring still obey those in point a) above except that if the Batsman hit a single off the No 
Ball then the penalty would be split between batsman (one run) and the No Balls total (one 
run) although the bowlers analysis would increase by two. In this example the score would 
also advance by two. On the Match Setup panel you can configure this option using the 
value (2). This is the least used of the four types of No Ball. It does contain the most 
anomalies after all.

c) Increasingly used in one day matches the third format is a derivative of point a). The 
penalty associated with the No Ball is still one but any additional runs scored from the No-
Ball are always scored in addition to the No Ball penalty. To use point a) again as an 
example if a bowler bowls a No Ball and the batsman hits the ball to the boundary then the 
batsman would be attributed with four additional runs, the score would advance by five (No
Ball = 1, Batsman = 4), the bowlers analysis would increase by five and the bowler would 
be obliged to repeat the delivery. However if the bowler bowled a No Ball and no other runs 
were made then the Score would advance by one run and the bowlers analysis would do 
likewise. This format is commonly known as '+1 No Ball Scoring' although to configure this 
format on the Match Setup panel you should enter (-1).

d) The last of the four formats takes the penalty value from point b) ie two and the 
method from point c) additive and is commonly known as '+2 No Ball Scoring'. To configure 
this format on the Match Setup panel you should enter (-2).

Once you know and have configured the    appropriate No Ball scoring format you can 



then begin to score No Balls. Very basic No Balls can be scored using the Options Icon 
Palette but you may find it easier and more consistent to always use the Ball, No Ball menu 
option. By using this menu option a new panel is displayed with five fields. These five fields 
provide inputs covering all the combinations of No Ball possible and these are described 
below.

Section A indicates the number of runs scored from the no ball delivery in addition to the 
standard penalty of a No Ball (Note that the rules differ for 1 or 2 value penalty No Balls). 
This entry may be from 0 to 9. The value registered as No Balls by default is the number 
set for the value of a no ball using Match Setup. Willow Scorebook will not provide facilities 
for more than 9 runs to be scored from one delivery. You should not enter the No Ball 
penalty in this field only the runs scored from the bat or as byes, leg byes or wides.

Section B indicates whether the Batsmen ran on the no ball or not. In most cases this 
selection will be made for you but if only one wide is scored then you will need to tell the 
scorebook whether the batsman ran or not. Depending upon your selection the batsmen 
may have changed ends.

Section C indicates whether additional runs are attributed to the batsman or as no balls. 
If a no ball is called by the umpire and the batsman subsequently plays the ball with the 
bat and makes good ground between the wickets then the no ball is recorded as an extra 
ball in the over but the runs scored are contributed towards the batsman's total (either 
instead of or in addition to the No Ball penalty). If byes or leg byes are scored from a no ball
then those runs are scored as no balls. Remember to use the up and down arrows to 
display your selection and then click on your selection to highlight it.

Section D indicates whether a wicket falls during the course of a no ball delivery. If no 
wicket has fallen during the delivery then the default selection, 'No Wicket' will be 
appropriate. If a wicket does fall during the course of a no ball then one of the following 
types of dismissal may be recorded. Remember to highlight the entry :-

1. Run Out
2. Handed The Ball
3. Obstructing Field
4. Hit Ball Twice
If a wicket does fall on a No ball the name of the batsman out should be selected in 

section E. The current batsman is selected by default although the non striker may also be 
chosen from the list. Remember to highlight your selection.

Once all selections have been made the Done option, identified in section F may be used
to confirm the delivery information. If you wish to cancel the delivery you may choose close
from the No Balls window pull down options, top left.

The example shown above indicates that one no ball was scored and contributed as a no 



ball and no wicket fell. This example would also result had the No Ball icon been selected 
from the Options Icon Palette.

Run Outs are one example of a situation when batsman can change ends through 
unusual play. You should pay special attention to such situations as they may require the 
scorer to alter the ends at which the batsmen stand using the Batsman Change Ends 
option, after recording the wicket.

Summary
Matches may be played where the value of a no ball is recorded as either 1 or 2 for the 

batting side. In exceptional circumstances you may be required to score a match using both
ie 1 for regular no balls and 2 for an illegal bouncer. You may also enter a minus value of 
either -1 or -2. There are therefore four different values that can be entered for the No Ball 
Value and these are scored in different ways.

1 or +1 A penalty of one run is scored for the no ball. If runs are scored through Byes, 
Leg Byes or Batting runs from the no ball then the No Ball penalty IS NOT also added to the 
score. This is the traditional and default option.

2 or +2 A penalty of two runs is scored for the no ball. If runs are scored through Byes,
Leg Byes or Batting runs from the no ball then the No Ball penalty IS NOT also added to the 
score.

-1 A penalty of one runs is scored for the no ball. If runs are scored through Byes, Leg 
Byes or Batting runs from the no ball then the No Ball penalty IS also added to the score.

-2 A penalty of two runs is scored for the no ball. If runs are scored through Byes, Leg 
Byes or Batting runs from the no ball then the No Ball penalty IS also added to the score.



Entry Of Byes
The entry of byes, (a delivery which makes no contact with the bat but is run by the 

batsman) may be recorded in two ways. A single bye may be scored by using the bye icon 
from the Options Icon Palette or by selecting the Byes option from the Ball menu. Both 
methods perform similar functions.

The Options Icon Palette provides an icon option for the recording the delivery of one bye
without any complication such as the fall of a wicket during the scoring process. The 
Options Icon Palette is the most convenient method for recording the scoring of one bye 
under normal conditions but will not cater for every eventuality. The Byes option from the 
Ball menu offers a number of choices as displayed below.

Section A indicates the number of runs scored from byes. This may be from 0 to 9 byes. 
If 0 is entered as the number of byes scored then any subsequent changes to the form will 
not be recognised and the entry of byes will be aborted. If you are registering a fall of 
wicket when no runs are scored then you should refer to the wicket option specific to the 
batsman's demise. Willow Scorebook will not provide facilities for more than 9 runs to be 
scored from one delivery.

Section B indicates whether a wicket falls during the course of byes. If no wicket has 
fallen during the delivery then the default selection, 'No Wicket' will be appropriate. If a 
wicket does fall during the course of byes then one of the following types of dismissal may 
be recorded :-

1. Run Out
2. Handed The Ball
3. Obstructing Field
If a wicket does fall after byes are scored the name of the batsman out should be 

selected in section C. The current batsman is selected by default although the non striker 
may also be chosen from the list.

Once all selections have been made the Done option, identified in section D may be used
to confirm the delivery information. If you wish to cancel the delivery you may choose close
from the Byes window pull down options, top left.

The example shown above indicates that the non striker was out obstructing the field 
after the scoring of 2 byes.

Run Outs are one example of a situation when batsman can change ends through 
unusual play. You should pay special attention to such situations as they may require the 
scorer to alter the ends at which the batsmen stand using the Batsman Change Ends 
option, after recording the wicket.



Entry Of Leg Byes
The entry of leg byes, (a delivery which makes contact with the batsman and is run by 

the batsman) may be recorded in two ways. A single leg bye may be scored by using the 
leg bye icon from the Options Icon Palette or by selecting the Leg Byes option from the Ball 
menu. Both methods perform similar functions.

The Options Icon Palette provides an icon option for the recording the delivery of one leg 
bye without any complication such as the fall of a wicket during the scoring process. The 
Options Icon Palette is the most convenient method for recording the scoring of one leg bye
under normal conditions but will not cater for every eventuality. The Leg Byes option from 
the Ball menu offers a number of choices as displayed below.

Section A indicates the number of runs scored from leg byes. This may be from 0 to 9 
byes. If 0 is entered as the number of leg byes scored then any subsequent changes to the 
form will not be recognised and the entry of leg byes will be aborted. If you are registering 
a fall of wicket when no runs are scored then you should refer to the wicket option specific 
to the batsman's demise. Willow Scorebook will not provide facilities for more than 9 runs 
to be scored from one delivery.

Section B indicates whether a wicket falls during the course of leg byes. If no wicket has 
fallen during the delivery then the default selection, 'No Wicket' will be appropriate. If a 
wicket does fall during the course of leg byes then one of the following types of dismissal 
may be recorded :-

1. Run Out
2. Handed The Ball
3. Obstructing Field
If a wicket does fall after leg byes are scored the name of the batsman out should be 

selected in section C. The current batsman is selected by default although the non striker 
may also be chosen from the list.

Once all selections have been made the Done option, identified in section D may be used
to confirm the delivery information. If you wish to cancel the delivery you may choose close
from the Leg Byes window pull down options, top left.

The example shown above indicates that 3 leg byes were scored and no wicket fell.
Run Outs are one example of a situation when batsman can change ends through 

unusual play. You should pay special attention to such situations as they may require the 
scorer to alter the ends at which the batsmen stand using the Batsman Change Ends 
option, after recording the wicket.



Entry Of Wickets
The Wicket menu provides selections for recording the various methods of dismissal for a

batsman. The Wicket menu duplicates the Wicket icon found on the Options Icon Palette :-

Bowled - The Bowled option is used to record the dismissal of a batsman by being bowled
out.

Caught - The Caught option is used to record the dismissal of a batsman by being 
caught.

LBW - The LBW option is used to record the dismissal of a batsman leg before wicket.
Run Out - The Run Out option is used to record the dismissal of a batsman by being run 

out.
Stumped - The Stumped option is used to record the dismissal of a batsman by being 

stumped.
Hit Wicket - The Hit Wicket option is used to record the dismissal of a batsman by hitting 

their own wicket.
Timed Out - The Timed Out option is used to record the dismissal of a batsman by being 

timed out.
Handled The Ball - The Handled Ball option is used to record the dismissal of a batsman 

who handles the ball.
Hit Ball Twice - The Hit Ball Twice option is used to record the dismissal of a batsman who

has hit the ball twice.
Obstructing Field - The Obstructing Field option is used to record the dismissal of a 

batsman who has obstructed the fielding side.



Entry Of The Dismissal Of A Batsman 'Bowled'
The fall of a wicket may be recorded in two ways. The wicket may be scored by selecting 

the wicket icon from the Options Icon Palette followed by the type of dismissal or by 
selecting the type of dismissal from the Ball Wicket menu. Both methods perform the same 
function.

The Bowled option from the Ball Wicket menu registers the dismissal of the current 
striker and credits the current bowler with the wicket. Batting, bowling and fall of wicket 
analysis are updated to reflect the loss to the batting side.

If Automatic Timing is enabled then the time at which the wicket fell will be recorded by 
Willow Scorebook. If Manual Timing is enabled then you will be requested to enter the date 
and time. No time out will be recorded if No Timing is set.

If Automatic Batsman Selection is enabled then the new batsman will be recorded by 
Willow Scorebook. If Manual Batsman Selection is set then you will be requested to select 
the next batsman.

If Automatic Timing is enabled then the time at which the new batsman takes to the field
will be recorded by Willow Scorebook. If Manual Timing is enabled then you will be 
requested to enter the date and time. No time in will be recorded if No Timing is set.



Entry Of The Dismissal Of A Batsman 'Caught'
The fall of a wicket may be recorded in two ways. The wicket may be scored by selecting 

the wicket icon from the Options Icon Palette followed by the type of dismissal or by 
selecting the type of dismissal from the Ball Wicket menu. Both methods perform the same 
function.

The Caught option from the Ball Wicket menu registers the dismissal of the current 
striker and credits the current bowler with the wicket. The name of the fielder and whether 
the batsmen have crossed is also recorded using the panel displayed below.

If the name of the fielder is not known then select Unknown from the fielder list. If the
ball is caught by a substitute fielder select Substitute Fielder, otherwise choose the fielder 
from the list of players.

Should the batsmen cross during the Caught dismissal you can record the changing of 
ends by entering Y in the Have The Batsmen Crossed option. The default of N indicates the 
batsmen have not crossed. Should the recording of the Batmen crossing not be recorded at 
this point you can also use the Batsman Change Ends option after the dismissal.

Once the fielder has been selected the Done option may be used to confirm the wicket. If
you wish to cancel the wicket you may choose close from the Caught Event window pull 
down options, top left.

Batting, bowling and fall of wicket analysis are updated to reflect the loss to the batting 
side.

If Automatic Timing is enabled then the time at which the wicket fell will be recorded by 
Willow Scorebook. If Manual Timing is enabled then you will be requested to enter the date 
and time. No time out will be recorded if No Timing is set.

If Automatic Batsman Selection is enabled then the new batsman will be recorded by 
Willow Scorebook. If Manual Batsman Selection is set then you will be requested to select 
the next batsman.

If Automatic Timing is enabled then the time at which the new batsman takes to the field
will be recorded by Willow Scorebook. If Manual Timing is enabled then you will be 
requested to enter the date and time. No time in will be recorded if No Timing is set.



Entry Of The Dismissal Of A Batsman 'LBW'
The fall of a wicket may be recorded in two ways. The wicket may be scored by selecting 

the wicket icon from the Options Icon Palette followed by the type of dismissal or by 
selecting the type of dismissal from the Ball Wicket menu. Both methods perform the same 
function.

The L.B.W option from the Ball Wicket menu registers the dismissal of the current striker 
and credits the current bowler with the wicket. Batting, bowling and fall of wicket analysis 
are updated to reflect the loss to the batting side.

If Automatic Timing is enabled then the time at which the wicket fell will be recorded by 
Willow Scorebook. If Manual Timing is enabled then you will be requested to enter the date 
and time. No time out will be recorded if No Timing is set.

If Automatic Batsman Selection is enabled then the new batsman will be recorded by 
Willow Scorebook. If Manual Batsman Selection is set then you will be requested to select 
the next batsman.

If Automatic Timing is enabled then the time at which the new batsman takes to the field
will be recorded by Willow Scorebook. If Manual Timing is enabled then you will be 
requested to enter the date and time. No time in will be recorded if No Timing is set.



Entry Of The Dismissal Of A Batsman 'Run Out'
The fall of a wicket may be recorded in two ways. The wicket may be scored by selecting 

the wicket icon from the Options Icon Palette followed by the type of dismissal or by 
selecting the type of dismissal from the Ball Wicket menu. Both methods perform the same 
function.

The Run Out option from the Ball Wicket menu registers the dismissal of the current 
striker but does not credit the current bowler with the wicket. The option offers a number of
choices as displayed below.

Section A indicates the number of runs scored during the course of the run out. This may 
be from 0 to 9 byes. Willow Scorebook will not provide facilities for more than 9 runs to be 
scored from one delivery.

Section B indicates whether the striker or non striker is the batsman run out.
Section C indicates whether the non striker was run out backing up. In this eventuality no

ball will have been bowled. Section C is only available if the number of Runs defined in A is 
'0' and the non striker is selected. Enter a 'Y' in this section to indicate a run out of the non 
striker backing up.

Once all selections have been made the Done option, identified in section D may be used
to confirm the wicket. If you wish to cancel the wicket you may choose close from the Run 
Out Event window pull down options, top left.

Batting, bowling and fall of wicket analysis are updated to reflect the loss to the batting 
side.

If Automatic Timing is enabled then the time at which the wicket fell will be recorded by 
Willow Scorebook. If Manual Timing is enabled then you will be requested to enter the date 
and time. No time out will be recorded if No Timing is set.

If Automatic Batsman Selection is enabled then the new batsman will be recorded by 
Willow Scorebook. If Manual Batsman Selection is set then you will be requested to select 
the next batsman.

If Automatic Timing is enabled then the time at which the new batsman takes to the field
will be recorded by Willow Scorebook. If Manual Timing is enabled then you will be 
requested to enter the date and time. No time in will be recorded if No Timing is set.



Entry Of The Dismissal Of A Batsman 'Stumped'
The fall of a wicket may be recorded in two ways. The wicket may be scored by selecting 

the wicket icon from the Options Icon Palette followed by the type of dismissal or by 
selecting the type of dismissal from the Ball Wicket menu. Both methods perform the same 
function.

The Stumped option from the Ball Wicket menu registers the dismissal of the current 
striker and credits the current bowler with the wicket. The name of the wicket keeper 
involved in the stumping is also recorded using the panel displayed below.

The wicket keeper currently identifed using the Match Setup option is identified at the
top of the list of potential keepers. If the regular wicket keeper has been incapacitated the 
selection of the replacement keeper may be made from the list.

Once the wicket keeper has been selected the Done option may be used to confirm the 
wicket. If you wish to cancel the wicket you may choose close from the Stumping Event 
window pull down options, top left.

Batting, bowling and fall of wicket analysis are updated to reflect the loss to the batting 
side.

If Automatic Timing is enabled then the time at which the wicket fell will be recorded by 
Willow Scorebook. If Manual Timing is enabled then you will be requested to enter the date 
and time. No time out will be recorded if No Timing is set.

If Automatic Batsman Selection is enabled then the new batsman will be recorded by 
Willow Scorebook. If Manual Batsman Selection is set then you will be requested to select 
the next batsman.

If Automatic Timing is enabled then the time at which the new batsman takes to the field
will be recorded by Willow Scorebook. If Manual Timing is enabled then you will be 
requested to enter the date and time. No time in will be recorded if No Timing is set.



Entry Of The Dismissal Of A Batsman 'Hit Wicket'
The fall of a wicket may be recorded in two ways. The wicket may be scored by selecting 

the wicket icon from the Options Icon Palette followed by the type of dismissal or by 
selecting the type of dismissal from the Ball Wicket menu. Both methods perform the same 
function.

The Hit Wicket option from the Ball Wicket menu registers the dismissal of the current 
striker and credits the current bowler with the wicket. Batting, bowling and fall of wicket 
analysis are updated to reflect the loss to the batting side.

If Automatic Timing is enabled then the time at which the wicket fell will be recorded by 
Willow Scorebook. If Manual Timing is enabled then you will be requested to enter the date 
and time. No time out will be recorded if No Timing is set.

If Automatic Batsman Selection is enabled then the new batsman will be recorded by 
Willow Scorebook. If Manual Batsman Selection is set then you will be requested to select 
the next batsman.

If Automatic Timing is enabled then the time at which the new batsman takes to the field
will be recorded by Willow Scorebook. If Manual Timing is enabled then you will be 
requested to enter the date and time. No time in will be recorded if No Timing is set.



Entry Of The Dismissal Of A Batsman 'Timed Out'
The fall of a wicket may be recorded in two ways. The wicket may be scored by selecting 

the wicket icon from the Options Icon Palette followed by the type of dismissal or by 
selecting the type of dismissal from the Ball Wicket menu. Both methods perform the same 
function.

The Timed Out option from the Ball Wicket menu registers the dismissal of the batsman 
yet to take to the field of play but does not credit the current bowler with the wicket. 
Batting, bowling and fall of wicket analysis are updated to reflect the loss to the batting 
side. The Timed Out option is only available following the fall of a wicket caused by an on 
field dismissal. The option will not be available after a break in play even if the fall of a 
wicket preceded or preempted the break in play.

If Automatic Timing is enabled then the time at which the wicket fell will be recorded by 
Willow Scorebook. If Manual Timing is enabled then you will be requested to enter the date 
and time. No time out will be recorded if No Timing is set.

If Automatic Batsman Selection is enabled then the new batsman will be recorded by 
Willow Scorebook. If Manual Batsman Selection is set then you will be requested to select 
the next batsman.

If Automatic Timing is enabled then the time at which the new batsman takes to the field
will be recorded by Willow Scorebook. If Manual Timing is enabled then you will be 
requested to enter the date and time. No time in will be recorded if No Timing is set.



Entry Of The Dismissal Of A Batsman 'Handled Ball'
The fall of a wicket may be recorded in two ways. The wicket may be scored by selecting 

the wicket icon from the Options Icon Palette followed by the type of dismissal or by 
selecting the type of dismissal from the Ball Wicket menu. Both methods perform the same 
function.

The Handled Ball option from the Ball Wicket menu registers the dismissal of the current 
striker but does not credit the current bowler with the wicket. The option offers a number of
choices as displayed below.

Section A indicates the number of runs completed before the batman handled the ball. 
This may be from 0 to 9 byes. Willow Scorebook will not provide facilities for more than 9 
runs to be scored from one delivery.

Section B indicates whether the striker or non striker handled the ball.
Once all selections have been made the Done option, identified in section C may be used

to confirm the wicket. If you wish to cancel the wicket you may choose close from the 
Handled Ball Event window pull down options, top left.

Batting, bowling and fall of wicket analysis are updated to reflect the loss to the batting 
side.

If Automatic Timing is enabled then the time at which the wicket fell will be recorded by 
Willow Scorebook. If Manual Timing is enabled then you will be requested to enter the date 
and time. No time out will be recorded if No Timing is set.

If Automatic Batsman Selection is enabled then the new batsman will be recorded by 
Willow Scorebook. If Manual Batsman Selection is set then you will be requested to select 
the next batsman.

If Automatic Timing is enabled then the time at which the new batsman takes to the field
will be recorded by Willow Scorebook. If Manual Timing is enabled then you will be 
requested to enter the date and time. No time in will be recorded if No Timing is set.



Entry Of The Dismissal Of A Batsman 'Hit Ball Twice'
The fall of a wicket may be recorded in two ways. The wicket may be scored by selecting 

the wicket icon from the Options Icon Palette followed by the type of dismissal or by 
selecting the type of dismissal from the Ball Wicket menu. Both methods perform the same 
function.

The Hit Ball Twice option from the Ball Wicket menu registers the dismissal of the current 
striker but does not credit the current bowler with the wicket. The option offers a number of
choices as displayed below.

Section A indicates the number of runs completed before the striker hit the ball illegally 
for the second time. This may be from 0 to 9 byes. Willow Scorebook will not provide 
facilities for more than 9 runs to be scored from one delivery.

Once all selections have been made the Done option, identified in section B may be used
to confirm the wicket. If you wish to cancel the wicket you may choose close from the Hit 
Ball Twice Event window pull down options, top left.

Batting, bowling and fall of wicket analysis are updated to reflect the loss to the batting 
side.

If Automatic Timing is enabled then the time at which the wicket fell will be recorded by 
Willow Scorebook. If Manual Timing is enabled then you will be requested to enter the date 
and time. No time out will be recorded if No Timing is set.

If Automatic Batsman Selection is enabled then the new batsman will be recorded by 
Willow Scorebook. If Manual Batsman Selection is set then you will be requested to select 
the next batsman.

If Automatic Timing is enabled then the time at which the new batsman takes to the field
will be recorded by Willow Scorebook. If Manual Timing is enabled then you will be 
requested to enter the date and time. No time in will be recorded if No Timing is set.



Entry Of The Dismissal Of A Batsman 'Obstructing Field'
The fall of a wicket may be recorded in two ways. The wicket may be scored by selecting 

the wicket icon from the Options Icon Palette followed by the type of dismissal or by 
selecting the type of dismissal from the Ball Wicket menu. Both methods perform the same 
function.

The Obstructing Field option from the Ball Wicket menu registers the dismissal of the 
current striker but does not credit the current bowler with the wicket. The option offers a 
number of choices as displayed below.

Section A indicates the number of runs completed before the batman obstructed the 
field. This may be from 0 to 9 byes. Willow Scorebook will not provide facilities for more 
than 9 runs to be scored from one delivery.

Section B indicates whether the striker or non striker obstructed the field.
Once all selections have been made the Done option, identified in section C may be used

to confirm the wicket. If you wish to cancel the wicket you may choose close from the 
Obstructing Field Event window pull down options, top left.

Batting, bowling and fall of wicket analysis are updated to reflect the loss to the batting 
side.

If Automatic Timing is enabled then the time at which the wicket fell will be recorded by 
Willow Scorebook. If Manual Timing is enabled then you will be requested to enter the date 
and time. No time out will be recorded if No Timing is set.

If Automatic Batsman Selection is enabled then the new batsman will be recorded by 
Willow Scorebook. If Manual Batsman Selection is set then you will be requested to select 
the next batsman.

If Automatic Timing is enabled then the time at which the new batsman takes to the field
will be recorded by Willow Scorebook. If Manual Timing is enabled then you will be 
requested to enter the date and time. No time in will be recorded if No Timing is set.



The View Menu
The View menu enables you to view the Scorebook of a completed innings. Up to four 

innings can be displayed as well as the current innings. You may not update the Scorebook 
whilst viewing a completed innings :-

View Current Innings - The View Current Innings option is used to return to the innings in 
which play is commencing having viewed the Scorebook of a previous innings.

View 1st Innings - The View 1st Innings option is used to view the completed Scorebook 
for the 1st innings of the match.

View 2nd Innings - The View 2nd Innings option is used to view the completed Scorebook 
for the 2nd innings of the match.

View 3rd Innings - The View 3rd Innings option is used to view the completed Scorebook 
for the 3rd innings of the match.

View 4th Innings - The View 4th Innings option is used to view the completed Scorebook 
for the 4th innings of the match.



View Current Innings
The View Current Innings menu option is used to return to Scorebook entry after viewing 

a completed innings. During the viewing of completed innings, Scorebook entry is not 
available. To return to the current innings and enable scoring again the View Current Innings
option should be used.



View 1st Innings
During the scoring process it is often necessary to refer back to a completed innings. The

View Innings options provides this facility. At any time during the scoring of the second, 
third or fourth innings or after the match is concluded, you may select the View 1st Innings 
option to bring back the completed first innings details. Once the view is active, scoring 
entry is made unavailable. The Windows options can be used to obtain displays of the first 
innings details. Once viewing is complete use the View Current Innings option to re-enable 
scoring of the current innings.



View 2nd Innings
During the scoring process it is often necessary to refer back to a completed innings. The

View Innings options provides this facility. At any time during the scoring of the third or 
fourth innings or after the match is concluded, you may select the View 2nd Innings option 
to bring back the completed second innings details. Once the view is active, scoring entry 
is made unavailable. The Windows options can be used to obtain displays of the second 
innings details. Once viewing is complete use the View Current Innings option to re-enable 
scoring of the current innings.



View 3rd Innings
During the scoring process it is often necessary to refer back to a completed innings. The

View Innings options provides this facility. At any time during the scoring of the fourth 
innings or after the match is concluded, you may select the View 3rd Innings option to bring
back the completed third innings details. Once the view is active, scoring entry is made 
unavailable. The Windows options can be used to obtain displays of the third innings 
details. Once viewing is complete use the View Current Innings option to re-enable scoring 
of the current innings.



View 4th Innings
During the scoring process it is often necessary to refer back to a completed innings. The

View Innings options provides this facility. At any time during after the match is concluded, 
you may select the View 4th Innings option to bring back the completed fourth innings 
details. Once the view is active, scoring entry is made unavailable. The Windows options 
can be used to obtain displays of the fourth innings details. Once viewing is complete use 
the View Current Innings option to re-enable scoring of the current innings.



The Events Menu
The Events menu provides for the entry of all Scorebook material not covered by the Ball

menu and covers all actions which cannot be counted as a delivery. This includes Batting 
events such as retirements, Bowling events such as a change of bowler or the voluntary or 
forced retirement of a bowler, Innings events to start, conclude or postpone the conclusion 
of an innings and Match events to begin or conclude a match. This menu is divided into four
categories :-

Batting Events - The Batting Events sub menu provides facilities to change the ends at 
which the two batsman stand, to retire a batsman not out, to retire a batsman out or to 
allocate a runner for an injured batsman.

Bowling Events - The Bowling Events sub menu provides facilities to change the bowler, 
to force the end of an over, to remove a bowler who has transgressed the laws of cricket at 
the request of the umpire, to retire an injured or incapacitated bowler, to record an umpires 
warning to a bowler, to record the use of substitute fielders and to record bowling styles.

Innings Events - The Innings Events sub menu provides facilities to commence or 
recommence an innings, to postpone play due to bad light, rain or other unforeseen act, to 
break for lunch, tea or drinks, to allow the batting side to declare or forfeit an innings and to
allow the batting side to enforce the follow on.

Match Events - The Match Events sub menu provides facilities to commence a match, to 
abandon a match and to conclude a match due to concession, conclusion or refusal by one 
or other side.

Note Events - The Notes Events allows the scorer to record special events as the match 
progresses.



Batting Events
The Batting Events menu provides for the entry into the Scorebook when the batsman 

change ends against the normal or predictable course of play, when a batsman is forced to 
retire injured or incapacitated or when a batsman is forced to retire but is considered out :-

Batsman Change Ends - This option allows the scorer to update the state of play so that 
the two batsman change ends.

Batsman Retires Out - When a Batsman retires without the permission of the umpire or 
leaves the field for no good reason the batsman should be given Retired Out and this actin 
should be recorded in the Scorebook using this option.

Batsman Retires Not Out - When a Batsman retires not out due to injury, illness or 
incapacitation with the agreement of the umpires record the action in the Scorebook using 
this option.

Runners - When a Batsman becomes injured or incapacitated and uses a runner you may
record the action in the Scorebook using this option.



The Batsman Change Ends Event
After a catch, run out, the obstruction of a fielder, the illegal handling of the ball or other 

exceptional circumstances the scorer may be required to change the ends at which the 
batsman stand. This is most common with the dismissal of a batsman Caught when both 
batsman have crossed while attempting a run but the ball has been caught before the run 
is completed. Although no runs are scored the incoming batsman will now be on strike and 
the scoring analysis will need to be changed to reflect this. The Batsman Change Ends 
event is used for this purpose. The entry is made only to the score sheet and does not 
affect either batting or bowling statistics.



The Batsman Retires Out Event
If, during the course of play, a batsman leaves the field without    good reason or without 

the umpires and opposing captains permission he may be given out. The recording of such 
a circumstance should be made using the Batsman Retires Out event.

Section A indicates whether the striker or non striker is the batsman retiring out.
Once the selection has been made the Done option, identified in section B may be used 

to confirm the retirement. If you wish to cancel the retirement you may choose close from 
the Batsman Retires Out window pull down options, top left.

If Automatic Timing is enabled then the time of the retirement will be recorded by Willow 
Scorebook. If Manual Timing is enabled then you will be requested to enter the date and 
time. No time will be recorded if No Timing is set.

If Automatic Batsman Selection is enabled then the new batsman will be recorded by 
Willow Scorebook. If Manual Batsman Selection is set then you will be requested to select 
the next batsman.

If Automatic Timing is enabled then the time at which the new batsman takes to the field
will be recorded by Willow Scorebook. If Manual Timing is enabled then you will be 
requested to enter the date and time. No time in will be recorded if No Timing is set.



The Batsman Retires Not Out Event
If, during the course of play, a batsman is forced to leave the field due to illness or injury 

with the consent of the umpires they may be given not out and allowed to resume batting 
at the fall of a wicket. The recording of such a circumstance should be made using the 
Batsman Retires Not Out event.

Section A indicates whether the striker or non striker is the batsman retiring not out.
Once the selection has been made the Done option, identified in section B may be used 

to confirm the retirement. If you wish to cancel the retirement you may choose close from 
the Batsman Retires Out window pull down options, top left.

If Automatic Timing is enabled then the time of the retirement will be recorded by Willow 
Scorebook. If Manual Timing is enabled then you will be requested to enter the date and 
time. No time will be recorded if No Timing is set.

If Automatic Batsman Selection is enabled then the new batsman will be recorded by 
Willow Scorebook. If Manual Batsman Selection is set then you will be requested to select 
the next batsman.

If Automatic Timing is enabled then the time at which the new batsman takes to the field
will be recorded by Willow Scorebook. If Manual Timing is enabled then you will be 
requested to enter the date and time. No time in will be recorded if No Timing is set.



Runners
When a batsman becomes injured or otherwise incapacitated they may require and call 

upon the services of a team mate to act as a runner. To record this event on the Score 
Sheet the Batsman Uses Runner event may be used to record the selection of the batsman 
requiring the runner and then the player acting as the runner.



Bowling Events
The Bowling Events menu provides for the entry into the Scorebook when the bowler is 

changed at the end of an over or during an over if a bowler retires or is removed, when a 
bowler retires or is removed and when the scorer needs to end an over :-

Bowling Change - This option allows the scorer to update the Scorebook to reflect a 
change of bowler.

Bowler Retires - This option allows the scorer to record when a bowler is forced to retire 
due to injury, illness or incapacitation of some kind.

Bowler Removed - This option allows the scorer to record when a bowler has been 
removed by the umpire having transgressed the laws of cricket.

New Ball - This option allows the scorer to record the taking of the new ball.
Replacement Ball - This option allows the scorer to record the taking of the replacement 

ball.
Warn Bowler For Running On The Pitch - This option allows the scorer to record when a 

bowler is warned for running on the pitch.
Warn Bowler For Short Pitch Deliveries - This option allows the scorer to record when a 

bowler is warned for bowling short pitched deliveries.
Warn Bowler For Bowling Beamers - This option allows the scorer to record when a bowler

is warned for bowling beamers.
Bowler Comes Around The Wicket - This option allows the scorer to record when a bowler 

comes around the wicket.
Bowler Comes Over The Wicket - This option allows the scorer to record when a bowler 

comes over the wicket.
Style Of Bowling - This option allows the scorer to record a bowlers style of bowling.
Change Of Fielder - This option allows the scorer to record when a fielder is changed or 

substituted.
Forcing The End Of Over - This option allows the scorer to force the end of an over when 

either, the over has ended with too few balls delivered, the over has ended with too many 
balls delivered or when the Automatic End Of Over feature is turned off.



The Bowling Change Event
When a bowler finishes their spell and a new bowler is brought on to bowl the Bowling 

Change event is used to reflect the change. The bowling analysis is updated to indicate the 
end of a bowlers spell and that they have been replaced. The new bowler is chosen from a 
list of the remaining players within the fielding side eligible to bowl. (This list will also 
include the wicket keeper.)

Section A indicates the number of the bowler being selected should a new bowler be 
chosen. There is no requirement to select a new bowler and the list indicates both those 
members of the fielding side who have and have not yet bowled during this innings. In the 
example above four bowlers have been used so far and should a new bowler be chosen, 
this would make five.

Section B is the list of eligible bowlers. The list is presented in reverse batting order with 
bowlers currently used during the innings listed first.

Once the bowler has been selected the Done option, identified in section C may be used 
to confirm the selection. If you wish to cancel the change of bowler you may choose close 
from the Bowler Selection window pull down options, top left.

The change of a bowler may only be carried out at the end of an over.



The Bowler Retires Event
If, during the course of play, a bowler is forced to leave the field due to illness or injury 

with the consent of the umpires the remaining deliveries will be bowled by another eligible 
bowler. In order to record the retirement of a bowler during an over the Bowler Retires 
event should be used. The bowling and score sheet analysis will be updated to reflect the 
retirement.

The new bowler is chosen from a list of the remaining players within the fielding side 
eligible to bowl. (This list will also include the wicket keeper.)

Section A indicates the number of the bowler being selected should a new bowler be 
chosen. There is no requirement to select a new bowler and the list indicates both those 
members of the fielding side who have and have not yet bowled during this innings. In the 
example above four bowlers have been used so far.

Section B is the list of eligible bowlers. The list is presented in reverse batting order with 
bowlers currently used during the innings listed first.

Once the bowler has been selected the Done option, identified in section C may be used 
to confirm the selection. If you wish to cancel the retirement of a bowler you may choose 
close from the Bowler Retires window pull down options, top left.



The Bowler Removed Event
If, during the course of play, a bowler is removed due to the bowling of fast short pitched

balls, fast full pitched deliveries, time wasting or damaging the pitch as adjudicated by the 
umpires, the remaining deliveries will be bowled by another eligible bowler. In order to 
record the removal of a bowler during an over the Bowler Removed event should be used. 
The bowling and score sheet analysis will be updated to reflect the removal.

The new bowler is chosen from a list of the remaining players within the fielding side 
eligible to bowl. (This list will also include the wicket keeper.)

Section A indicates the number of the bowler being selected should a new bowler be 
chosen. There is no requirement to select a new bowler and the list indicates both those 
members of the fielding side who have and have not yet bowled during this innings. In the 
example above four bowlers have been used.

Section B is the list of eligible bowlers. The list is presented in reverse batting order with 
bowlers currently used during the innings listed first.

Once the bowler has been selected the Done option, identified in section C may be used 
to confirm the selection. If you wish to cancel the removal of a bowler you may choose 
close from the Bowler Removed window pull down options, top left.



The New Ball Event
During a match of some length, typically a two innings, three to five day match, the 

bowling side will be in a position to take a new ball as agreed between Captains before the 
start of the match. To record this event the New Ball event should be used. The Score sheet
will be updated to indicate that the New Ball has been taken.



The Replacement Ball Event
During a match the original ball may become damaged or lose its shape. The umpires 

may then decide that the ball should be replaced by one of similar age and wear. To record 
this event the Replacement Ball event should be used. The Score sheet will be updated to 
indicate that a Replacement Ball has been taken.



Bowler Warned For Running On Pitch Event
During a match a bowler may run down the centre of the wicket during their follow 

through. Umpires may warn bowlers who repeatedly transgress the laws regarding running 
on the pitch. To record this event the Bowler Warned - Running On Pitch event should be 
used. The Score sheet will be updated to indicate that the bowler has been warned for this 
offence.



Bowler Warned For Short Pitch Bowling Event
During a match a bowler repeatedly bowl short pitched deliveries to the batsmen. 

Umpires may warn bowlers who repeatedly transgress the laws regarding short pitched 
deliveries. To record these events the Bowler Warned - Short Pitch event should be used. 
The Score sheet will be updated to indicate that the bowler has been warned for this 
offence.



Bowler Warned For Bowling Beamers Event
During a match a bowler repeatedly bowl beamer deliveries to the batsmen. Umpires 

may warn bowlers who repeatedly transgress the laws regarding beamer deliveries. To 
record these events the Bowler Warned - Beamer event should be used. The Score sheet 
will be updated to indicate that the bowler has been warned for this offence.



Bowler Comes Around The Wicket Event
During a match a bowler may decide to change from over to around the wicket. To record

this event the Bowler Comes Around Wicket event should be used. The Score sheet will be 
updated to indicate that the bowler has changed to around the wicket.



Bowler Comes Over The Wicket Event
During a match a bowler may decide to change from around to over the wicket. To record

this event the Bowler Comes Over Wicket event should be used. The Score sheet will be 
updated to indicate that the bowler has changed to over the wicket.



Style Of Bowling Event
The style of bowling a bowler extolls can be recorded using the Bowling Style Event. 

There are several styles to choose from which are presented in list form to be selected 
from. Following the first delivery of a bowler use the Bowler Style event to record the style 
of bowling and should the bowler change styles use the event again to record the change. 
The following styles are available:

LF Left Arm Fast
RF Right Arm Fast
LFM Left Arm Fast Medium
RFM Right Arm Fast Medium
LM Left Arm Medium
RM Right Arm Medium
LMF Left Arm Medium Fast
RMF Right Arm Medium Fast
SLA Left Arm Slow Orthodox
OB Right Arm Off Break
LB Right Arm Leg Break
RSM Right Arm Slow Medium
SLC Left Arm Slow Chinamen
LBG Leg Break And Googly
LOB Lob Bowler
UA Underarm Bowling (Not strictly a style)



Fielding Change Event
During a match fielding players may be substituted after consent from umpires and 

captains. To record players leaving and taking to the field the Fielding Change event should 
be used. The Score sheet will be updated to indicate that a fielder has been changed or 
substituted.



The End Of Over Event
Willow Scorebook provides facilities for the automatic or manual ending of an over. If you

have selected to manually end each over then the End Of Over event should be used for 
this purpose.

At the end of each over Willow Scorebook checks for the end of the match or innings, 
updates the bowling and over analysis and identifies the next expected bowler.

The End Of Over event option is only available when Manual End Of Over has been 
selected from the Options menu. If the bowlers end umpire should incorrectly call or not 
call the end of the over before or after the delivery of all 6 or 8 balls as applicable to the 
match in progress you should use the Manual End Of Over option from the Options menu to
turn on the manual calculation of deliveries and then use the End Of Over event to record 
the umpires call of end of over.



Innings Events
The Innings Events menu provides the scorer with the ability to commence or 

recommence an innings, to postpone play due to bad light, rain or other unforeseen act, to 
register a break for lunch, tea or drinks, to allow the batting side to declare or forfeit an 
innings and to allow the batting side to enforce the follow on.

Commence Innings - This option allows the scorer to begin scoring a new innings.
Recommence Innings - This option allows the scorer to register the continuation of an 

innings after a break for lunch, tea, drinks, bad light, rain or an unforeseen circumstance.
Stumps - This option allows the scorer to register the cessation of play when stumps are 

called by the umpires.
Bad Light Stops Play - This option allows the scorer to register the cessation of play 

caused by bad light as agreed by umpires and batsman.
Rain Stops Play - This option allows the scorer to register the cessation of play caused by 

rain as agreed by umpires and batsman.
Play Is Stopped Due To Unforeseen Circumstances - This option allows the scorer to 

register the cessation of play caused by unforeseen circumstances e.g. pitch invasion, 
snow, natural or unnatural disaster.

An Innings Is Declared - This option allows the scorer to register the end of an innings 
following a declaration from the batting team.

Forcing The Follow On - This option allows the scorer to register the forced follow on of 
the previous batting team on their second innings.

Forfeit Of An Innings - This option allows the scorer to register the forfeit of second 
innings by the team expected to bat.

An Innings Is Abandoned - This option allows the scorer to register the abandonment of 
an innings.

Stumps - This option allows the scorer to register the cessation of play when stumps are 
called by the umpires.

Taking Lunch - This option allows the scorer to register the taking of a lunch break.
Taking Tea - This option allows the scorer to register the taking of a tea break.
Taking Drinks - This option allows the scorer to register the taking of a drinks break.
Run Coda - This option allows the scorer to run the Willow CODA module to produce 

Duckworth / Lewis calculations for rain affect One-Day matches.



Commencing An Innings
To begin the second, third or fourth innings of a match the Commence An Innings option 

should be used to initialise the Scorebook for the new innings. Depending upon the settings
for automatic or manual batsman and timing selection the commencement of an innings 
may be followed by the selection of the opening batsmen and the recording of the time at 
which the innings begins. If the manual selection of batsmen and timing has been chosen 
then the following panels will be displayed at the commencement of an innings.

Section A indicates the number of the batsman being selected. In the example above the
opening batsman is being selected.

Section B is the list of eligible batsman. The list is presented in batting order as entered 
through the Match Setup option.

Once the batsman has been selected the Done option, identified in section C may be 
used to confirm the selection. You may not abort this panel when starting an innings or 
match.

Section A indicates the entry of date and time for the incoming batsmen. Although 
any text may be entered for the date and time the format shown above should be adhered.

Once the time has been entered the Done option, identified in section B may be used
to confirm the selection. You may not abort this panel when starting an innings or match.



Recommencing An Innings
Should an innings be suspended due to lunch, dinner or tea or in the event of bad light or

weather or other factors then to resume the innings the Recommencing An Innings option 
should be used. The Scorebook is re-opened at the point of suspension and the play 
resumed. The resumption of play will be recorded in the score sheet.

Section A indicates the entry of date and time for the re commencement of the innings. 
Although any text may be entered for the date and time the format shown above should be
adhered.

You will also be asked to specify the number of overs lost during the suspension if this is 
applicable. The default entry is '0' which indicates that the stoppage does not constitute a 
loss of overs.

Once the time has been entered the Done option, identified in section B may be used to 
confirm the selection. You may not abort this panel when recommencing an innings.



Stumps
Once a days play has been completed in a match extended over more than one day the 

umpires will call 'stumps' and play will be suspended. To record this cessation of play use 
the Stumps option. The score sheet will be updated to reflect the suspension of play and 
further entry to the Scorebook will be halted until the Innings is Recommenced. If the 
manual selection of timing has been chosen from the Options menu then the a panel will be
displayed allowing you to enter the time at which play ceased.



Bad Light Stops Play
If, during the course of play, the innings should be suspended due to bad light, the 

recording of such an instance should be performed using the Bad Light Stops Play option. 
The score sheet will be updated to reflect the suspension of play and further entry to the 
Scorebook will be halted until the Innings is Recommenced. If the manual selection of 
timing has been chosen from the Options menu then the following panel will be displayed.

Section A indicates the entry of date and time for the suspension of play due to bad light.
Although any text may be entered for the date and time the format shown above should be
adhered.

Once the time has been entered the Done option, identified in section B may be used to 
confirm the selection. You may not abort this panel when suspending an innings.



Rain Stops Play
If, during the course of play, the innings should be suspended due to rain, the recording 

of such an instance should be performed using the Rain Stops Play option. The score sheet 
will be updated to reflect the suspension of play and further entry to the Scorebook will be 
halted until the Innings is Recommenced. If the manual selection of timing has been chosen
from the Options menu then the following panel will be displayed.

Section A indicates the entry of date and time for the suspension of play due to rain. 
Although any text may be entered for the date and time the format shown above should be
adhered.

Once the time has been entered the Done option, identified in section B may be used to 
confirm the selection. You may not abort this panel when suspending an innings.



Play Is Stopped Due To Unforeseen Circumstances
If, during the course of play, the innings should be suspended due to unforeseen 

circumstance, the recording of such an instance should be performed using the Play Is 
Stopped Due to Unforeseen Circumstance option. The score sheet will be updated to reflect
the suspension of play and further entry to the Scorebook will be halted until the Innings is 
Recommenced. If the manual selection of timing has been chosen from the Options menu 
then the following panel will be displayed.

Section A indicates the entry of date and time for the suspension of play due unforeseen 
circumstance. Although any text may be entered for the date and time the format shown 
above should be adhered.

Once the time has been entered the Done option, identified in section B may be used to 
confirm the selection. You may not abort this panel when suspending an innings.



An Innings Is Declared
During the course of a match the captain of the batting team may declare an innings at 

any time. In order to record this event the Innings Is Declared option is used. The 
Scorebook will be updated to reflect the declaration and then closed to prevent further 
additions. The score sheet will record the time at which the innings closed. If Automatic 
Timing is set then this will be done automatically. However, if the manual selection of 
timing has been chosen from the Options menu then the following panel will be displayed.

Section A indicates the entry of date and time for the declaration of an innings. Although 
any text may entered for the date and time the format shown above should be adhered.

Once the time has been entered the Done option, identified in section B may be used to 
confirm the selection. You may not abort this panel when declaring an innings.



Forcing The Follow On
During a two innings match the captain of the batting side, having batted first and 

scored a total in excess of the agreed amount above that of the team batting second may 
force this team to bat again. This may only be actioned before the commencement of the 
innings. The Follow On option is used to record this event in the Scorebook.



Forfeit Of An Innings
During a two innings match an innings may be made forfeit by the captain of the batting 

side in order to increase the chance of a conclusion to the match. This may only be 
actioned before the commencement of the innings. The Forfeit An Innings option is used to 
record this event in the Scorebook.



An Innings Is Abandoned
Due often to poor weather but under other circumstances also an innings may be 

abandoned. This option will be particularly useful for one day matches in which an innings 
abandonment is common.



Taking Lunch
When lunch is taken during an innings the recording of the event should be performed 

using the Lunch option. The score sheet will be updated to reflect the suspension of play 
and further entry to the Scorebook will be halted until the Innings is Recommenced. If the 
manual selection of timing has been chosen from the Options menu then the following 
panel will be displayed (This also applies to the taking of Tea, Drinks or the suspension of 
play for any other reason).

Section A indicates the entry of date and time at which lunch is taken. Although any text 
may be entered for the date and time the format shown above should be adhered.

Once the time has been entered the Done option, identified in section B may be used to 
confirm the selection. You may not abort this panel when suspending an innings.



Taking Tea
When tea is taken during an innings the recording of the event should be performed 

using the Tea option. The score sheet will be updated to reflect the suspension of play and 
further entry to the Scorebook will be halted until the Innings is Recommenced. If the 
manual selection of timing has been chosen from the Options menu then the following 
panel will be displayed.

Section A indicates the entry of date and time at which tea is taken. Although any text 
may be entered for the date and time the format shown above should be adhered.

Once the time has been entered the Done option, identified in section B may be used to 
confirm the selection. You may not abort this panel when suspending an innings.



Taking Drinks
When Drinks are taken during an innings the recording of the event should be performed 

using the Drinks option. The score sheet will be updated to reflect the suspension of play 
and further entry to the Scorebook will be halted until the Innings is Recommenced. If the 
manual selection of timing has been chosen from the Options menu then the following 
panel will be displayed.

Section A indicates the entry of date and time at which drinks are taken. Although any 
text may be entered for the date and time the format shown above should be adhered.

Once the time has been entered the Done option, identified in section B may be used to 
confirm the selection. You may not abort this panel when suspending an innings.



Run CODA
During the course of One-Day matches where rain and bad weather has affected the 

match and overs have been lost you may find it useful to employ the Duckworth/Lewis 
method of calculating revised totals. In order to calculate revised totals you must use the 
CODA (Cricket One-Day Analysis) which analyses the match, predicts scores and thus can 
recommend revised totals. The Willow CODA Module is an additional piece of software 
which can be used with Willow to this end. Click the Run CODA option to start this 
additional module.



Match Events
The Match Events menu provides the scorer with the ability to commence a match, 

abandon a match and to conclude a match due to concession, conclusion or refusal to play 
by one or other side :-

Commence Match - This option allows the scorer to begin scoring a match.
Match Abandoned - This option allows the scorer to register a match as being 

abandoned.
Refusal To Play - This option allows the scorer to register the conclusion of a match by 

virtue of one or other side refusing to continue play.
Concede A Match - This option allows the scorer to register the concession of a match.
Conclude A Match - This option allows the scorer to register the conclusion of a match.



Commencing A Match
To begin a match and start the first innings the Commence A Match option should be 

used to initialise the Scorebook for the new match and innings. Depending upon the 
settings for automatic or manual batsman and timing selection the commencement of a 
match may be followed by the selection of the opening batsmen and the recording of the 
time at which the innings begins. If the manual selection of batsmen and timing has been 
chosen then the following panels will be displayed at the commencement of the match.

Section A indicates the number of the batsman being selected. In the example above the
opening batsman is being selected.

Section B is the list of eligible batsman. The list is presented in batting order as entered 
through the Match Setup option.

Once the batsman has been selected the Done option, identified in section C may be 
used to confirm the selection. You may not abort this panel when starting an innings or 
match.

Section A indicates the entry of date and time for the incoming batsmen. Although 
any text may be entered for the date and time the format shown above should be adhered.

Once the time has been entered the Done option, identified in section B may be used
to confirm the selection. You may not abort this panel when starting an innings or match.

Having selected opening batsman and recorded times of entry as necessary the scorer 
must register the opening bowler. A list of all eleven eligible bowlers is presented for 
selection. (This list will also include the wicket keeper.)



Section A indicates the number of the bowler being selected as the opening bowler.
Section B is the list of eligible bowlers. The list is presented in reverse batting order.
Once the bowler has been selected the Done option, identified in section C may be 

used to confirm the selection. You may not cancel the selection of opening bowler.



Match Abandoned
Should a match have to be abandoned the Match Abandoned option should be used to 

record the lack of a result in the Scorebook. If the manual selection of timing has been 
chosen from the Options menu then the following panel will be displayed.

Section A indicates the entry of date and time at which the match was abandoned. 
Although any text may be entered for the date and time the format shown above should be
adhered.

Once the time has been entered the Done option, identified in section B may be used to 
confirm the selection. You may not abort this panel when suspending a match.



A Refusal To Play
If, during the course of play, a team refuse to continue playing then the umpires shall be 

forced to award the match to the other side. The recording of such an instance should be 
performed using the Refusal To Play option. The following panel will be displayed so that 
the scorer may select the team which has refused to play (This also applies to matches 
ended by concession or conclusion).

Section A indicates whether the 'H'ome or 'A'way team have refused to play.
Once the Home or Away team have been entered the Done option, identified in section B

may be used to confirm the selection. You may not abort this panel when suspending a 
match.

The result will then be entered into the Scorebook. If the manual selection of timing has 
been chosen from the Options menu then the following panel will be displayed.

Section A indicates the entry of date and time at which the match was concluded due to 
a refusal to play. Although any text may be entered for the date and time the format shown
above should be adhered.

Once the time has been entered the Done option, identified in section B may be used to 
confirm the selection. You may not abort this panel when suspending a match.



Concede A Match
If a team concedes defeat then the umpires shall award the match to the other side. The 

recording of such an instance should be performed using the Concede A Match option. The 
following panel will be displayed so that the scorer may select the team which has 
conceded.

Section A indicates whether the 'H'ome or 'A'way team have conceded defeat.
Once the Home or Away team have been entered the Done option, identified in section B

may be used to confirm the selection. You may not abort this panel when suspending a 
match.

The result will then be entered into the Scorebook. If the manual selection of timing has 
been chosen from the Options menu then the following panel will be displayed.

Section A indicates the entry of date and time at which the match was concluded due to 
concession. Although any text may be entered for the date and time the format shown 
above should be adhered.

Once the time has been entered the Done option, identified in section B may be used to 
confirm the selection. You may not abort this panel when suspending a match.



Conclude A Match
If a match is concluded due a rearranged target in a limited overs match or for an 

exceptional condition then the umpires shall award the match accordingly. The recording of 
such an instance should be performed using the Conclude A Match option. The following 
panel will be displayed so that the scorer may select the team which has won the match by
conclusion.

Section A indicates whether the 'H'ome or 'A'way team have won the match by 
conclusion.

Once the Home or Away team have been entered the Done option, identified in section B
may be used to confirm the selection. You may not abort this panel when suspending a 
match.

The result will then be entered into the Scorebook. If the manual selection of timing has 
been chosen from the Options menu then the following panel will be displayed.

Section A indicates the entry of date and time at which the match was concluded. 
Although any text may be entered for the date and time the format shown above should be
adhered.

Once the time has been entered the Done option, identified in section B may be used to 
confirm the selection. You may not abort this panel when suspending a match.



The Note Event
Every Cricket Match is different and has its own unique incident. As scorer you will often 

want to reflect such special events in the scorebook. In order to record these events the 
Note option should be used which provides a free form text entry box for your note.

Notes are displayed in the Score sheet Window at the point in the innings at which they 
were recorded.



The Options Menu
The Options menu provides the scorer with the ability to tailor Willow Scorebook to suit 

both the match play and the type of scoring required. A number of features of Willow 
Scorebook may be carried out automatically, without the scorers intervention but this does 
not always suit. The options menu also provides facilities to control    the Options Icon 
Palette display which can be displayed both horizontally and vertically. The options menu 
also contains the Undo feature which erases a mistake in scoring :-

Vertical Display Of Options Icon Palette - This option sets the display of the Options Icon 
Palette to vertical.

Horizontal Display Of Options Icon Palette - This option sets the display of the Options 
Icon Palette to horizontal.

Extended Display Of Options Icon Palette - This option sets the display of the Options 
Icon Palette to the extended 36 option palette.

Extended Horizontal Display Of Options Icon Palette - This option sets the display of the 
Options Icon Palette to the extended 36 option palette in a horizontal orientation.

Set Batsman Scoring Positions After Ball - This option allows the recording of the 
batsman's strokes to be made after having previously recorded the result of the delivery.

Set Batsman Scoring Positions Before Ball - This option allows the recording of the 
batsman's strokes to be made before recorded the result of the delivery.

Undo Ball - This option allows the scorer to undo the previous delivery thus allowing the 
delivery to be entered again correctly.

Set Automatic Timing - This option, when set, uses the PC system date and time to 
record the times at which batsman begin and end their innings and the times at which 
innings are commenced or at the cessation or conclusion of play.

Set Manual Timing - This option, when set, forces the scorer to record the times at which 
batsman begin and end their innings and the times at which innings are commenced or at 
the cessation or conclusion of play.

Set No Timing - This option, when set, will ignore all requirements for setting the times at
which batsman begin and end their innings and the times at which innings are commenced 
or at the cessation or conclusion of play by leaving these details blank in the Scorebook.

Set Automatic Batsman Selection - This option, when set, causes Willow Scorebook to 
automatically select batsman in order of their definition in the Match Setup when an innings
is commenced or at the fall of a wicket.

Set Manual Batsman Selection - This option, when set, forces the scorer to select the 
opening batsman at the start of an innings and the new batsman at the fall of a wicket.

Set Automatic End Of Over - This option, when set, causes Willow Scorebook to mark the 
end of an over by calculating the number of balls bowled in the over.

Set Manual End Of Over - This option, when set, forces the scorer to mark the end of the 
over.

Set Automatic Match Saving - This option can be used to ensure that a match is saved at 
regular intervals in various formats.



Vertical Display Of Options Icon Palette
The Options Icon Palette, used for one click entering of common scoring functions, 

contains twelve options which may be displayed vertically as two columns of six rows or 
horizontally as two rows of six columns. The default selection is to display the Options Icon 
Palette vertically as indicated below. The display of the palette may be changed at any time
during the scoring process.

Further help is offered in the section Help With The Options Icon Palette .



Horizontal Display Of Options Icon Palette
The Options Icon Palette, used for one click entering of common scoring functions, 

contains twelve options which may be displayed vertically as two columns of six rows or 
horizontally as two rows of six columns. The horizontal display of the options icon palette is 
indicated below. The display of the palette may be changed at any time during the scoring 
process.

Further help is offered in the section Help With The Options Icon Palette .



Extended Display Of Options Icon Palette
The Extended Options Icon Palette, used for one click entering of common scoring 

functions, contains thirty six options as opposed to the twelve offered by the vertical and 
horizontal displays of the standard Options Icon Palette. The default selection is to display 
the standard Options Icon Palette vertically. The display of the palette may be changed at 
any time during the scoring process.

Further help is offered in the section Help With The Options Icon Palette .



Extended Horizontal Display Of Options Icon Palette
The Extended Horizontal Options Icon Palette differs from the Extended Options Icon 

Palette in that it provides two rows of eighteen icons rather than the six by six display of 
the Extended Options Icon Palette. You should note that this may not display fully on some 
monitors.

Further help is offered in the section Help With The Options Icon Palette .



Set Batsman Scoring Positions After Ball
Willow Scorebook provides facilities for scoring the positional play of a delivery following 

or before the recording of the delivery. When a batsman scores runs from a delivery two 
independent scoring mechanisms can be employed; the number of runs scored is one 
element and the position on the field to which the ball was struck is the other. As scorer 
you may decide to record the score first and the position second. On the other hand you 
may wish to record the position first and score second. Two options are provided to enable 
you to set which of these two methods you wish to use. You must remember to be 
consistent in your approach and are recommended to select one of these methods and use 
it whenever you use Willow Scorebook.

If you want to score the position second, which is the default and most natural of the two
choices, then select the Score Positions After Ball option.

Refer to the Set Scoring Positions window selection for more information.



Set Batsman Scoring Positions Before Ball
Willow Scorebook provides facilities for scoring the positional play of a delivery following 

or before the recording of the delivery. When a batsman scores runs from a delivery two 
independent scoring mechanisms can be employed; the number of runs scored is one 
element and the position on the field to which the ball was struck is the other. As scorer 
you may decide to record the score first and the position second. On the other hand you 
may wish to record the position first and score second. Two options are provided to enable 
you to set which of these two methods you wish to use. You must remember to be 
consistent in your approach and are recommended to select one of these methods and use 
it whenever you use Willow Scorebook.

If you want to score the position first then select the Score Positions Before Ball option.
Refer to the Set Scoring Positions window selection for more information.



Undo Ball
One of the most important features of Willow Scorebook is the ability to undo or erase 

mistakes in scoring. Even the most diligent of scorers are guilty of guessing umpires calls 
before they are signalled or making incorrect assumptions about the score. If you, for 
example, see the striker stroke the ball into the outfield and see three runs accrue it is only 
natural to record three runs before noticing the umpires signal of one short. In this example
and the many others which you will undoubtedly encounter it will be imperative for you to 
erase the score for the delivery and to replace it with the correct result.

Willow Scorebook holds the position of play for up to six deliveries enabling you, as 
scorer to undo each of the past six deliveries in turn should you need to. The Undo Ball 
option will reset the Scorebook to the position prior to the recording of the last delivery.

There are occasions when you will not be able to undo scoring mistakes and as such 
some care should be taken before confirming these events. The Undo option is disabled 
after the conclusion or suspension of an innings or match or once a match is saved and 
then reopened. Events such as 'changing the ends at which the batsmen stand', although 
not strictly a delivery are counted as such for the undo option thus reducing the actual 
deliveries which can be undone. It should be noted that it is not possible to adjust the 
Scorebook at the end of an innings as is sometimes done in village cricket, to ensure the 
Scorebook tallies. Willow Scorebook reduces the likelihood of such mistakes to a minimum.



Set Automatic Timing
Willow Scorebook provides facilities for recording the time at which certain events take 

place. Such events include the times at which batsmen are out or take to the field and the 
times at which innings commence, conclude or are suspended due to weather or interval. 
These events can be recorded automatically by Willow Scorebook, manually by you the 
scorer, or not at all.

The Automatic Timing option, when set, performs the recording of timed events 
automatically be using your computers internal date and time settings. If you use the 
Automatic Timing option you should ensure that your computers date and time are set 
correctly.

You must select Automatic Timing, Manual Timing or No Timing, before you commence a 
match. Although you can change from Automatic Timing to Manual or No Timing during a 
match you may not change from Manual to Automatic. You should consider this selection 
carefully before commencing the match. 



Set Manual Timing
Willow Scorebook provides facilities for recording the time at which certain events take 

place. Such events include the times at which batsmen are out or take to the field and the 
times at which innings commence, conclude or are suspended due to weather or interval. 
These events can be recorded automatically by Willow Scorebook, manually by you the 
scorer, or not at all.

The Manual Timing option, when set, will force Willow Scorebook to request times from 
you, the scorer, during the recording of the instances above. A time entry panel will be 
displayed similar to the one indicated below.

Section A indicates the current time as known by your computer but will then allow 
you to edit this field. Times should be recorded as displayed above. The date should be 
entered first in DD-MM-YYYY format followed by a space and then the time in HH:MM format 
using twenty four hour notation. No checks are performed on the entry of this field but the 
convention will help you identify times when viewing the score sheet.

Once the time has been entered the Done option, identified in section B may be used to 
confirm the selection.

You must select Automatic Timing, Manual Timing or No Timing, before you commence a 
match. You may not change this selection during the match.



Set No Timing
Willow Scorebook provides facilities for recording the time at which certain events take 

place. Such events include the times at which batsmen are out or take to the field and the 
times at which innings commence, conclude or are suspended due to weather or interval. 
These events can be recorded automatically by Willow Scorebook, manually by you the 
scorer, or not at all.

The No Timing option, when set, will force Willow Scorebook to ignore the recording of 
times for all the instances above.

You must select Automatic Timing, Manual Timing or No Timing, before you commence a 
match. You may not change this selection during the match.



Set Automatic Batsman Selection
Willow Scorebook provides facilities for the automatic or manual selection of the next 

incoming batsman during innings. If Automatic Batsman Selection is chosen from the 
Options menu then, at the fall of a wicket or incapacitation of a batsman, the next batsman
will be automatically be recorded in the Scorebook. The batsmen are picked in order from 
the list of batsmen entered through the Match Setup option. When the fourth wicket falls 
for example, the sixth batsman will be selected from the Match Setup list for the batting 
team.

Automatic or Manual Batsman selection can be changed at any time during play. You 
should remember however, that if you are using Automatic Batsman Selection you must 
switch to manual batsman selection before recording the wicket if the order of batsman will
change. If you are not a member of the batting team or party to the captains decisions then
you should set the selection to Manual.



Set Manual Batsman Selection
Willow Scorebook provides facilities for the automatic or manual selection of the next 

incoming batsman during innings. If Manual Batsman Selection is chosen from the Options 
menu then, at the fall of a wicket or incapacitation of a batsman, you will be requested to 
choose the next incoming batsman from the Batsman Selection list as indicated below. Only
those batsman still eligible to bat will be displayed and this list will contain any batsmen 
who have retired not out during the innings.

Section A indicates the number of the batsman being selected.
Section B is the list of eligible batsmen. The list is presented in batting order as entered 

in Match Setup.
Once the batsman has been selected the Done option, identified in section C may be 

used to confirm the selection.

If only retired not out batsman remain eligible to bat then the Check Not Out panel will 
be displayed before Batsman Selection as indicated below. This panel is used to determine 
whether the innings is concluded or whether a Retired Not Out batsman will retake the field
to bat.

The entry panel below A can be changed to Yes or No to indicate whether the innings 
will continue.

Once the batsman has been selected the Done option, identified in section B may be 
used to confirm the selection.

Automatic or Manual Batsman selection can be changed at any time during play.



Set Automatic End Of Over
Willow Scorebook provides facilities for the automatic or manual ending of an over. If you

select the Automatic End Of Over option then Willow Scorebook will check and record the 
end of over automatically. Willow Scorebook will count the balls delivered in the over and 
once 6 or 8 balls are reached (as defined in Match Setup) the Scorebook will be updated to 
reflect the end of over. When Automatic End Of Over is selected the End Of Over event will 
be disabled.

Under most circumstances Automatic End Of Over should be used to record entries in the
Scorebook. However should an umpire incorrectly count the number of balls in the over you
will need to change to manual selection temporarily in order to record the extra or missing 
ball(s).

Automatic or Manual End Of Over selection can be changed at any time during play.



Set Manual End Of Over
Willow Scorebook provides facilities for the automatic or manual ending of an over. If you

select to manually end each over then the End Of Over event should be used for this 
purpose.

The End Of Over event option is only available when Manual End Of Over has been 
selected. If the bowlers end umpire should incorrectly call or not call the end of the over 
before or after the delivery of all 6 or 8 balls as applicable to the match in progress you 
should use the Manual End Of Over option to turn on the manual calculation of deliveries 
and then use the End Of Over event to record the umpires call of end of over.



Set Automatic Match Saving
Everyone is forgetful sometimes and computers can 'glitch' in many different ways. To 

protect you against such minor and major disasters the Willow Scorebook provides facilities
for automatically saving match information while you score. The Automatic Save Option 
allows you to perform a Match Save at the completion of every over or more frequently at 
the completion of each delivery. You can carry on and concentrate on the matter of scoring 
rather than be concerned whether the match is saved safely.

When you click the Auto Save option a panel will be displayed providing you with a 
number of auto save facilities.

You may save files in either the normal Willow match save format WSB (which you 
should note is the only method of reading files back into Willow and as such should be your
default option) or in Cricket Scorebook Format CSF, or as a Data Interchange Format DIF 
file, or as a set of HTML pages suitable for viewing by an Internet Web Browser such as 
Microsoft Explorer or Netscape Navigator or as an Electronic ScoreBook file ESB which may
link directly to an electronic scoreboard. You may choose any number of these formats 
simultaneously together with their associated options.

WSB. Willow Scorebook files may be saved automatically at the end of every over or at 
the conclusion of each and every delivery. You may also choose to create Unique Filenames
for each saved copy of the match. If you choose not to create unique files then the default 
match filename will be used (You will be prompted for a filename if one has not yet been 
provided. The Save As option describes this process in more detail). If you choose to create
unique filenames then each time the WSB file is saved it will be given a unique filename 
and an extension of TMP. You should ensure that you regularly tidy your data directory of 



TMP files if you use this method as significant disk space can be used through this method.
However it does provide you with the best protection against data corruption and scoring 
errors.

CSF. Cricket Scorebook Format files may be saved automatically at the end of every 
over or at the conclusion of each and every delivery. Refer to the Export Match.for further 
information.

DIF. Data Interchange Format files may be saved automatically at the end of every over
or at the conclusion of each and every delivery. Refer to the Export Match.for further 
information.

HTML. Hyper Text Markup files in version 3 format may be saved automatically at the 
end of every over or at the conclusion of each and every delivery. HTML files are created 
based on a template identified using the Browse Templates .TPT button. A DEFAULT.TPT 
template file is supplied with Willow but you can create your own using a text editor. The 
DEFAULT.TPT file contains several lines of text. Each line fits one of four categories which 
are explained below.

INNINGS n
The INNINGS line enables you to select which of four innings you wish the following 

PROCESS lines to deal with. The value of n should be from 1 to 4 where 1 is the first innings
of the match and 4 is the last inning of a two innings game. An INNINGS line should always 
preceed one or more PROCESS lines.

PROCESS input output
The PROCESS line enables you to identify an input and output file. The input file will 

be a text file encoded in HTML v3 format which includes variable identifiers for match 
information. Each variable is preceeded by a # character. Each variable contains two 
letters followed by two numbers. An INPUT.HTM file is provided so that you can see how 
this process works but you will need to edit or create your own input files yourself. The 
PROCESS command forces the input file to be read and each variable is then converted to 
the text equivalent of the field value to which it is associated. This new, filled, file is then 
written to the output file name ready for web publishing.

RUN program parameters
The RUN line enables you to execute a secondary program from within Willow. 

Although it doesn't have to be, this could very well be an FTP (File Transfer Protocol) 
program to transmit your output file(s) to your hosted web site. You may supply the name 
of the program you wish to run together with any parameters necessary. If you wish to 
publish Willow scored matches in real time to the Internet through a PPP or SLIP connection
then we recommend that you look at the SDFTP scripted FTP utility. The author can be 
contacted at pgsoft@ix.netcom.com. At the time of writing the latest versions of the SDFTP 
programs (1.38 for 16bit and 1.50 for 32 bit) are available from http://www.shareware.com.

MESSAGE message
The MESSAGE enables you to send messages to the Willow operator informing them 

of template script    progress.
The HTML output option provides a flexible and practical method of publishing real time 

scoring information across the globe. You are advised however to seek technical assistance
with matters concerning Internet connectivity in relation to this activity.

ESB. Electronic Scoreboard files may be saved automatically at the end of every over or
at the conclusion of each and every delivery. ESB files are created using a unique name 
provided through the Set Electronic Scoreboard File command. Once the file is identified 
and the automatic save is enabled then a record is written to the defined file which can 
then be read and interpreted ready for display on an electronic scoreboard. Each Electronic
Scoreboard is different however and you are advised to consult with EddSON to find the 
appropriate action to enable you to display Willow information on your Electronic 



Scoreboard.
Two additional options are provided for Electronic Scoreboard Entry. If the Show A 

Countdown Of 20 Overs option is set then for limited over matches the current number of 
overs output as part of the ESB file will contain the number of overs left rather than those 
bowled in the inning once 20 or fewer remain in the inning.

If the Show Score At Fall Of Last Wicket is set then the ESB file will no longer be output 
with the opponents total but will instead contain the score for the current inning at which 
the last wicket fell.

If you have selected any of the above five Save As options then a tick will appear against
the Save As option on the Options menu to indicate that some method of automatic saving 
has been enabled.



The Setup Menu
The Setup menu provides two options for setting up match details and innings details 

before commencing either match or innings:-

Match Setup - This option provides the scorer with facilities to ensure pre match details 
are set before the start of play.

Player Setup - This option provides the scorer with the ability to define the names of the 
players for each team before and during a match.

Innings Setup - This option provides the scorer with facilities to ensure pre innings details
are set before the start of play for each innings.



Match Setup
Before the start of a cricket match, the scorer will prepare a Scorebook by entering 

pertinent information regarding teams, dates and times, type of match, number of overs 
etc. This information will be entered before the commencement of the first innings. Willow 
Scorebook provides for the entry of this information through the Match Setup option.

The Match Setup option will be automatically invoked when a new match (Refer to the 
File New menu option) is opened but can also be selected during play.

The Match Setup panel is presented as a list of editable fields which can be navigated by 
using the tab key (to move forward to the next field) and shift tab (to move backward to the
previous field). The Match Setup panel is displayed and described below. At various stages 
throughout a match the entry of Match Setup information may be prohibited. You cannot, 
for example, change the number of balls in an over after the start of a match nor set the 
match result before the match has concluded. Such fields are displayed in dark grey.

The Match Setup panel below contains the letters A to Z plus n displayed in red. Each 
field identified by these letters is described in a section below. After the description of each 
Match Setup field letters in blue indicate when the field may be entered or changed. A B 
indicates the field may be edited Before the commencement of a match. A D indicates the 
field may be changed during a match and an A indicates the field may be updated after the 
conclusion of a match.

The Match Setup panel, when displayed before a match is commenced, is filled with 
default values. These default values may be changed and stored using the Save Defaults 
option. As many of the default values will need to be changed for each match, facilities are 
provided for clearing fields. If the CTRL and DELETE keys are pressed whilst editing a field 
the current contents of the field will be cleared. If the CTRL, SHIFT and DELETE keys are 
pressed then all text fields within the Match Setup window will be cleared.

Once the fields in the Match Setup panel have been entered you should use the Done 
option to close the window and save your settings.



A/B Name Of Home Team / Name Of Away Team
The cricket match is played between a home team and an away team, regardless of 

whether the match venue should be one of the teams regular pitch. In the event that both 
teams are playing away from their regular ground or that both teams play regularly on the 
same ground, the scorer must decide which team shall be deemed to be playing at home 
and which is playing away. The name of each team should then be typed into the entry fields
beside the Name Of Home Team and Name Of Away Team.

B,D,A

C Name Of Ground
The name of the venue at which or ground on which the match is played should be 

entered for the Name Of Ground.
B,D,A

D Type Of Match
The entry of Type Of Match should encompass whether the match is Friendly, League or 

Cup, Amateur, County/Province or International. You should decide upon the standard which
suits your matches best and adhere to your standard for all games.

B,D,A

E Date Of Match



The Date on which the match starts should be entered for Date Of Match. The current 
date, as known by your computer, will be entered automatically for you. You may change 
the date but should adhere to the DD-MM-YYYY format provided.

B

F Days In Match (1/5)
The maximum number of days allowed for the match may be entered in Days In Match. 

The number of days should be entered as a number from 1 to 5.
B

G/H Name Of Top End / Name Of Bottom End
Many grounds have names for each end of the wicket. You may enter names for each 

end under the headings Name Of Top End and Name Of Bottom End. Which end you decide 
is top and which is bottom is an arbitrary decision but one you should try to be consistent 
with when recorded the score of many matches on the same ground.

B,D,A

I Match Notes
As scorer, you may want to make special comment about a match before or during play 

to serve as a reminder when examining the match detail at a later date. The Match Notes 
section allows the free form entry of text.

B,D,A

J/K Name Of Umpire 1 / Name Of Umpire 2
If umpires have been assigned to adjudicate a match then their names should be 

entered. If players are acting as umpires during part of a match (amateur cricket) you are 
recommended to record one or both umpires as N/A (Not Applicable).

B,D,A

L/MName Of Scorer 1 / Name Of Scorer 2
If scorers have been assigned to score a match then their names should be entered. If 

players are    acting as scorers during part of a match (amateur cricket) you are 
recommended to record one or both scorers as N/A (Not Applicable).

B,D,A

N Local Customs
Many grounds have Local Customs to reduce ambiguity with regard to the normal laws of

the game or to stress those laws. A ground may have a tree within the boundary which 
constitutes four runs if hit regardless of whether the ball is still in flight or has bounced. 
Such local customs or agreements made by both captains should be entered prior to the 
start of the match.

B,D,A

n Wides as balls faced by the batsmen
There is some discussion over whether wide balls should be recorded as balls faced by 

the batsmen. Under normal circumstances this value should be set to No but if your 



competition or governing organisation determine that wides should be recorded as balls 
faced by the batsmen then set this field to Yes.

B

O Players Per Team
Most games of cricket are played between teams of eleven players. Some matches may 

be played with less, such as six a side cricket or indoor cricket. The number of players in a 
team should be entered in the Players Per Team section. Willow supports from 5 to 15 
players.

B

P Toss Won By (H/A)
The result of the toss before a match is recorded using the Toss Won By entry. If the 

Home team captain wins the toss an H should be entered. If the Away captain wins an A 
should be entered.

B

Q No' Of Innings (1/2)
Each cricket match is comprised of one or two batting and fielding innings for each team.

You should enter either 1 or 2 against the Number Of Innings section as appropriate to the 
match.

B,D,A

R Overs Per Innings
Matches may be played with limited overs for the batting side or with an unlimited 

number of overs. If an unlimited match will be played you should enter 0 in the Overs Per 
Innings section. If the match is to be played in limited overs you should enter the number 
of overs allowed.

B,D,A

S No Ball Value(1/2/-1/-2)
Matches may be played where the value of a no ball is recorded as either 1 or 2 for the 

batting side. In exceptional circumstances you may be required to score a match using both
ie 1 for regular no balls and 2 for an illegal bouncer. You may also enter a minus value of 
either -1 or -2. There are therefore four different values that can be entered for the No Ball 
Value and these are scored in different ways.

1 or +1 A penalty of one run is scored for the no ball. If runs are scored through Byes, 
Leg Byes or Batting runs from the no ball then the No Ball penalty IS NOT also added to the 
score. This is the traditional and default option.

The current MCC No Ball rule and the rule still used for Test Matches states that 'A 
penalty of one run for a no ball shall be scored if no runs are made otherwise'. 
Thus if a bowler bowls a No Ball and the batsman hits the ball to the boundary then the 
batsman would be attributed with four additional runs, the score would advance by four 
and the bowlers analysis would increase by four and the bowler would be obliged to repeat 
the delivery. However if the bowler bowled a No Ball and no other runs were made then the
Score would advance by one run and the bowlers analysis would do likewise with the 



penalty now directly attributable to the No-Ball. On the Match Setup panel you can 
configure this basic format by entering (1).

2 or +2 A penalty of two runs is scored for the no ball. If runs are scored through Byes,
Leg Byes or Batting runs from the no ball then the No Ball penalty IS NOT also added to the 
score.

In some Formats the penalty for a No Ball is not one run but two runs. The rules for 
scoring still obey those in the fist point above except that if the Batsman hit a single off the
No Ball then the penalty would be split between batsman (one run) and the No Balls total 
(one run) although the bowlers analysis would increase by two. In this example the score 
would also advance by two. On the Match Setup panel you can configure this option using 
the value (2). This is the least used of the four types of No Ball. It does contain the most 
anomalies after all.

-1 A penalty of one runs is scored for the no ball. If runs are scored through Byes, Leg 
Byes or Batting runs from the no ball then the No Ball penalty IS also added to the score.

Increasingly used in one day matches and is a derivative of point (1). The penalty 
associated with the No Ball is still one but any additional runs scored from the No-Ball are 
always scored in addition to the No Ball penalty. To use the example again if a bowler bowls
a No Ball and the batsman hits the ball to the boundary then the batsman would be 
attributed with four additional runs, the score would advance by five (No Ball = 1, Batsman 
= 4), the bowlers analysis would increase by five and the bowler would be obliged to repeat
the delivery. However if the bowler bowled a No Ball and no other runs were made then the
Score would advance by one run and the bowlers analysis would do likewise. This format is 
commonly known as '+1 No Ball Scoring' although to configure this format on the Match 
Setup panel you should enter (-1).

-2 A penalty of two runs is scored for the no ball. If runs are scored through Byes, Leg 
Byes or Batting runs from the no ball then the No Ball penalty IS also added to the score.

The last of the four formats takes the penalty value from the second point (two) and the 
method from the third point (additive) and is commonly known as '+2 No Ball Scoring'. To 
configure this format on the Match Setup panel you should enter (-2).

We recommend that you experiment with these options to fully appreciate their 
differences.

B,D,A

T Balls In Over (6/8)
Matches may be played with overs of either 6 or 8 balls.
B

U Result Notes
On the completion of a match Willow Scorebook will update the Result Notes field with an

automatic calculation of the match result. This result may not be entirely accurate for all 
circumstances and may be changed accordingly. The field is free form text and can be used
for any match result comments or notes. This field can only be altered after the completion 
or conclusion of the match.

A



V/W Points For Home Team / Points For Away Team
The result of a match may yield points for the Home and Away teams if playing in a 

league or tournament. The award of points may be recording in the Points for Home and 
Away Teams sections.

A

X Result Details
The Result Details field may not be altered but does display the current selection for 

match result. This field differs from the Result Notes field in that only certain entries may 
appear in this field. Selection of the match result type, winning team and the margin for 
victory in runs or wickets is altered using the Set Match Result button described below.

A

Y Done
The Done button will close the Match Setup window and return control to the Willow 

Scorebook menu.
B,D,A

Z Set Match Result
The Set Match Result button is only available at the conclusion of a match. When pressed

a list of selectable Result Types is displayed. There are fourteen different results to choose 
from covering all possible match results including English and Australian league result 
types. After selecting the Result Type you may then also be asked to choose the Winning 
Team. This is done by entering an H for the Home Team or A for the Away Team. Lastly you 
may also be required to specify the number of Runs or the number of Wickets to describe 
the margin of victory. Once these panels are updated the Result Details field will be 
updated to reflect your selections. You may reiterate this process as many times as you 
wish to change the result type.

B,D,A



Player Setup
Before the start of a cricket match, the scorer will prepare a Scorebook by entering 

pertinent information regarding teams, dates and times, type of match, number of overs 
etc. Willow Scorebook provides for the entry of this information through the Player Setup 
option.

The Player Setup option will be automatically invoked after a new match (Refer to the File
New menu option) is opened but can also be selected during play.

The Player Setup panel is presented as a list of editable fields which can be navigated by 
using the tab key (to move forward to the next field) and shift tab (to move backward to the
previous field). The Player Setup panel is displayed and described below.

The Player Setup panel below contains the letters A to D displayed in red. Each field 
identified by these letters is described in a section below.

The Player Setup panel, when displayed before a match is commenced, is filled with 
default values. These default values may be changed and stored using the Save Defaults 
option. As many of the default values will need to be changed for each match, facilities are 
provided for clearing fields. If the CTRL and DELETE keys are pressed whilst editing a field 
the current contents of the field will be cleared. If the CTRL, SHIFT and DELETE keys are 
pressed then all text fields within the Player Setup window will be cleared and Captains and 
Wicket Keepers reset to batsman number one. If the SWITCH button is selected (Bottom 
right) then the Home and Away player names will be swapped.

Once the fields in the Player Setup panel have been entered you should use the Done 
option to close the window and save your settings.

A/C Home Player Names / Away Player Names
Up to twelve player names may be entered for both teams. Each name should be 

entered in the teams expected batting order although this may be overridden during play.
B/D One captain and one wicket keeper per team may also be selected. On the 

right of the players names two columns indicate the selection of captain and wicket keeper. 
To select a teams captain ensure the circle is clicked solid in the first column of circles 
against the captains name. To select a teams wicket keeper ensure the second columns 



circle against the wicket keepers name is clicked solid. By default the first name for both 
teams is selected as both captain and wicket keeper. You will not be able to set a captain or 
keeper outside the value defined in Match Setup for the number of players per team. If for 
example, the match is to be played with 6 players per side then the captain and wicket 
keeper must be selected from the first six names within Player Setup.



Innings Setup
Before the start of each innings, the scorer will prepare a Scorebook by entering 

pertinent information regarding the current batting team, end to start, pitch and weather. 
Willow Scorebook provides for the entry of this information through the Innings Setup 
option.

The Innings Setup option will be automatically invoked after a new match (Refer to the 
File New menu option) is opened but can also be selected during play.

The Innings Setup panel is presented below as a list of editable fields.

Current Innings No'
The number of the current innings is indicated but is not editable in the Current Innings 

No' field. This value may be from 1 to 4.

Current Batting Team
The current batting team may be entered as H for the home team or A for the Away 

team. This field may be changed only the start of the first innings but not thereafter.

Weather Conditions / Pitch Condition
The condition of both weather and pitch may be entered for each innings. You should 

attempt to gain consistency with your entries for both conditions. For example :-

Weather Sunny, Fair, Cloudy, Stormy
Clear, Overcast
Humid; Crisp
Hot; Mild; Bitter 

Pitch Hard, Spongy
Bare, Grassy
Flat, Rolled, Unrolled, Bumpy
Solid, Loose; Crumbly, Cracked



End To Start Innings
The end at which the batsman takes strike on the first ball of an innings should be 

recorded as either 1 or 2 where 1 indicates your entry in Match Setup for the name of the 
Top end and 2 indicates your entry for the Bottom end.

Innings Notes
You may record notes during each innings to record events which would not otherwise be

recorded. For example, if play is suspended due to a crowd invasion.

Penalties/Bonus Runs
You may record penalty or bonus runs for each innings. A penalty should be recorded as 

a negative number of runs and a bonus should be recorded as a positive number of runs. 
These penalties and bonuses can be used in matches where the target has been reduced or
when a team has been penalised for slow play for example. Values between -999 and 1000 
can be entered in this field and will be used to calculate the target and result. A value of 0 
indicates that there are no penalties or bonuses for the innings. Any non zero value entered
will appear on the Match Summary window in brackets eg (P-10) for a penalty of 10 runs.

Once the fields in the Innings Setup panel have been entered you should use the Done 
option to close the window and save your settings.



The Windows Menu
The Windows menu provides a list of Willow Scorebook Viewing windows which, when 

selected, display a section of a typical paper based Scorebook or features additional to 
those found in a paper based Scorebook. Options available include Scoreboard, Batting and 
Bowling Summaries or Details; Scoring Positions, Fall Of Wickets; Overs; Run Rate and 
Manhattan Graphs, Match Summary and Score sheet Analysis. As many or as few Windows 
may be displayed on the screen at the same time as are required by the scorer.

The speed at which Willow Scorebook re displays Scorebook information may be slowed 
when many windows are open at the same time. This is particularly prevalent on slower 
486 cpu machines and below. In most circumstances it is not necessary to have more than 
four windows open at the same time.

View ScoreBoard - This option provides the scorer with a view of the current state of the 
match as would be displayed on a typical scoreboard.

Set Scoring Positions - This option provides the scorer with the ability to record the 
position on the field to which the cricket ball is struck or played for each delivery of the 
innings.

View Scoring Positions (Batsmen) - This option provides the scorer with a view of the 
positions on the field that each batsman has struck or played the ball during the course of 
the innings.

View Scoring Positions (Bowlers) - This option provides the scorer with a view of the 
positions on the field that each bowler was struck to by batsmen during the course of the 
innings.

View Bowling Summary - This option provides the scorer with a view of the current 
innings bowling analysis.

View Batting Summary - This option provides the scorer with a view of the current 
innings batting analysis.

View Bowling Detail - This option provides the scorer with a view of the current innings 
bowling analysis in some detail. Details may also be manually edited.

View Batting Detail - This option provides the scorer with a view of the current innings 
batting analysis in some detail. Details may also be manually edited.

View Fall Of Wicket Analysis - This option provides the scorer with a view of the fall of 
wickets analysis during the current innings. Details may also be manually edited.

View Over Details - This option provides the scorer with a view of over details for the 
current innings. Details may also be manually edited.

Run Rate Graph - This option provides the scorer with a graphical view of progress made 
in each innings by comparing runs scored against overs bowled.

Manhattan Graph - This option provides the scorer with a graphical view of the 
comparative over scoring rate in each innings by displaying bar charts of the runs scored in 
each over.

Runs Distribution - This option provides the scorer with a tabular view of the distribution 
of Batsmen's runs.

View Match Summary - This option provides the scorer with a summary of the match.
View Scoresheet - This option provides the scorer with detailed innings analysis in the 

form of a score sheet.



Cascade Windows - This option provides a facility for reorganising the current open 
windows, from those selected above, so that the windows are cascaded diagonally within 
the bounds of the screen.

Load Defaults - This option will load settings for the display of a set of default windows to
be sized and placed automatically on the screen.

Save Defaults - This option will save the current state of opened windows so that the 
display can be easily replaced during later innings or matches.



Viewing The Scoreboard
The Willow Scorebook Scoreboard is available at any time after a match has commenced.

The Scoreboard Window can be toggled on or off by selecting the Scoreboard option from 
the Windows menu. When the Scoreboard is active a tick will appear next to the Scoreboard
option and the Scoreboard Window will appear on screen. The Scoreboard Window may be 
moved to any point on the screen and may also be resized by dragging the border in or out.
An example of the scoreboard is displayed below :-

Line A shows the numbers of the current batsman and which is the striker. The striker is 
indicated by a highlighted red/white sphere.

Line B shows the current batsman's scores and the innings total.
Line C shows the number of runs scored by the last batsman out, the number of wickets 

which have fell during the current innings and the score at which the last wicket fell.
Line D shows the names of the bowlers and which is bowling the current over. The 

current bowler is indicated by a highlighted red/white sphere.
Line E shows the bowling analysis for each of the two current bowlers and the number of 

overs bowled during the current innings. The bowling analysis is presented using the 
notation :-

overs - maidens - runs - wickets
Lines F show the names of the two team, which is batting and the scores made during 

the innings played. The team batting is indicated by a highlighted red/white sphere.



Set Scoring Positions
Willow Scorebook provides facilities for scoring the positional play of a delivery following 

or before the recording of the delivery. When a batsman scores runs from a delivery two 
independent scoring mechanisms can be employed; the number of runs scored is one 
element and the position on the field to which the ball was struck is the other. The Set 
Scoring Positions Window is available at any time during play. The Set Scoring Positions 
Window can be toggled on or off by selecting the option from the Windows menu. When the
Set Scoring Positions Window is active a tick will appear next to the option and the Set 
Scoring Positions Window will appear on screen. The Set Scoring Positions Window may be 
moved to any point on the screen and may be resized by dragging the border in or out. 
There is a maximum and minimum limit to which the Window can be sized. An example of 
the Set Scoring Positions window is displayed below :-

The Set Scoring Positions window displays an oval pitch and the wicket in the centre. 
Although this may not truly reflect the position and shape of the pitch and wickets it serves 
as an outline for scoring. The two named ends are marked top and bottom.

To set a scoring position to indicate the field position to which a batsman has played the 
ball move the crosshairs to the field position and hold down the mouse button. As you move
the mouse you will see the names of the fielding positions displayed to help you. Once the 
left mouse buttom is clicked you should see a dotted line between the crosshairs and the 
end of the wicket at which the striker played the stroke. You may now move the mouse 
(while holding the mouse button down) to adjust the position if necessary. The dotted line 
will follow the crosshair. Once the exact position has been attained release the mouse 
button and the line will become solid. If you wish to change the position you may do so by 
repeating the procedure. As soon as the next delivery is recorded you may not change the 
scoring position without the use of the undo option.

When recording a boundary four you should mark the scoring position on the boundary 
line. When recording a six you should mark the scoring position outside the boundary line.

The example above indicates the batsman played a square cut from the bottom end 
known as the Church End, which nearly reached the boundary.



View Scoring Positions
The Scoring Positions view is available at any time after a match has commenced. The 

Scoring Positions Window can be toggled on or off by selecting either of the View Scoring 
Position options from the Windows menu. When a View Scoring Positions Window is active a 
tick will appear next to its option and the View Scoring Positions Window will appear on 
screen. The View Scoring Positions Window may be moved to any point on the screen but 
may not be resized. An example of a Batsmens Scoring Positions Window is displayed 
below. Analysis can be obtained for both batsmen and bowlers :-

Section A indicates the name and number of the batsman.
Section B indicates the recording of the batsman's stroke play. Lines in black identify 

scoring strokes which did not reach the boundary. Lines in red identify fours and lines in 
blue indicate sixes.

Section C indicates the scroll bar. As only three batsman's scoring positions are shown in 
the Scoring Positions Window at one time the scroll bar is used to display other batsman's 
scoring positions. If the slider is moved to the right, lower order batsman are displayed. If 
the slider is moved to the left higher order batsman are displayed.

If you double click a scoring position view then a further window is opened showing the 
individuals scoring strokes in more detail. This window may be enlarged and an option 
exists to allow you to see the distribution of runs by segment. You may also print an 
individuals details from this panel.



View Bowling Summary
The Bowling Summary Window is available at any time after a match has commenced. 

The Window can be toggled on or off by selecting the Bowling Summary option from the 
Windows menu. When the Bowling Summary Window is active a tick will appear next to the 
option and the Bowling Summary Window will appear on screen. The Window may be 
moved to any point on the screen and may be resized horizontally. An example of the 
Bowling Summary Window is displayed below :-

The Bowling Summary displays either six or eight columns of information. The number of
rows depends upon the number of bowlers that have been used during the current innings. 
The bowler's names are listed in the first column. The second column will be marked with >
in one row indicating the associated bowler is currently bowling. The remaining columns 
display the over, maiden, run and wicket analysis for the bowler respectively. In addition 
wides and no-balls may be displayed by dragging the right hand edge of the Window to the 
right. These two additional columns will then be displayed. They may be removed by 
dragging the right hand edge back to the left again.

The Bowling Summary contains an Options menu which allows you to change the order 
of columns for English (O-M-R-W) or Australian (O-M-W-R) analysis display.



View Batting Summary
The Batting Summary Window is available at any time after a match has commenced. 

The Window can be toggled on or off by selecting the Batting Summary option from the 
Windows menu. When the Batting Summary Window is active a tick will appear next to the 
option and the Batting Summary Window will appear on screen. The Window may be moved
to any point on the screen but may not be resized. An example of the Batting Summary 
Window is displayed below :-

The Batting Summary displays seven columns of information. The number of rows 
depends upon the number of batsman in a team. The batsman's numbers are listed in the 
first column. The second column will be marked with > in one row indicating the associated
batsman currently has strike. The third column displays the names of the batsman. The 
fourth column indicates how a batsman lost their wicket. The fifth column indicates the 
fielder responsible for a catch or stumping should a batsman be out caught or stumped. 
The sixth column indicates the name of the bowler credited with the wicket and the 
seventh column indicates the number of runs scored by each batsman. At the bottom of 
the Batting Summary Window the number of extras, the total score and the number of 
wickets which have fallen are displayed.



View Bowling Detail
The Bowling Detail Window is available at any time after a match has commenced. The 

Window can be toggled on or off by selecting the Bowling Detail option from the Windows 
menu. When the Bowling Detail Window is active a tick will appear next to the option and 
the Bowling Detail Window will appear on screen. The Window may be moved to any point 
on the screen but may not be resized. An example of the Bowling Detail Window is 
displayed below in two parts :-

The Bowling Summary displays several columns of information. The number of rows 
depends upon the number of bowlers that have been used during the current innings. The 
bowler's names are listed in the first column and identified in section A. The second column
will be marked with > in one row indicating the associated bowler is currently bowling and 
with '.' in another row indicating the last bowler. The remaining columns shown above 
indicate the detailed over analysis for each bowler, the number of wides and the number of
no balls bowled by each bowler.

Section B indicates the detailed over analysis. The standard scoring notation has been 
used with some useful additions. Each delivery is scored as shown below. Below each over 
is a running total of each bowlers analysis containing the number of accumulative runs 
scored from each over and the number of accumulative wickets taken by the bowler :-

Dot Balls                    !
Wide Balls                    ; < < ( 

(1-4 Wides)
No Balls                     # $ % & [ \ ] ^ _ ` 

(1-4 No Balls, 1-6 Runs From A No Ball)
Byes                    ) 

(An Up Arrow Indicates Byes)
Leg Byes                    * 

(A Down Arrow Indicates Leg Byes)
Wickets                     W ? 

(A Wicket and a Wicket Off A Wide)

Section C indicates the number of Wides a bowler has bowled.



Section D indicates the number of No Balls a bowler has bowled.
The number of Balls bowled by the bowler is also indicated in the bowling summary.

Section E shows the vertical scroll bar used to move between the display of bowlers.
Section F shows the horizontal scroll bar used to move between display shown above and

the display shown below.

Section A indicates the number of overs each bowler has bowler.
Section B indicates the number of maidens each bowler has bowler.
Section C indicates the number of runs which have been scored from each bowler.

Section D indicates the number of wickets each bowler has taken.
Section E indicates the number of runs per wickets for each bowler.

The Bowling Detail Window will grow in size as new bowlers bowl and as each bowler 
bowls more overs. The scroll bars should be used to display the required bowler detail.

Although the Bowling Detail Window cannot be resized by dragging and dropping the 
window borders, two menu options are provided to enable the window to be sized using 
either small or large fonts. The default display uses the large font and this is indicated by a 
tick against the 'Large Font' option on the Options menu. To change to the 'Small Font' 
display simply select the 'Small Font' option. A tick will appear against this option and the 
Bowling Detail will change to about two thirds its original size. To change it back simply click
the 'Large Font' option again.

The Bowling Detail Window contains an Options menu which allows you to change the 
order of columns for English (O-M-R-W) or Australian (O-M-W-R) analysis display.

The Bowling Detail Window is one of four Windows which may be manually edited. To edit
Bowling Details use the mouse and cursor keys to highlight a cell to change and then press 
the enter key or double click with the mouse. An edit box or list will then be displayed in 
which you can change the Bowling Detail. Once the enter key is pressed again or the Done 
button clicked the change will be registered on the Bowling Detail Window. All manual 
changes are recorded on the Scoresheet under the definition {Alter()}.

You should take great care when manually editing the Willow Scorebook. The integrity of 
your match is carefully controlled    by Willow Scorebooks automatic updation. This integrity 



can be easily damaged by making improper manual changes. It is strongly suggested that 
you leave manual editing until the end of each Inning.



View Batting Detail
The Batting Detail Window is available at any time after a match has commenced. The 

Window can be toggled on or off by selecting the Batting Detail option from the Windows 
menu. When the Batting Detail Window is active a tick will appear next to the option and 
the Batting Detail Window will appear on screen. The Window may be moved to any point 
on the screen but may not be resized. However each column may be resized left or right, by
moving the mouse over the column divider, clicking and dragging left or right. An example 
of the Batting Detail Window is displayed below :-

The Batting Detail is displayed in three sections. The first section A contains fourteen 
columns of information. The number of rows depends upon the number of batsman in a 
team.

The batsman's numbers are listed in the 1st column.
The 2nd column will be marked with > in one row indicating the associated batsman 

currently has strike.
The 3rd column displays the names of the batsman.
The 4th column indicates the time at which the batsman took to the field.
The 5th column indicates the time at which the batsman was out.
The 6th column contains detailed analysis of the batsman's stroke play and balls 

received. Each dot or run indicates a ball received. A batsman's innings is concluded with a >> or a single > if the batsman has Retired Not Out.
The 7th column indicates the number of fours scored by the batsman.
The 8th column indicates the number of sixes struck by the batsman.
The 9th column indicates the number of balls received by the batsman.
The 10th column indicates the number of minutes the batsman has been at the crease.
The 11th column indicates how a batsman lost their wicket.
The 12th column identifies the fielder responsible for a catch or stumping should a 

batsman be out caught or stumped.



The 13th column indicates the name of the bowler credited with the batsman's wicket.
The 14th column indicates the number of runs scored by the batsman.

Not all the columns can be displayed in the Batting Detail Window at once. The scroll bar 
identified in section B is used to move columns left or right.

Section C, below the scroll bar, displays the detailed extras totals for Byes, Leg Byes, 
Wides and No Balls.

Section D summarises the display by indicating the total number of extras, the total 
innings score and the number of wickets to fall.

The Batting Detail Window is one of four Windows which may be manually edited. To edit 
Batting Details use the mouse and cursor keys to highlight a cell to change and then press 
the enter key or double click with the mouse. An edit box or list will then be displayed in 
which you can change the Batting Detail. Once the enter key is pressed again or the Done 
button clicked the change will be registered on the Batting Detail Window. All manual 
changes are recorded on the Scoresheet under the definition {Alter()}.

You should take great care when manually editing the Willow Scorebook. The integrity of 
your match is carefully controlled    by Willow Scorebooks automatic updation. This integrity 
can be easily damaged by making improper manual changes. It is strongly suggested that 
you leave manual editing until the end of each Inning.



View Fall Of Wickets
The Fall Of Wickets Window is available at any time after a match has commenced. The 

Window can be toggled on or off by selecting the Fall Of Wickets option from the Windows 
menu. When the Fall Of Wickets Window is active a tick will appear next to the option and 
the Fall Of Wickets Window will appear on screen. The Window may be moved to any point 
on the screen but may not be resized. An example of the Fall Of Wickets Window is 
displayed below :-

The Fall Of Wickets Window displays six details for each wicket that falls or for each 
batsman that retires not out during an innings. In the latter case the wicket number will be 
marked NO (Not Out). The four details recorded in each instance are :-

a) The number of the outgoing batsman as displayed in the Batting Detail or Summary 
window.

b) The partnership made for the loss of the wicket or made during the retiring batsmans 
stay at the crease.

c) The over in which the wicket fell or retirement occurred.
d) The innings total at which the wicket fell or retirement occurred.
e) The number of balls played during the partnership.
f) The duration of the partnership in minutes.

The current partnership is also displayed in brackets.

Although the Fall Of Wickets Window cannot be resized by dragging and dropping the 
window borders, menu options are provided to enable the display of a graphical 
representation of the innings partnerships using the Show Partnership Bar option. The 
default display does not display this additional information and the menu option defaults to 
Hide Partnership Bar. To change this option simply select the Option menu followed by the 
chosen option. A tick will appear against the chosen option. The display below shows the 
additional information available.



The Fall Of Wickets Window is one of four Windows which may be manually edited. To 
edit Fall Of Wickets Details use the mouse and cursor keys to highlight a cell to change and 
then press the enter key or double click with the mouse. An edit box or list will then be 
displayed in which you can change the Fall Of Wickets Detail. Once the enter key is pressed 
again or the Done button clicked the change will be registered on the Fall Of Wickets 
Window. All manual changes are recorded on the Scoresheet under the definition {Alter()}.

You should take great care when manually editing the Willow Scorebook. The integrity of 
your match is carefully controlled    by Willow Scorebooks automatic updation. This integrity 
can be easily damaged by making improper manual changes. It is strongly suggested that 
you leave manual editing until the end of each Inning.



View Over Details
The Over Window is available at any time after a match has commenced. The Window 

can be toggled on or off by selecting the Over option from the Windows menu. When the 
Over Window is active a tick will appear next to the option and the Over Window will appear
on screen. The Window may be moved to any point on the screen but may not be resized. 
An example of the Over Window is displayed below :-

The Over Window displays four details for each over bowled during an innings.

a) The number of the bowler for each over bowled as displayed in the bowling detail or 
summary window. In the event of a bowlers retirement or removal and two or more bowlers 
share an over then all the bowlers who participate in completing the over will be identified. 
For example if bowler number 1 became injured during an over and bowler 3 completed the
over the Over Window would display 1/3 in the bowler number field.

b) The innings total made by the batting team at the completion of the over.
c) The number of wickets which had fallen at the completion of the over.
d) The number of runs scored from the over including all extras.

On the right hand side of the Over Window is a scroll bar. This is used to move forwards 
and backwards through the over details. When the Over Window is activated the current 
over will be shown at the bottom of the Over Window.

The Over Detail Window is one of four Windows which may be manually edited. To edit 
Over Details use the mouse and cursor keys to highlight a cell to change and then press the
enter key or double click with the mouse. An edit box or list will then be displayed in which 
you can change the Over Detail. Once the enter key is pressed again or the Done button 
clicked the change will be registered on the Over Detail Window. All manual changes are 
recorded on the Scoresheet under the definition {Alter()}.

You should take great care when manually editing the Willow Scorebook. The integrity of 
your match is carefully controlled    by Willow Scorebooks automatic updation. This integrity 
can be easily damaged by making improper manual changes. It is strongly suggested that 
you leave manual editing until the end of each Inning.



View Run Rate Graph
The Run Rate Window is available at any time after a match has commenced. The 

Window can be toggled on or off by selecting the Run Rate Graph option from the Windows 
menu. When the Run Rate Graph Window is active a tick will appear next to the option and 
the Run Rate Graph Window will appear on screen. The Window may be moved to any point 
on the screen and may also be resized. An example of the Run Rate Graph Window is 
displayed below :-

The Run Rate Graph Window displays a coloured line for each of the four innings possible
so that a comparison can be drawn as to the relative state of a teams progress. The fall of 
wickets are identified along the lines by a dot and text along side.



View Manhattan Graph
The Manhattan Window is available at any time after a match has commenced. The 

Window can be toggled on or off by selecting the Manhattan Graph option from the 
Windows menu. When the Manhattan Graph Window is active a tick will appear next to the 
option and the Manhattan Graph Window will appear on screen. The Window may be moved
to any point on the screen and may also be resized. An example of the Manhattan Graph 
Window is displayed below :-

The Manhattan Graph Window displays coloured bar charts for each innings in the match.
Each bar chart contains a bar for each over of the inning. The size of the bar indicates the 
number of runs accruing from the over.



View Runs Distribution
The Distribution Window is available at any time after a match has commenced. The 

Window can be toggled on or off by selecting the Distribution option from the Windows 
menu. When the Distribution Window is active a tick will appear next to the option and the 
Distribution Window will appear on screen. The Window may be moved to any point on the 
screen.

The Distribution Window displays the summed scoring strokes for each batsman. The 
batsman are listed in rows and the strokes in columns. The Totals for the innings are also 
displayed at the bottom of the list. You may interrogate the Distribution Window to discover 
the number of singles or non scoring strokes have been made by the batsmen.



View Match Summary
The Match Summary Window is available at any time after a match has commenced. The

Window can be toggled on or off by selecting the Match Summary option from the Windows 
menu. When the Match Summary Window is active a tick will appear next to the option and 
the Match Summary Window will appear on screen. The Window may be moved to any point
on the screen and may also be resized by dragging the border in or out. An example of the 
Match Summary Window is displayed below :-

The Match Summary Window summarises the play of each innings. Four innings can be 
summarised on the Match Summary window. The 1st innings of each team is shown in the 
top half of the window and the second innings in the bottom half. Each innings contains the 
following information.

Section A indicates the name of the team batting in the represented innings and the 
score made in that innings.

Section B indicates the top five batting performances above 20 runs.
Section C indicates the top five bowling performances of those bowlers who took wickets.

Section D summarises the match by indicating the current state of play.



View Scoresheet
The Scoresheet Window is available at any time after a match has commenced. The 

Window can be toggled on or off by selecting the Scoresheet option from the Windows 
menu. When the Score sheet Window is active a tick will appear next to the option and the 
Scoresheet Window will appear on screen. The Window may be moved to any point on the 
screen but may not be resized. An example of the Scoresheet Window is displayed below :-

Each over is described in detailed scoresheet notation. Every aspect of play and scoring 
is represented. Scroll bars may be used to move through the over details.

The score sheet notation is summarised below :-

Events enclosed in { } indicate events which are not reliant on a ball being bowled for 
their place on the score sheet.

Events are separated on the scoresheet by a space. If several events happen as the 
result of one delivery then they will be linked together by commas. For example if three 
runs are scored and then the batsman is run out going for the fourth run the score sheet 
entry would be 3_R,Wkt_RO(Bt4)

Characters represented in red indicate the fixed text used to describe the event. 
Characters represented in blue indicate the variable entry of runs, bowlers, batsmen, 
fielders etc.

. Dot ball
n_B Byes
n_LB Leg Byes
n_NBR No Balls scored to the Batsman
n_NB. No Balls scored as no balls
n_R Runs
n_W Wides

Wkt_B(Bt Batsman ,Bl Bowler ) Wicket Bowled
Wkt_CT(Bt Batsman ,Bl Bowler ,Ct Fielder ) Wicket Caught
Wkt_HB(Bt Batsman ) Wicket Handled Ball
Wkt_HW(Bt Batsman ,Bl Bowler ) Wicket Hit Wicket
Wkt_HBT(Bt Batsman ) Wicket Hit Ball Twice



Wkt_LBW(Bt Batsman ,Bl Bowler ) Wicket Leg Before Wicket
Wkt_OF(Bt Batsman ) Wicket Obstructing Field
Wkt_RO(Bt Batsman ) Wicket Run Out
{Wkt_RO(Bt Batsman )} Wicket Run Out Backing Up
Wkt_ST(Bt Batsman ,Bl Bowler ) Wicket Stumped
{Wkt_TO(Bt Batsman )} Wicket Timed Out
Wkt_RetNO( Batsman ) Batsman Retires Not Out
Wkt_RetO( Batsman ) Batsman Retires Out

{NewBat( Batsman )} New Batsman
{NewBowl( Bowler )} New Bowler
{BCE} Batsmen Change Ends
{EOSBowl( Bowler )} End Of Spell for Bowler
{RemBowl( Bowler )} Bowler Is Removed
{RetBowl( Bowler )} Bowler Retires
{Stumps( Date & Time )} Stumps Taken At End Of Days Play
{BadLight( Date & Time )} Bad Light Stops Play
{Rain( Date & Time )} Rain Stops Play
{Drinks( Date & Time )} Drinks Interval
{Lunch( Date & Time )} Lunch Interval
{Tea( Date & Time )} Tea Interval
{OtherStop( Date & Time )} Other Stoppage
{Declaration( Date & Time )} Innings Is Declared
{ForceFollowOn} The Follow On Is Enforced
{ForfeitInnings} The Innings Is Forfeit
{AbandonInns( Date & Time , Overs , Score , Wickets )}

The Innings Is Abandoned
{RecommenceInns( Date & Time , Overs , Score , Wickets , Overs Lost )}

The Innings Is Recommenced
{MatchAbandoned( Date & Time )} Match Abandoned
{MatchConceded( H/A , Date & Time )} Match Conceded By Home or Away
{MatchConcluded( Date & Time )} Match Concluded
{MatchRefusal( H/A , Date & Time )} Match Ends After Refusal To Play
{NewBall( Date & Time )} The New Ball Is Taken
{ReplaceBall( Date & Time )} A Replacement Ball Is Taken
{Notes( Text )} Events Of Special Note
{50Total( Fifty , Date & Time , Minutes , Balls )} Score Reaches A Multiple Of Fifty
{50Bat( Fifty , Date & Time , Minutes , Balls , Batsman )}

Batsman Reaches A Multiple Of Fifty
{50Pship( Fifty , Date & Time , Minutes , Balls , Wicket , Batsman1 , Batsman2 )}

Partnership Reaches A Multiple Of Fifty
{InningsTime( Minutes , Score )} The score at 60 minute intervals.



{Alter( Window , Field , Previous , After )} Manual Alterations

The Scoresheet Window also contains an Options menu which allows you to interrogate 
the Scoresheet in more detail. The Options menu contains six selections as described 
below. When you make a selection a List window appears which displays the information 
requested.

List Stoppages
Whenever the match is stopped for poor weather, at the end of a session or day, the 

stoppage is recorded on the Scoresheet. You may obtain an ordered list of these stoppages 
by selecting the List Stoppages option. The list which is subsequently produced contains the
over number in the left hand column followed by the Scoresheet stoppage information 
taken directly from the scoresheet. 

{Stumps( Date & Time )} Stumps Taken At End Of Days Play
{BadLight( Date & Time )} Bad Light Stops Play
{Rain( Date & Time )} Rain Stops Play
{Drinks( Date & Time )} Drinks Interval
{Lunch( Date & Time )} Lunch Interval
{Tea( Date & Time )} Tea Interval
{OtherStop( Date & Time )} Other Stoppage
{RecommenceInns( Date & Time )} The Innings Is Recommenced

List Notes
While scoring a match you may make use of the Notes feature which allows you to record

special events of interest and to document details of the match which cannot be recorded 
conventionally. You may obtain an ordered list of these notes by selecting the List Notes 
option. The list which is subsequently produced contains the over number in the left hand 
column followed by the Scoresheet notes information taken directly from the scoresheet. 

{Notes( Text )} Events Of Special Note

List 50's
Willow automatically records an event on the Scoresheet when the innings total passes a

multiple of 50 or when a batsmen reaches a 50 or when a partnership passes a 50. You may
obtain an ordered list of these landmarks by selecting the List 50's option. The list which is 
subsequently produced contains the over number in the left hand column followed by the 
Scoresheet 50's information taken directly from the scoresheet. 

{50Total( Fifty , Date & Time , Minutes , Balls )}
Score Reaches A Multiple Of Fifty. The Fifty parameter indicates which multiple of 50 has 

been passes. The Date & Time indicates when the landmark occured. The Minutes 
parameter specifies the length of playing time in minutes taken to reach the landmark and 
Balls indicates the number of valid deliveries taken to reach the landmark.

{50Bat( Fifty , Date & Time , Minutes , Balls , Batsman )}
Batsman Reaches A Multiple Of Fifty. The Fifty parameter indicates which multiple of 50 



has been passes by the batsman. The Date & Time indicates when the landmark occured. 
The Minutes parameter specifies the total length of innings playing time in minutes taken to
reach the landmark. Balls indicates the number of valid deliveries taken to reach the 
landmark and Batsman specifies which batsman reached the landmark by their batting 
order number.

{50PShip( Fifty , Date & Time , Minutes , Balls , Wicket , Batsman1 , Batsman2 )}
Partnership Reaches A Multiple Of Fifty. The Fifty parameter indicates which multiple of 

50 has been passes by the batsmen during the partnership. The Date & Time indicates 
when the landmark occured. The Minutes parameter specifies the length of innings playing 
time in minutes taken to reach the landmark. Balls indicates the number of valid deliveries 
taken to reach the landmark. The Wicket parameter indicates the current number of wickets
fallen and Batsman1 and Batsman2 specify which batsmen have reached the partnership 
landmark by their batting order numbers.

List Alterations
Willow provides you with manual methods of changing the scorebook. All manual 

alterations are recorded, as you make them, on the Scoresheet. In order that you may trace
these manual changes the List Alterations option is provided. You may obtain an ordered list
of these changes by selecting the List Alterations option. The list which is subsequently 
produced contains the over number in the left hand column followed by the Scoresheet 
Alteration information taken directly from the scoresheet. 

{Alter( Window , Field , Previous , After )} Manual Alterations

List New Balls
In order for you to clearly identify when a new or replacement ball is taken during an 

innings, the List New Balls option is provided. You may obtain an ordered list of these 
events by selecting the List New Balls option. The list which is subsequently produced 
contains the over number in the left hand column followed by the Scoresheet New Balls 
information taken directly from the scoresheet. 

{NewBall( Date & Time )} The New Ball Is Taken
{ReplaceBall( Date & Time )} A Replacement Ball Is Taken

List Hourly Scores
Willow automatically records the score at each our of play time and at the end of the 

innings. In order for you to clearly identify the hourly scores the List Hourly Scores option is 
provided. The list which is subsequently produced contains the over number in the left hand
column followed by the Scoresheet Innings Time information taken directly from the 
scoresheet. 

{InningsTime( Minutes , Score )} The score at 60 minute intervals.



Cascade Windows
As many windows may be displayed on the screen at one time it may be necessary to 

reorganise the windows. The Cascade Windows option will move all the active windows into 
a cascade starting at the top right of the screen below the Menu area and flowing towards 
the bottom left. This ensures that at least part of all the active windows are visible on 
screen rather than hidden behind other active windows.



Load Default Windows
The display of active Windows and their position on screen can be altered throughout the

scoring process. If you wish to reset the windows to the saved defaults use the Load Default
Windows option to restore the settings.



Save Default Windows
The default Window layout of Batting Summary and Bowling Summary may not be your 

preference. You may prefer to view the Scoreboard and Scoring Location while scoring for 
example or any of the other combinations available to you. Once you have established the 
active windows you wish displayed and their positions on screen you may use the Save 
Default Windows option to save these settings so that they are loaded each time you start a
new match.

You should note that the size of Windows is not saved and will revert to their original 
sizes the next time Willow Scorebook is loaded.



Manual Editing
The following fields can be manually edited :

Bowling Detail
Current Bowler
Last Bowler
Delivery Details
Run/Wicket Counts
Wides
No Balls
Balls Delivered
Overs
Maidens
Runs
Wickets

Batting Detail
Current Striker
Non Striker
Time In
Time Out
Batting Detail
4's
6's
Balls Received
Minutes At Crease
How Out
Bowler
Fielder
Runs
Byes Detail
Byes Total
Leg Byes Detail
Leg Byes Total
Wides Detail
Wides Total
No Balls Detail
No Balls Total
Extras Total
Grand Total
Overs



Wickets
Fall Of Wickets

Batsman No To Fall
Partnership
Score At Fall Of Wicket
Over In Which Wicket Fell

Over Detail
Bowler(s) Of Over
Score At End Of Over
Wickets To Have Fallen At End Of Over
Runs From Over

You should take great care when manually editing the Willow Scorebook. The integrity of 
your match is carefully controlled    by Willow Scorebooks automatic updation. This integrity
can be easily damaged by making improper manual changes. It is strongly suggested that 
you leave manual editing until the end of each Inning.



Help With The Options Icon Palette
The Options Icon Palette is displayed whenever the match is in play and will always 

appear on top of any other Window occupying the same space so that you can always find 
it. The standard Options Icon Palette consists of twelve icons displayed vertically or 
horizontally. Each icon identifies a different delivery event necessary for scoring. The icons 
represent a Dot ball, Bye, Leg Bye, No Ball, Wide, Wicket and Runs.

The Options Icon Palette is the most accessible and quickest method of scoring a match. 
Not all deliveries may be recording using the icons within the option palette but the most 
frequently used are represented.

The Options Icon Palette will usually be the active selected window whilst scoring. This is 
indicated by the title line being highlighted a different colour from other active windows. If 
the Options Icon Palette is not the selected active window it can be made so by clicking the 
title line. When the Options Icon Palette is the selected active window both the keyboard 
and mouse can be used to score. Each icon has an associated key on the keyboard which 
can be used to record the delivery. For example a single Leg Bye may be scored by clicking 
the Leg Bye icon or by pressing the L key.

The Options Icon Palette is also accessible using the cursor and return keys. When the 
Options Icon Palette window is active the current icon selection will be highlighted along the
right and bottom edges of the icon. You may use the UP, DOWN, LEFT and RIGHT cursor 
keys to change the highlighted icon and then press the ENTER key to confirm your icon 
selection.

The standard Options Icon Palette is displayed below. Each icon is described beneath :-

Icon A is the Dot Ball icon. A Dot ball may be recorded by clicking or selecting the icon or 
by pressing the . key.

Icon B is the Bye icon. A Bye may be recorded by clicking or selecting the icon or by 
pressing the B key. The Bye icon is used to record the scoring of a single bye. If more than 
one bye is scored you should use the Bye option from the Ball Menu to record the delivery.

Icon C is the Leg Bye icon. A Leg Bye may be recorded by clicking or selecting the icon or
by pressing the L key. The Leg Bye icon is used to record the scoring of a single leg bye. If 
more than one leg bye is scored you should use the Leg Bye option from the Ball Menu to 
record the delivery.

Icon D is the No Ball icon. A No Ball may be recorded by clicking or selecting the icon or 



by pressing the N key. The No Ball icon is used to record the scoring of a single no ball but 
not if the batsman has also made a scoring stroke from the delivery. If more than one no 
ball is scored or if the no ball should be credited as runs to the batsman you should use the 
No Ball option from the Ball Menu to record the delivery. For a more detailed explaination of 
No Balls refer to the No Ball Menu Option section

Icon E is the Wide icon. A Wide may be recorded by clicking or selecting the icon or by 
pressing the W key. The Wide icon is used to record the scoring of a single wide. If more 
than one wide is scored you should use the Wide option from the Ball Menu to record the 
delivery.

Icon F is the Wicket icon. All types of dismissal may be recorded by clicking or selecting 
the Wicket icon or by pressing the X key. Once the wicket icon has been selected a list of 
possible dismissals is displayed. Click and select the type of dismissal required and select 
Done at the bottom of the pop up panel.

The six numbered icons G represent from one to six runs credited to the batsman. Runs 
may be recorded by clicking or selecting the numbered icon required or by pressing the 
number keys 1,2,3,4,5 or 6. If the batsman scores more than six runs from one delivery 
then you should use the Runs option from the Ball Menu to record the delivery.

The Options Icon Palette is also accessable in two extended versions one of which is 
shown below. The Extended Options Icon Palette consists of the standard twelve options 
plus an additional twenty four. Only the standard twelve icons respond to an associated key
press as described above. All the remaining icons must be clicked or selected through the 
use of the Cursor and Enter keys.

From Top to Bottom and from Left to Right the Extended Icons represent :-

Row 1, Column 1 Dot Ball
Row 1, Column 2 Bowling Change
Row 1, Column 3 Bowler Retires
Row 1, Column 4 Batsmen Change Ends
Row 1, Column 5 Batsman Retires Not Out
Row 1, Column 6 Save Match
Row 2, Column 1 One Bye
Row 2, Column 2 One Leg Bye
Row 2, Column 3 One Wide
Row 2, Column 4 One No Ball
Row 2, Column 5 One No Ball Hit For One Run
Row 2, Column 6 End Of Over
Row 3, Column 1 Two Byes
Row 3, Column 2 Two Leg Byes
Row 3, Column 3 Two Wides



Row 3, Column 4 Two No Balls
Row 3, Column 5 One No Ball Hit For Two Runs
Row 3, Column 6 Fall Of Wicket
Row 4, Column 1 Three Byes
Row 4, Column 2 Three Leg Byes
Row 4, Column 3 Three Wides
Row 4, Column 4 Three No Balls
Row 4, Column 5 One No Ball Hit For Three Runs
Row 4, Column 6 Note
Row 5, Column 1 Four Byes
Row 5, Column 2 Four Leg Byes
Row 5, Column 3 Four Wides
Row 5, Column 4 Four No Balls
Row 5, Column 5 One No Ball Hit For Four Runs
Row 5, Column 6 Help
Row 6, Column 1 One Run
Row 6, Column 2 Two Runs
Row 6, Column 3 Three Runs
Row 6, Column 4 Four Runs
Row 6, Column 5 Five Runs
Row 6, Column 6 Six Runs



Help Techniques
Learning how to use a new piece of software can be a lengthy process. It can be 

exasperating to know what you want to do with the software but not know how to do it. This
section of Willow Scorebook Help is intended to aid the new user through first principles and
provide a step by step guide to scoring a cricket match. Not every feature of Willow 
Scorebook is covered in this section and reference should be made to the Menu and 
Window sections of the guide for detailed explaination of some features.

First Principles

Starting A New Match
Preparing The Scorebook For Play
Preparing Scorebook Options
Commencing Play
Scoring An Over
Examining The Scorebook
Changing Bowlers
At The Fall Of A Wicket
A Break In The Play
The End Of An Innings
Starting A New Innings
At The End Of The Match



First Principles
The Willow Scorebook attempts to simulate and enhance the normal manual scoring 

process. Your computers disk drives can be equated to a very large Cricket Scorebook. The 
Scorebook must be opened to the appropriate pages before scoring can begin or before you
can browse a match. Each match or set of pages in the scorebook is stored as a file on your 
hard disk. In order to open your scorebook to the appropriate pages you must open the file 
relating to the match in question and save the file before closing the scorebook.

Once the Scorebook is open to the required pages (file) you can begin using the Willow 
Scorebook features to add details to any of the pages or to browse a specific page. Each 
innings of a match is stored on several pages, known as Windows. Each window displays a 
different set of match information. For example the Bowling Summary Window displays a 
summary of one innings bowling.

The significant difference between Willow Scorebook and a conventional Scorebook is 
that each delivery or event can be recorded on all relevent windows (pages) by clicking the 
associated delivery or event on the Willow Scorebook menu. In this scenario Willow 
Scorebook is acting as your assistant. As you keep an eye on the match and shout out the 
scores, your assistant is feverishly updating the scorebook. You do not need to remember to
update the batting, bowling, fall of wicket and over analysis, you just need to record the 
delivery or event once.

Willow Scorebook extends the facilities of a manual scorebook by providing windows for 
Scoreboard, Scoresheet, Batsmen Scoring Positions, Run Rate and Match Summary over 
and above those you would normally find. Each window can be printed so that you can keep
a manual record of matches.

Other features are available to help you in the scoring process. These enable you to 
automatically end overs, select batsman and bowlers and record times at which events take
place.

All these features help to make Willow Scorebook a valuable new tool for novice and 
experienced scorers alike.



Starting A New Match
The following actions are necessary in order to create a new set of blank pages in your 

Scorebook so that you can then score a match.

1. From the File Menu select the New option to create a new match.
The new match will be created with default settings and will be {untitled} This option will

automatically invoke the steps descibed in the following section 'Preparing The Scorebook 
For Play'



Preparing The Scorebook For Play
The following actions are necessary to prepare a new match for play.

1. From the Setup Menu select the Match Setup option.
2. From the Match Setup Window edit the details to prepare the match for play.

The Match Setup window may be selected at any time a match is in play but some 
settings can only be set before a match is commenced. You are recommended to change as
many match setup details as possible before the start of play.
3. Close the Match Setup Window once the Match details are correct.

The Match Setup window can be closed by clicking the Done option or by clicking on the 
marker at the top left hand corner of the window and choosing close.
4. From the Setup Menu select the Player Setup option.
5. From the Player Setup Window edit the details to prepare the names of players for play.

The Player Setup window may be selected at any time a match is in play althoughyou 
will findit    more convenient to ensure players details are correct before the start of play.
6. Close the Player Setup Window once the Innings details are correct.

The Player Setup window can be closed by clicking the Done option or by clicking on the 
marker at the top left hand corner of the window and choosing close.
7. From the Setup Menu select the Innings Setup option.
8. From the Innings Setup Window edit the details to prepare the innings for play.

The Innings Setup window may be selected at any time a match is in play but some 
settings can only be set before an innings is commenced. You are recommended to change 
as many innings setup details as possible before the start of play.
9. Close the Innings Setup Window once the Innings details are correct.

The Innings Setup window can be closed by clicking the Done option or by clicking on the
marker at the top left hand corner of the window and choosing close.



Preparing Scorebook Options
The following actions are necessary to prepare Willow Scorebook Options for play.

1. From the Options Menu choose Automatic or Manual selection of :-
a. Batsman.
b. Timing.
c. Ending The Over
Select as many automatic options as you feel are appropriate. By doing this you will 

minimise the requests made on you to score such details. You should be aware that the 
selection of Automatic or Manual Timing can only be made prior to the commencement of a
match. Other Options may be set during play.



Commencing Play
The following actions are necessary to commence the scoring of a match.

1. From the Events Menu choose Match Events.
2. From the Match Events sub menu choose Commence Match.

Once the Match is Commenced the Windows, Ball and Event options are also activated 
allowing you to score and monitor the scoring of a match.



Scoring An Over
The following actions are neccessary to score an over.

1. Either from the Ball Menu or the Options Icon Palette select the appropriate event.
2. Repeat step 1. for each ball in the over.
3. Some special events may be necessary. These can be selected from the Events Menu.

Use the search facility within this Help guide to find specific information on the delivery 
or event you wish to record.



Examining The Scorebook
The following actions are necessary to examine elements of the scorebook.

1. From the Windows Menu select the information you wish to examine.
Windows may be toggled on and off during play. The Windows menu indicates which 

windows are currently open by marking them with a tick. All windows can be re positioned 
to new areas of the screen and some windows may also be sized. Examine the section of 
this Help guide entitled Help with Windows for further information.



Changing Bowlers
The following actions are necessary to change a bowler.

1. From the Events Menu select the Bowling sub menu.
2. From the Bowling sub menu choose the Bowling Change event.
3. From the Bowling Change Window select the name of the new bowler.

Bowlers can only be changed at the end of an over although bowlers can retire or be 
removed during an over.



At The Fall Of A Wicket
The following actions are necessary to record the fall of a wicket.

1. From the Ball Menu or the Options Icon Palette select the Wicket option.
2. From the Wicket window or sub menu select the type of dismissal.
3. Select the name of the new Batsman if necessary.

Batsman may also retire out or not out and these events can be recorded through the 
Events menu, Batting Events.



A Break In The Play
The following actions are necessary to record a break in the play.

1. From the Events Menu select the Innings sub menu.
2. From the Innings sub menu choose the type of stoppage required.

You are recommended to save your match at regular intervals and especially when a 
break in the play is forced. In order to save the match for the first time perform the 
operations below.
3. From the File Menu choose the Save As option.
4. Type in the name of the file you wish to use to title your match.
5. Click the OK button to confirm the save event.

Once the break in play is over and only if Willow Scorebook was closed during the break 
in play.
6. From the File Menu select the Open option.
7. Type in the name of the file you have titled your match.
8. Click the OK button to confirm the open event.

Once the break in play is over.
9. From the Events menu select the Innings sub menu.
10. From the Innings sub menu choose the Recommence Innings option.



The End Of An Innings
The following actions are necessary to record the end of an innings.

1. From the Events Menu select the Innings sub menu.
2. From the Innings sub menu choose the type of end of innings required.



Starting A New Innings
The following actions are necessary to begin a new innings.

1. From the Events Menu select the Innings sub menu.
2. From the Innings sub menu choose the Commence Innings option.



At The End Of The Match
The following actions are necessary to record the end of a match.

1. From the Events Menu select the Match sub menu.
2. From the Match sub menu choose the type of end of match required.

Once a match is complete you may not score more events. You may use the View menu 
to display the scorebook details. You should save your match at its conclusion.



Technical Information
The Willow Scorebook has been written using Microsoft Windows v3.1 ,v3.11, Windows 

95, Windows 98 and Windows NT v4, Microsoft Visual Basic v2, v3, v4 and v5 Professional 
Editions, Microsoft Word v2, v6 & 97, WordPerfect v5.1, v5.2, v6, v6.0a, v6.1 & v7, Corel 
Draw v4, v5 & v8, Persistence Of Vision v2, Moray 3D Modeller, TITLESPY VBX from Softland,
TIPS VBX, WAVE1.VBX & WAVE32.OCX from Mabry and RESIZE VBX & RESIZE30.OCX from 
Larcom & Young.

The Willow Scorebook has been developed on an Intel P200, an Ami Bios based 
486dx100 and 386dx40, a Compaq LTE/Lite 386sl25, an IBM PS/VP M40 486dx33, a DEC 
433dxDT, a DEC Celebris P90, a DEC Venturis P166 and a DEC Hi-Note 586 Notebook using 
A Hewlett Packard Laserjet V, Laserjet IV, Laserjet IIIP, Paintjet XL300, Deskjet 550C, Canon 
Bubblejet BJ10e, Epson Stylus 600 Colour, Epson LX800 and a Citizen 120D for output. The 
Willow Scorebook has been tested on over sixty other models of PC and Printer.

A great amount of effort has been provided by Grahame Giddings. Without Grahame's 
constant flow of ideas, comment and encouragement Willow would be much less of a 
product than it is today. The Willow Scorebook CSF Export routine was tested by G.Giddings 
using Cricket Statistics for Windows. :-

Grahame Giddings, 76, Spingwell Rd, Heston, Middlesex. TW5 9EJ.
Email: ggiddings@cix.compulink.co.uk

Additional contributions to the CSF definition were made by P.Griffiths.

Thanks to Mike Sinclair for his assistance with the Cricket Statz MXP export routine. Mike 
can be contacted using email at the following address or through his web page.

Email: msinclair@cricketstatz.com
www.cricketstatz.com

Thanks to Hugo Russell for his assistance with the Radial Chart control. Hugo can provide
further Radial Control facilities through OCX :-

Hugo Russell, 124 Yardley Close, Oldbury, West Midlands. B68 9DG. England
Tel: 0121 544 6024 Fax: 0121 544 5806 Email: hugo@islandsystems.co.uk

Thanks to Greg Sanders for his continued support and input as Australasian Distributor :-
Greg Sanders, A.N.T.S Pty Ltd, PO Box 8, Walkerville. S.A. 5081. Australia.
Email: sales@ants.com.au
Web: www.ants.com.au
Tel:+61) (08) 8344 7100

EddSON wish to thank all the above named for their help in the making of this program 
and to those customers who have offered their services during the 'early release programs'.

All trademarks used within the program and documentation are acknowledged.

Product Contents



     WSB.EXE
The Willow Scorebook Program

     WSB.HLP
The Willow Scorebook Help Guide

       *.BMP
The Graphic Files used by the Scoreboard

     WSB.LIC
The Licence File as seen through Help About

  OPTDEF.CKT
The Default Options saved file

   UNDO*.CKT
The files used by the Options Undo event

  WINDEF.CKT
The Default active windows and their screen locations

     WSB.INI
The Windows Initialisation file which contains information used by Willow Scorebook 

to locate program and data files, allocate memory and define start up parameters :-
ProgDir=
The Drive and Directory in which Willow Scorebook is located.
DataDir=
The Drive and Directory in which Willow Scorebook should load matches from and 

save matches to. 
MemAllocOver=
A number indicating the maximum number of overs that may be scored during an 

innings. This value should be in the range 20 to 999. The default setting of 100 will allow 
Willow Scorebook to run satisfactorily on a 4Mb PC. You will require a minimum of 16Mb in 
order to use the maximum setting of 999. If you find Willow Scorebook is unable to allocate 
suitable memory then either close all other open Windows Programs or reduce the 
MemAllocOver value.

BallRotate=
This initialisation variable may contain a Y or N to indicate whether you wish Willow 

Scorebooks introduction window to be displayed as a rotating ball or as a static image. 
When Willow Scorebook loads with a Y in this setting the introductory window is displayed 
as a spinning cricket ball. On some machines with minimal memory, a slow hard disk or a 
slow processor this image can take some time to load and display each frame in the 
sequence. If you wish to improve Willow Scorebooks load time then set this variable to N so 
that only a static image of the ball is displayed.

UseRadial=



This initialisation variable may contain a Y or N to indicate whether you wish Willow 
Scorebook to enable the use of Radial Charts and Run Rate Graphs. If you find that Windows
is running out of System Resources (USER & GDI) then you may wish to set this option to N 
so that memory is conserved.

RecentFile1=
Willow Scorebook remebers the last five matches to be saved and loaded. The above 

initialisation variable will contain the directory and filename for the first of these five files.

  CKTSFB.*
The True Type Font used for Bowling Details

       *.WAV
The Cricket music file

   DEFAULT.TPT
The default HTML template file

   INPUT.HTM
The default input HTML process file.




